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Introduction 

Welcome! 

Thank You for purchasing EzCoin. Should you have any suggestions, questions, or 

comments please write to us at the address on the front of this package. If you 

have any requests for enhancements that would be nice to have.., please let us 

know and we will try to incorporate any useful ideas into future releases. That's 

how EzCoin has grown to be the mature product that it is. 

If you like EzCoin, please tell your friends about us. Dealer inquiries are welcome. If 

you find any errors or omissions in the documentation, please let us know. We're 

here to help. 
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There are many new features in this release of EzCoin. For those of you who are 

upgrading from a previous version, please read the quick start guide or the 

following section on Importing from prior versions of EzCoin. 

http://www.pcvu.com/DEMOS/ezcoin/QT/EzC2_QSG.pdf 

 

Please note our E-mail address is mariost@shaw.ca or ezcoin@ezstamp.com. It 

is the fastest and easiest way to get help if you need it (other than Reading the 

Manual). Our web site is located at www.stamptools.com and you can also reach us 

at (705) 254-6201 

 

EzCoin For Windows is owned by SoftPro 2001.  

Unauthorized Use or Duplication by any means is Prohibited by 

Law. © 2019 SoftPro 2001. All Rights Reserved 

 

Coin Images © 2019 Royal Canadian Mint. All Rights Reserved  

Images des pièces © 2019 Monnaie Royale Canadienne. Touts Droits Réservés 

 

  

http://www.pcvu.com/DEMOS/ezcoin/QT/EzC2_QSG.pdf
http://www.stamptools.com/
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System Requirements 

Operating System Support 

 Windows XP Windows Vista Windows 7 Windows 8 

32-bit     

64-bit     

 

Note: As Windows XP is no longer supported by Microsoft, SoftPro can't ensure the 

reliable operation of EzCoin within this operating system if enhancements or extra 

features are added to the application in the future which will require Windows Vista 

at minimum. It's recommended to install EzCoin on at least the Vista platform, to 

ensure ongoing support from both SoftPro/EzCoin and Microsoft/Windows. 

 RAM As much system memory as needed to comfortably run EzCoin 
within your installation of Windows. A minimum of 1 GB is 

required, but 2 GB or more provides the best performance 

Video EzCoin is designed to run at a minimum resolution of 1024 x 768 

pixels, with a minimum of 256 colors. Higher resolutions are 

recommended for using the secondary support windows, such as 

the Coin List and Thumbnail Viewer. 

Disk Space Approximately 75 MB of hard disk space is required for Canada & 

USA country files. An additional 150 MB of disk space is required to 
copy pre-supplied images to your system's local disk drive (this is 

optional but recommended). Additional pre-supplied country files 
and custom country files will require additional space. 

CD/DVD A CD, DVD, or BluRay disc drive is required for installation. 

Third Party 

Software 

Adobe Acrobat reader or a compatible PDF document viewer is 

required to view the printable version of the manual. FREE 

Software downloads are available from www.adobe.com  

Additional An online connection to the Internet is required to access the Free 
updates feature of EzCoin. An Internet browser is required to use 

the eLook™ feature. EzCoin makes use of Microsoft database 
technology to store country data and EzCoin configuration settings. 

This software is installed by the EzSetup application to the EzCoin 
installation path. 

Printer A Windows compatible printer and associated driver software must 
be installed on your system to print reports. EzCoin can print 
reports in color with images, if your printer supports color output. 

Microsoft 
.NET 

Framework 

EzCoin was built using the Microsoft .NET Framework, version 2.0. 
Your installation of Windows must have at least version 2.0 of the 

framework installed (Vista and Windows 7/8 generally have this 
installed by default). EzCoin is compatible with higher versions (3.x 

and 4.x) of the framework. Free downloads of the framework can 

http://www.adobe.com/
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be found on the Microsoft website at www.microsoft.com 

 

Additional Online Help 
 

Our website will be regularly updated with the latest information about updates, 

additional modules and databases and other pertinent information. 

We will be providing online video tutorials to guide you through the different tasks 

in EzCoin from how to backup and restore, how to add your own images and 

varieties and may other topics. 

 

We also have the Quick Start Guide available on our site at 

 

http://www.pcvu.com/DEMOS/ezcoin/QT/EzC2_QSG.pdf 

 

This guide describes the basic functions and features what you will use on a regular 

basis and gives you an overview of some important features. 

 

We also maintain a FAQ (Frequently Asked Questions) page on our site. 

The Tips of the Day feature can be accessed anytime from the Help menu in 

EzCoin. 

  

http://www.microsoft.com/
http://www.pcvu.com/ezcoin/QT/QT0001.html
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Support, Questions and Comments 
 

Technical Support: Many of the most commonly asked questions about our products 

are available on our website in the FAQ (Frequently Asked Questions) or Support 

pages at http://www.StampTools.com. 

 If you still have questions after having read the product manuals, guides or on-line 

help, please contact us.  We welcome any questions, comments or suggestions you 

may have about our products. Customer service and prompt attention to your 

needs is a priority at SoftPro. 

Telephone / Fax              705-254-6201        

Mailing Address    SoftPro 2010 Inc.  

     118 Palomino Dr.  

     Sault Ste. Marie, Ontario  

     Canada  P6A 0B2 

 

Questions / Support   ezcoin@ezstamp.com 

Priority Remote Support 

We are also pleased to offer Priority Remote Support to our customers so that 

we can Securely Remote into your PC & assist you in solving problems or questions 

you may have. This can also be used as a training session to demonstrate how to 

perform certain functions or simply if you would like us to use our expertise to train 

you to use our software more effectively.  

Here's how it works.   

 Contact us and ask for Priority Remote Support. We will set up a time , 

usually right away. You MUST have internet access to use this service. Once 
the Remote Control Software is installed on your PC, you will be provided 
with a user ID & password for this session. We will need these codes to 

initiate the session 

 We will contact you via phone or email, & then we will take control of your PC 

to solve issues or demonstrate what you need help with. You will be able to 
watch everything we do and ask any questions that you may have. You can 
close the connection at any time. 

 Is this safe and secure?   Absolutely. The entire connection is encrypted and 
safe and used by large corporations worldwide.  

 To initiate a Priority Remote Support session, please call us at  
705-254-6201        or email us at mailto:techsupport@ezstamp.com 

 Then click on the link below to begin the remote control session. Once 

initialized, you will see a partner ID & a password (auto generated).  

http://www.stamptools.com/
mailto:techsupport@ezstamp.com
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http://get.teamviewer.com/SoftPro  
   
Click on the above link to begin after you have contacted us 

Additional Online Help 
Our website will be regularly updated with the latest information about updates, 

additional modules and databases and other pertinent information. 

We will be providing online video tutorials to guide you through the different tasks 

in EzCoin from how to backup and restore, how to add your own images and 

varieties and may other topics. 

 

We also have the Quick Start Guide available on our site at 

 

http://www.pcvu.com/DEMOS/ezcoin/QT/EzC2_QSG.pdf 

 

This guide describes the basic functions and features what you will use on a regular 

basis and gives you an overview of some important features. 

 

We also maintain a FAQ (Frequently Asked Questions) page on our site. 

The Tips of the Day feature can be accessed anytime from the Help menu in 

EzCoin. 

Filling Out Contact Information 
It's recommended that you fill out your contact information accurately so that we 

can better assist with supporting any issues you may encounter when using EzCoin. 

If you need to update contact information, it can be accessed from the send email 

screen via the Change Contact Info button. 

 

 
 

You should enter valid name, phone number and email address when prompted. 

  

http://get.teamviewer.com/SoftPro
http://www.pcvu.com/ezcoin/QT/QT0001.html
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EzSetup – Installing or Removing EzCoin 
EzCoin is provided on one or more CD, DVD or BD discs. Unless the disc is purely 

for image files, it will come with an installation program named EzSetup.exe. Trial 

and downloadable versions of EzCoin will contain this application as part of a self-

extracting archive, which can be found in the location you chose to extract the files 

to. 

Trial Versions and EzCoin Activation 

EzCoin is provided as a trial (demo) version and a release version. Trial version 

setup is functionally identical to the release setup. In fact the setup programs are 

identical. The only difference is in the setup package file which EzSetup references. 

Once you install a trial version of EzCoin, you can convert it to a release version 

with an activation code. However, EzSetup should always be used to install the 

necessary application files, as it can automatically detect what files need to be 

updated/installed based on the setup package contents. 

Cumulative Installations 

EzSetup has the ability (which is the default installation setting) to update an 

existing installation of EzCoin on your system. For example, if you have 2 discs, one 

for Canada and one for USA, each disc’s setup package will contain all the core 

application files for EzCoin, plus country files for Canada (on the Canada disc) and 

USA (on the USA disc). Each installation disc will contain all EzCoin core files. 

Country files are specific to each disc however. When EzSetup installs core files 

from the disc, it will detect what version of each file is currently installed on your 

system, and only install or replace any files which are newer. 

Country Update vs. New Install 

When choosing a country file to install, EzSetup will check if that country is 

currently installed on your system. If the country data on the installation disc is 

newer than what is currently provided, EzSetup will place an update file (i.e. 

Canada.upc) into the Setup folder of your EzCoin installation path. This represents 

pre-supplied data/pricing information and will be applied to your country file(s) the 

next time you run EzCoin. If EzSetup detects that your country file is already up to 

date, no new information will be installed for that country. If the country file doesn’t 

exist, EzSetup will install a new SDF (Country files have an SDF extension) file into 

the DB folder where EzCoin is installed. 
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Running EzSetup 

To start EzSetup, simply run the EXE directly from the disc (or from the self-

extraction location for downloadable installation packages). A multi-step setup 

wizard will be provided. Simply follow the on-screen instructions and click the Next 

button as needed until you reach the option to click on an Install button. Use the 

Previous button to step backwards in the setup wizard. Click Cancel to close 

EzSetup. When the installation is completed, you will see a final window with two 

checkbox options, one for placing a shortcut to EzCoin on your Windows Desktop, 

the other to view the Read Me text file. 

Most of the wizard screens are self-explanatory. However, the following screens 

have information of importance to determine how best to perform the installation. 

Existing v2.x EzCoin Installation - Image Copy and Location 

 

If there is no current version of EzCoin (Version 2) installed, the default location will 

be as above. Use the Browse button to choose a different installation path. 

There is a checkbox option named Install Coin Images with Countries. Each 

pre-supplied country file will contain an image file library (with a file extension of 

.IMG) which contains all of the pre-supplied coin images. This file can be copied to 

the EzCoin installation path (and will be stored in the Images subfolder) by 

checking this option. As EzCoin images are represented as JPEG images, the 

amount of extra storage space is minimal - it's recommended to keep this option 

checked, as it will improve performance when retrieving image information. 
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EzSetup will detect any existing installation of EzCoin, as long as it is based on 

version 2.x, and provide 4 setup choices. Note: EzCoin version 1.x is not directly 

supported by version 2. You must export country data from version 1 for use in 

version 2, and install version 2 separately from the older versions. 

1. Install and Update as Needed. This is the default option and the safest, 

providing a cumulative setup of your existing installation. EzSetup will only 

install or update new files as needed and leave any existing up-to-date 

information as is. 

2. Clean EzCoin Installation. This option will remove all EzCoin core data 

files, leaving only country files intact. Only choose this option if you are sure 

you want to perform a “fresh” EzCoin installation, yet preserve any active 

country data. 

3. Full Installation. This option will remove every EzCoin file from the 

installation path, including country files. Note: You will NOT be able to 

recover deleted files from this installation option. 

4. Remove EzCoin. This option uninstalls EzCoin from your system. 

Country File Selection 

Each installation disc will have one or more country files available to install. Check 

country files from the available list to install. If the country is already installed, 
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EzSetup will detect if the installed version needs any supplied data/pricing updates 

from the disc. By default, EzSetup preselects every country file available. 

Installation to Existing Folders 

EzSetup will allow you to install to any existing directory on your system. If EzSetup 

detects non-EzCoin files in that directory, a warning prompt will be displayed. 

EzSetup will not remove existing files or folders, unless they conflict with any file or 

folder reserved for use exclusively by EzCoin. It’s recommended that you install 

EzCoin to the default installation path provided by the setup wizard. If you wish to 

install to another location, please make sure that the location contains only EzCoin 

v2.x files or is empty. EzSetup will not recognize installations of EzCoin prior to or 

later than version 2.x. 

Windows Vista/Windows 7/Windows 8 and User Access Control (UAC) 

EzSetup and EzCoin are safe applications in the sense that they will not try and 

perform any privileged actions which would otherwise violate user access control 

policies on your system. EzSetup deploys shortcuts and files under the ownership of 

the current user logged into Windows. If you have multiple users logged into your 

PC who need to use EzCoin, you will need to create shortcuts for each additional 

user from within EzCoin. 

You should not install EzCoin into the Program Files area of Windows when using 

Windows Vista, Windows 7 or Windows 8. This may cause UAC issues due to 

restricted access rights defined for that area. EzSetup’s default installation path will 

not point to Program Files. Note that if an existing v2.x EzCoin installation is 

detected by EzSetup, the default installation path will automatically switch to where 

EzCoin is installed. 

  



EzCoin Reference – Version 2.0 

Page | 29 
 

EzCoin Activation 

A fresh installation of EzCoin will run under Trial/Demonstration mode. This will be 

indicated in the title bar of the application as “Unregistered”. You can only open 

trial versions of country files contained the DemoDB folder where EzCoin is 

installed. 

Activation is done using a 16 character activation code. There may be additional 

activation codes for extra features which SoftPro may provide in future releases of 

EzCoin. All activation code types are entered using a single window within EzCoin. 

Choose the EzCoin Activation option from the Help menu. 

 

The activation code is entered in 4 parts of 4 characters each, in the top set of 

input fields. Note that if EzCoin is already registered, the input fields and Activate 

button will be disabled as shown in the screen example above. 

Enter all 16 characters (without dashes) and then click on the Activate button to 

the right of the 4 text box fields. At this point EzCoin will be registered. 

Extra features use a dropdown list with a choice of activation types. The activation 

process is the same for these codes. Just use the second Activate button for the 

selected feature. 

Both a SoftPro web URL link and email button are provided in the activation 

window. 
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Trial Version Expiration 

 

Demo versions of country files will have a 30 day time limit for which they can be 

used, after which the usage allowance will expire. You should not use EzCoin demo 

versions as a fully registered versions of a country for this reason. The 30 day 

window allows you time to evaluate EzCoin and assess if it's capabilities will meet 

your needs.  

The above dialog window will pop up to warn you on the number of days left. You 

may extend the usage for a demo country by submitted a request to SoftPro. 

 

Trial Image Data Removal on Activation 

 

When activating a trial version of EzCoin, you will be presented with the above 

confirmation dialog for custom image links. If you've linked any custom image files 

to a trial country file, you can choose to retain those images for the equivalent 

release version of the same country files. 
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Converting a Demo/Trial Country to a Release Version 

Once you have registered EzCoin with an activation code, you will no longer be able 

to access the trial versions of country files stored in the DemoDB subfolder. If you 

have any coin information from the demo country which you want to add to the 

release version of the same country, use the Convert Demo Country option from 

the County Data File Utilities submenu. 

 

 

Source Demo Country 

The source country drop down will list all trial country files stored in the DemoDB 

subfolder of EzCoin's installation path. 

You can select a country from this folder, or choose to select one from any other 

location using the Browse button. You will not be able to convert a release country 

using this utility. 

Target Release Country 

The target country drop down list contains all release country files you have with 

your version of EzCoin. Unless a target country file exists, you will not be able to 

perform the conversion. 

Conditions for Trial Data Copy 
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There are some additional restrictions/requirements for the conversion to be aware 

of. 

 The target country must have been initialized, which is done by simply 

opening the country file in EzCoin at least one time. 

 The target file must have the same country of origin. For example, you can't 

add trial coin information for Canada into a USA target country file - they 

must both have Canada as the country of origin. 

 If the source demo country file contains pre-supplied coin information from 

SoftPro, then it will only be migrated into the release country if it also 

contains pre-supplied coin information. If the target country is a custom 

format with no pre-supplied coin data, then only custom variety coin 

information can be migrated to the release country. To avoid this restriction, 

ensure you have purchased a release country from SoftPro and select that 

country file as the target file. 

 Any matching coin records in the target country file have precedence. If you 

have an inventoried coin in the target country with the same 5 key fields 

(Denomination, Year, Type/Reign, Variety, Mint Mark) as an inventoried coin 

in the source demo country, then the coin information will not be added to 

the release country. 

 Priority want lists, sell lists, purchase history and sell history records are 

merged together, even for the same coin record, as long as the grade 

information is different. For example, if the grade VG exists in the PWL for a 

given coin in the target country and a grade EF exists in the PWL for the 

same coin in the source demo country, the end result will be EF and VG 

grades in the PWL for the coin record. For purchase/sell history, coin records 

will not be copied over to the release country for the same coin record if both 

the grade and purchase/sell date are the same. If the dates are different and 

the grades the same, the coin record will still be copied to the release 

country. 

Deleting the Demo Country After Conversion 

Check the Delete Demo Country option to have the file removed from the DemoDB 

folder after the conversion has completed. 

If you don't check this option, you can manually remove the file using the Delete 

button after selecting the country from the source file drop down list. 

Automatic Backup 

The original target release country will be backed up into the Backup/Temp 

subfolder of the EzCoin installation path. There is no restore from backup option 

available for this type of conversion. You can only restore the file manually by 

copying it back to the DB folder. If you choose to do this, make sure to run the 
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Recalculate Country Totals after you open the original file to adjust any 

currency/quantity values for the grand totals reports. 
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EzCoin Overview 
This section summarizes the various components which make up the main EzCoin 

window. You can access this help topic from the EzCoin application by clicking on 

the Help button on the right side of the main toolbar. An example of the main 

window is shown below. 

 

Menu Bar 

The menu bar provides all of the options available within EzCoin. The shortcut keys 

associated with each menu item can be customized to use any set of shortcuts you 

need. 

 

1 The File menu contains options for opening and closing country files, 

performing backups and restorations, and various utilities such as file 
merging and supplied data updates. 

2 The Navigate menu contains options for browsing coin records, including 
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Bookmarks, Tags, and Coin Lists to manage groups of records. 

3 The Edit menu contains all the basic tools to manipulate the coin record data, 
including quick mode edit features and rapid multi-entry. 

4 The Search menu contains basic search options in EzCoin including eLook™ 
and Power Search. 

5 The Reports menu contains additional searching and report options. The 
Search and Report menus together provide all of the reporting capabilities 

within EzCoin. The Grand Totals reports and report profile customizations are 
also available in this menu. 

6 The Utility menu contains various options used to maintain and edit country 

file information. 

7 The Extras menu contains additional features of EzCoin. As new special 

features are added to EzCoin, they will appear in this menu. Some of these 
features may require a specific country file to be opened, or require an 

additional activation code to be purchased. 

8 The View menu contains the options to view additional windows of 

information, such as the Thumbnail viewer or the Coin List. These windows 
are supplementary to the main EzCoin window and can be dragged and 
resized around the main window. 

9 The Options menu contains items which allow you to customize EzCoin at the 
application or country file level. The general preferences item contains most 

of the application customization points in EzCoin. 

10 The Help menu contains items to access the context-sensitive help topics, 

tips of the day, product activation and miscellaneous assistance features 
within EzCoin. 

 

Tool Bar 

The tool bar provides access to the most frequently used features of EzCoin. A 

shortcut button configuration tool is available which will allow you to assign 

additional buttons to a secondary window which can be displayed in any position 

alongside the main EzCoin window. 

 

1 The leftmost icon in this group is the EzCoin Drill Down feature, used to find 
coin records using a separate window with filtering of the 5 primary key 

fields (Denomination, Year, Type/Reign, Variety and Mint Mark), using real 
time preview of the matching records. 

 
The second icon in the group allows for quick recall of the most recent 8 coin 
lookups where more than 1 matching coin record was found. Selecting an 

item from the popup menu will automatically run the report view and place 
the selection cursor at the last coin record selected, if applicable. 

2 The blue arrows are used to step backwards and forwards through all coin 
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records in the country, both pre-supplied records from SoftPro and 

inventoried records in your collection. Hold down CTRL to step to the first or 
last record.  

3 The # symbol between the blue arrows is used to select the stepping method 
between the next and previous available coin records. 

4 The green arrows are used to step through inventoried records only. Pre-
supplied non-inventoried records are skipped. For custom countries without 
pre-supplied data from SoftPro, the green and blue arrows will perform the 

same function. 

5 The violet arrows are used to step through the contents of the active 

Navigation List. These lists can be generated from any search or report 
within EzCoin. 

6 The blue checkmark is used to add new coin records or save changes to 
existing coin records, based on the coin information currently displayed in 

the main EzCoin window. 

7 The red “X” icon will remove the current record from your inventory. If the 
coin record has pre-supplied information from SoftPro, this will cause the 

coin record to revert back to a pre-supplied status with the removal of any 
inventoried information or customizations. 

8 The eraser icon will clear the current fields on screen. By default only 
inventoried or customized data is cleared (priority want/sell list data and pre-

supplied fields are not erased). To clear the entire screen of data, hold down 
CTRL while clicking the icon. 

9 Click this icon to duplicate the current coin as a new record. The duplicated 
coin is based on the 5 primary key fields (Denomination, Year, Type/Reign, 
Variety and Mint Mark). The bottom status bar will include new information 

to indicate a duplicate coin status. 

A Click this icon to add the selected grades to the Priority Want List. Hold down 

CTRL while clicking to use the alternate method of addition. The 2 methods 
used (based on a general preference setting) will be Quick Add (no pop up 

dialog) or Normal Addition (dialog with options to select grades, set quantity 
and type to buy). You don’t have to select any grades to add the coin to the 
PWL – in this case the PWL entry will be indicated as “Any Grade” in reports. 

B Click this icon to add the selected grades to the Priority Sell List. As with the 
PWL, there are two modes of addition based on whether the CTRL key is held 

down while clicking on the icon. 

C Click on this icon to provide a quick report of all pre-supplied data for the 

country (EzBrowse). Hold down CTRL to provide a report of all inventoried 
records (EzInventory). 

D 
E 

F 

These 3 icons will run the most recent search or report for the following: 
 S: Last option run from the Search menu. 

 R: Last option run from the Reports menu. 
 Q: Last QuickStats report. 

The toolbar icons make it easy to re-run the same report type multiple 

times. 

G Click this icon to show or hide the custom user fields window. 

H The image links icon is used to access the image links editor, allowing you to 
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view or modify the coin images for the obverse and reverse sides. 

I This icon shows the thumbnail image viewer based on the current stepping 
sort order. 

J This icon will only be enabled when Special Notes and Information is 
available in the pre-supplied data. When enabled, click the icon to view this 

information. 

K If there are special pre-supplied notes for a coin record, this icon will be 

enabled. Click on it to view additional notes about this coin. 

L Click this icon to view the current image in the image comparison window. As 
you navigate to new coin records, the image comparison window will retain 

the current image. 

M This icon presents a drop down list of special characters which can be used in 

place of the shortcut key combinations which normally must be used to 
insert special symbols. 

N If you have alternate obverse and reverse images associated with a coin 
record, then this button will become visible. Click the button to show the 

alternate images, or Ctrl+Click to reset back to the original images. 

O This button allows you to save any modifications to pre-supplied coin 

information without adding the coin to your inventory. Note that any supplied 
country updates from SoftPro can change these customizations. 

P Provides a quick help link to the EzCoin main application summary. 

Q This icon will present a dialog window containing summary statistics for the 

current open country file. 

 

Coin Details 

This area of the main application window contains the basic coin details 

information. The image preview area and the coin details/comments panes share 

the same horizontal band of the main window. You can drag the vertical separator 

between these two areas to reallocate space between them. 
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Coin Key Fields and Attributes 

 

 

1 A unique coin record for a country is identified by 5 key 

attributes: 
 Denomination 
 Year 

 Type/Reign 
 Variety 

 Mint Mark 
 

At least one of denomination or year must be present for 
a coin to be saved. Duplicates of the coin record are 
allowed, but will still have the same 5 key attributes for 

each duplicated record. 
 

To search for an existing coin record, press ENTER while 
positioning in any of the 5 key fields. If more than one 
matching coin is found based on the combination of the 5 

fields, a report view will be displayed with all matching 
records. 

 
To perform a Drill Down search, click on the Drill Down 
button or hold the Ctrl key while pressing ENTER. 

2 A country in EzCoin can have up to 4 pre-supplied catalog 
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numbering systems, plus an additional 4 user-defined 

numbering systems. Only one of these numbering types is 
available on the main screen at any given time. Alternate 
catalog numbers are optional and are not needed to 

uniquely identify a coin record.  
 

To set the current numbering system, click on the label 
above the input field to display a popup menu with 
available choices. Note that each custom numbering 

system can be labeled as you see fit. Pre-supplied catalog 
numbering systems can't be renamed. 

 
To search on an alternate catalog ID, enter it in the field 
and press ENTER. There are no partial ID matches 

allowed. 

3 The UID, or Universal Identification Code, is a unique 

shorthand notation for any pre-supplied coin record. You 
are free to use any notation for custom UID values, but 

you will not be allowed to change the pre-supplied 
versions for any coin record. To perform a UID lookup, 
enter a complete or partial UID value in the field and 

press ENTER. If multiple matches are detected on a partial 
UID field, a report window will be displayed with all 

matching coin records. 

4 This is the primary coin attribute area, divided into pre-

supplied coin attributes and those which can only be 
associated with inventoried records. For a custom country 
file, all fields are associated with inventoried records. 

 
Specific details on these fields is summarized in the next 

section 

 

Pre-Supplied Coin Attributes 

The following fields can be pre-supplied by SoftPro for any country file which is 

purchased. For custom countries, all fields are custom information. Pre-supplied 

information is kept as a copy within a country file. You may modify the pre-supplied 

information, or add to it for any field attribute which is not supplied for a given coin 

record. Keep in mind, pre-supplied information may be subject to updates with paid 

supplied country updates each year, in which case your customizations to these 

fields may be discarded during an update patch. 

Diameter Coin dimension, free format text. 

Weight Coin weights are expressed using one of 5 standards: 
 Grams 

 Troy Ounces 
 Avoir Ounce 
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 Pennyweight 

 Grains 
When entering a weight, make sure to use the correct unit of 
weight from the dropdown list. Note that when you change a 

weight unit for an existing weight value, EzCoin will attempt to 
do a weight conversion of that value, which may result in small 

rounding errors - ensure that you manually update the weight in 
this case. 

Thickness Coin dimension, free format text. 

Edge Coin edge type, free format text. 

Composition Compositions are generally expressed in free format text, as 
percentages of metal types. The composition can also contain 

special notes about the composition.  
 
Precious metal compositions should NEVER be placed in the free 

format field. Always place the percentage of Silver, Gold, 
Palladium or Platinum in the appropriate input field. 

 
Also note that the weight of the coin and the precious metal 
composition percentages will determine the bullion value of the 

coin. 

Period This is the period for which the coin was in active circulation. 

Mintage This is the quantity of coins issued for mint and proof mint 
types. 

Designer Free format text for the designer of the coin. 

Notes Any special notes or description for this coin will appear 

underneath the image preview area. These are pre-supplied 
notes only. Any custom comments you wish to attach to a coin 

record will be in addition to this. 

Coin 

Quantity for 
Sets 

This is a new attribute in EzCoin Version 2. For coin records 

which are represented by a physical set of multiple coins, this 
field will contain the number of coins in the set.  
 

On reports, you can display the inventoried grade quantity (i.e. 
grade MS-65 with quantity 2 plus MS-60 with quantity 3 = 

Quantity of 5 for the coin record). 
 

Or, you can display the set coin quantity. For example, a set 
with a coin quantity of 6 where you inventory grade MS-63 with 
quantity 3 will result in a report coin quantity of 18. 

 

Overriding Pre-Supplied Values 

If you change a value for a pre-supplied field, you will see the background color of 

that field change to reflect it is now different from the pre-supplied value. This color 

coding is a visual cue to inform you of pre-supplied changes. EzCoin provides 

reporting capabilities to also identify these types of changes. 
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Inventoried Coin Attributes 

The following fields are not provided by SoftPro and are associated with inventoried 

records only. For users of EzCoin Version 1, you will find that many of the old 

inventory attributes have moved to the grade level, such as buy and sell 

information, to allow attributes to be associated with the individual grades and not 

the coin record itself. 

Location The location field can exist at both the main coin record and also 

for individual grades. When importing from EzCoin Version 1, 
you will have the option to import to either or both locations. A 

utility is also available to migrate locations between the primary 
and grade level. 

Serial 
Number 

The serial number is a general purpose cross reference field. 

Comments Comments can be up to 4,000 characters in length in EzCoin 
Version 2. In EzCoin Version 1, comments could be up to 16,000 
characters in length. Due to how comments are used in 

advanced searches and reports in version 2, you will not be able 
to import comments from version 1 which are longer than 4,000 

characters. 
 

Comments appear below the notes and image area on the right 
pane of the main EzCoin screen. You may resize the comments 
area by dragging the space between the image preview and 

comments area. You can also choose to show the comments in 
their own separate window to make maximum use of available 

preview image area. 

 

Tabbed Spreadsheet Data Grids 

Depending on the country opened, and on some general preference options to show 

additional tabs of data, this area will contain spreadsheet-style data grids for the 

following coin information:  

 Available and Inventoried Grades 

 Purchase History 

 Sell History 

 Priority Want List Entries 

 Priority Sell List Entries 

 Custom Field Entries 

Click any tab to show the grid view for the respective information type. The fields 

which appear in the grid view for the Grades tab can be reordered or removed from 

the grid altogether using the Field Settings for Grade Data menu option. 
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The labels for each tab will have a numeric value enclosed in parenthesis to indicate 

the number of records associated for that data type (i.e. Custom (3) indicates 3 

custom field values for the coin record). 

The grades tab is slightly different from the other grid views in that it contains 

status icons on the left side of each record.  

Each status icon indicates a specific state for the grade, as follows. 

 The grade is part of your inventory. 

 The grade is in the Priority Want List. 

 The grade is in the Priority Sell List. 

 The grade is part of your inventory and in the PWL. 

 The grade is part of your inventory and in the PSL. 

 The grade is in both the PWL and PSL. 

 The grade is part of your inventory, in the PWL and also in the PSL. 

In addition, a red checkmark  symbol indicates a grade which has a pre-supplied 

market value from SoftPro, or for when you have assigned a custom market value.  

If no status icon is shown, then the data row represents a grade that is available to 

be inventoried, with no other specific attributes or price information. 

Market Values, User Values and Bullion Values 

Any grade can be inventoried based on one of 3 values: 

 The market value or pre-supplied price is the current value of the coin for the 

associated grade, in the currency as per the country conversion rate defined. 

 

 The user value is a special one-time override of the market value. You are 

free to set a user value for any grade for any coin, but be aware that when 

you choose to do this, market values will no longer be used to calculate the 

net inventoried value for the coin record for that grade. If a market value 

doesn't exist, it's recommended that you assign a market value over a 

custom user value. Unlike EzCoin version 1, you are allowed to assign or 

change market values for grades. 

 

 The bullion value is only applicable if 2 conditions exist: First, the coin must 

have a at least a percentage of one of the 4 precious metals defined. Second, 

the coin must have a value weight greater than 0. When these 2 conditions 

exist, the bullion value will be shown below the grade data grid to the right of 

the market value. 

If the bullion value is greater than the market value, the market value in the data 

grid for that grade will be shaded with a yellow background color. This means the 

precious metal content value exceeds the current market value. 
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You can choose to inventory a grade as it's bullion value and it will be shown in the 

data grid at the very top row shaded with a gold background color, with the BV 

column containing the word Yes. 

Selected Grade Information 

Below the grade grid are status attributes for the selected grade and a set of 

shortcut buttons to the right of this information. 

 

1 This field is present so that you can override and enter a price for any single 
grade (i.e. on a grade by grade basis). This is NOT your cost, but your 

override of the supplied market value for any specific grade that you have 
selected in the Grades window.  
 

You MUST first select a grade by highlighting the row and then enter your 
value and click on the green $+ icon to accept your entry. This is NOT is a 

pre-supplied field.  
 
It's recommended that you enter a custom Market Value for any grade where 

a pre-supplied value doesn't exist, and only use the User value to explicitly 
lock in a price which can't be changed even by a supplied country data 

update patch. 

2 This field is used to enter the quantity of the coins you own for a specific 

grade that you have selected. The default value is 1, but you may change it 
to reflect the quantity you own. Please note that you can enter a value of 
zero (0) and still record this grade as inventoried. This is NOT is a pre-

supplied field 

3 This is the EzCoin market value for the associated grade. This value may be 

provided by SoftPro for pre-supplied countries, but not every grade for every 
coin may have a pre-supplied market value. You may override this value if 

you choose to.  
 
Also note that you can set a Price Lock on any coin so that supplied data 

updates will never alter these values. (See the price lock icon at the bottom 
left portion of the Status Bar. This is a pre-supplied field. 

4 If the coin contains a valid weight and at least one of the 4 precious metals 
as a composition percentage, then it's current bullion value is displayed here. 

This is the value for a single coin, regardless of grade type. 
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Grade Shortcut Buttons 

 

1 This is the same as the blue checkmark in the main application toolbar, used 

to add the record to your inventory. 

2 Use this button to commit the data you have entered for the selected grade 

(i.e. qty, your value, dates, comments etc.). This does NOT save the record 
to the country file yet. It just accepts the entries for that selected grade.  
 

You can select multiple grades at one time and add them all collectively with 
a single click on this button. 

 
To actually SAVE the record to file, you must left click on the Save Record 
Icon (blue checkmark) or Right Click in the Grades Area and select ADD and 

SAVE from the Pop Up Menu. 
 

A general preferences option can be enabled to allow you to auto add grades 
when you click the blue check icon to save the record. It performs the 
function of the Blue Check button and the $+ button in one step. 

 
Hold down the Ctrl key while clicking the button to show a dialog allowing for 

entry of additional grade information, such as buy/sell details, comment and 
location information. 

3 This button will save the selected grade as a bullion valued coin, ignoring the 
market price. Since bullion value is based on metal content and not grade, 
the bullion value is the same for any grade you select.  

4 Use this button to remove the selected grades from your data (i.e. qty, your 
value). To CLEAR ALL fields for the Grades, hold down Ctrl while clicking the 

button. 
 

This does NOT remove the record from your inventory, just the selected 
grades. To remove the entire record/coin from your inventory, you must click 
on the RED X on the main EzCoin tool bar. You can select multiple grades at 

a time and remove them at the same time. You may also remove grades by 
selecting the grades and then RIGHT clicking in the grades area, then choose 

the Remove Selected option from the popup Menu. 

5 Use this button to bring up the quick edit grade edit window. In this window 

you can edit any of the dates, prices and comments for a single grade at a 
time. Compare this to the Grades quick Editor icon which allows for editing 
multiple grades and the associated details all at the same time. 

6 Use this button to allow editing of multiple grades in a spreadsheet-type 
editor. You can make changes to the data for any of the grades listed.  

 
Any changes you make can be undone within the current editing session. 

Once the window closes, changes cannot be undone.  
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This provides a quick way to make multiple changes to multiple grades in 
one convenient window. An option available in the Preferences Menu allows 
you to auto-save the coin record. In this mode, once you save the data in 

the Quick Edit window (click on the Apply Changes Icon), the grade 
information is automatically saved to file. 

7 If you have selected a grade or multiple grades, you can click on the Grades 
Deselect Icon to deselect the grade. This does NOT clear any data, but just 

deselects the grades in the grid. 

 

Purchase/Sell History Shortcut Buttons 

 

1 Add a new transaction to the purchase/sell history. 

2 Remove selected records from the purchase/sell history. 

3 Edit the selected record in the purchase/sell history. 

4 Perform a quick edit on the purchase/sell history using a spreadsheet view. 

5 Edit/review the complete purchase/sell history for the country. 

 

Priority Want/Sell List Shortcut Buttons 

 

1 Add a new record to the priority want/sell list. 

2 Remove selected records from the priority want/sell list. 

3 Edit the selected record in the priority want/sell list. 

4 Perform a quick edit on the priority want/sell list using a spreadsheet view. 

5 Edit/review the complete priority want/sell list for the country. 

 

Status Bar 

The bottom of the main EzCoin window contains a status bar with several elements. 

Not all of these elements will be visible, depending on the current open country file 

opened, the state of the current coin record, or any special background tasks 

currently running. 
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1 This is the current record status. See below for a list of all status types. 

2 If you enforce pricing locks on a coin record, this icon will be enabled. Price 
locks prevent EzCoin from applying price changes when new pre-supplied 

country updates are applied. 

3 If duplicate coin records are created on the same coin record, this status area 

will indicate the current and total number of duplicate records. 

4 Use these arrows to navigate between the duplicate records. Note that by 

default the green arrows will navigate the duplicate records as well. These 
supplementary arrows are useful when you disable duplicate record stepping 
on the green arrows. 

5 The total quantity of coin grades inventoried on this record. 

6 The total value of the inventoried grades. 

7 If a navigation list is active, this status indicates the current and total number 
of records in the list. 

8 The remaining area is used for hint messages on menu options and progress 
messages for operations which take several seconds or more to complete. 

 

Coin Record Status Indicator 

The bottom left icon in the main EzCoin window contains a status icon for the 

current coin record. 

 There is no country file opened, or no current coin record shown in the main 
window. 

 EzCoin is busy performing a background task and can’t be interrupted. 

 The record is pre-supplied data and has not been added to your inventory. 

 The record is part of your inventory and is based on pre-supplied data. 

 The record is part of your inventory and is a custom variety, or you are 

working with a custom country file. For a custom country file, you will never 
see the blue or green status icons, only this one or the duplicate status icon 
for inventoried records. 

 The record is one among a set of duplicate coin records based on the 
primary 5 coin attribute fields. 

 

Context Sensitive Popup Menus 

The following areas on the main window have special popup menus by right or left 

clicking within the area or on a specific label. 

 Right click within the data grids in the bottom tabbed area to show a popup 

menu with specific options related to the grid type (i.e. right clicking within 

Grades will give you grade-specific options). 

 Left click the Alternate Catalog ID label above the input field customization 

options. 



EzCoin Reference – Version 2.0 

Page | 47 
 

Context Sensitive Quick Help 

Most of the buttons in the main EzCoin window and labels which are associated with 

input fields have context sensitive quick help. 

Simply right click on a label or button and a small window will appear with a short 

description of what that button or label means. 

For example, right clicking on the Weight label will show the following popup help 

topic: 

 

 

Resizing Panels in the Main Window 

If you have a large high resolution display, you can increase the size of or resize 

the primary areas in main EzCoin window. The main details panel in the upper left 

area has a minimum height which can't be made smaller, to avoid hiding key coin 

fields. Aside from that, the main window has the following configuration: 
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There are 3 invisible lines separating the 4 sizeable areas in EzCoin. To make the 

details panel larger (which makes the image & notes/comments areas smaller), 

click in the area between the panels and drag to the right while holding the mouse 

down. Similarly, you can click and drag between the image panel and the 

notes/comments panel to allocate a different size ratio between those two areas. 

The data grids area can be made smaller or larger vertically by click-dragging in the 

area between the top 3 panels and the data grids. 

Note that with a large display area, there can be a lot of unused space between the 

details panel and the data grid on the left. If this is the case, then use the 

preferences option to move the notes and comments to the details panel, as 

described in the next section. 

 

Alternate Display Mode for High Resolution Monitors 

EzCoin was designed with a default main window size to accommodate a minimum 

screen size of 1024 by 768 pixels. With the common format of wide screen 1080P 

(1920 x 1080) or higher resolutions in today's computer displays, EzCoin provides a 
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generate preference option to take advantage of this, by moving the coin notes and 

comments fields from underneath the image area to the left details pane, appearing 

underneath the  Designer field. This provides more useable space for larger coin 

images. 

To enable this mode, go to the EzCoin coin General Preferences dialog and 

choose the Display tab. Check the option as shown below: 

 

This will now place the notes and comments fields on the left details panel at the 

bottom. 

 

 

Data Grid Fields 

The following tables summarize the fields which can appear in each data grid. Note 

that the PWL/PSL data grids are turned off by default. You can enable them using 

the EzCoin general preferences. The custom field tab will not appear unless you 

have assigned custom fields to the country file. 
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Grade Grid Fields 

Field Description 

Grade Name The name of this grade, i.e. MS-65. Grades can be pre-

supplied from SoftPro or custom ones which you create. The 

grade list is based on the country file, and can be filtered to 

only show grades you may be interested in. 

Bullion Value If a coin was inventoried as a bullion value based on precious 

metal content and a valid weight, this field will be shown in the 

"BV" field with the value "Yes". In addition, the row in the grid 

will be shaded with a yellow background color. 

Market Value The price of the grade, either a pre-supplied value or one 

which you assigned, expressed in the current currency format 

and conversion rate assigned to the country. If the bullion 

value of a coin exceeds the market value, this field will be 

shaded in yellow to indicate this condition. 

User Value You can choose to override any market value for any grade. By 

default no user value will be applied to any inventoried grade. 

Quantity Quantity can be a value from 0 and up to a maximum of 

99,999,999. A grade can be inventoried with zero quantity. 

Net Value This is quantity * the user value/bullion value/market value. 

Coin Qty The total coins associated with a single grade. This value is the 

grade quantity multiplied by the Coin Set Quantity (which 

normally is 1 coin for non-set records) to result in the total 

number of physical coins. 

Comments You may enter any text comments to associate with a grade. 

Unlike version 1 of EzCoin, comments can be associated with 

both the coin and the individual grades. 

Location You may enter an optional location to associate with a grade. 

Unlike version 1 of EzCoin, location information can be defined 

at the coin level and grade level. 

Graded By You may enter an optional value for who graded the coin. 

Version 2 of EzCoin assigns this information on a per grade 

basis. 

 

Purchase History Grid Fields 

Field Description 
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Field Description 

Grade Name The name of the grade purchased. Since purchase history is 

transactional, the grade may appear more than one time in the 

data grid. Note that EzCoin allows you to specify "Any Grade" 

as a reference if you are unsure of the actual grade. 

Quantity Quantity of coins purchased can be a value from 0 and up to a 

maximum of 99,999,999. 

Purchase Date When the coin was purchased. This value can be empty, but 

it's recommended you assign a date so that a chronological 

transaction report can be generated properly. 

Purchase Price The amount paid for the coin(s). You should enter the total 

purchase price, as EzCoin doesn't allow you to set itemized 

prices for a transaction (i.e. if you purchase 3 coins on the 

same transaction and wish to itemize 3 different prices, then 

you will need to enter this information as 3 transactions). 

Purchased From Who the coin(s) were purchased from. 

Comments You may enter any text comments to associate with the 

transaction. 

 

Sell History Grid Fields 

Field Description 

Grade Name The name of the grade sold. 

Quantity Quantity of coins purchased can be a value from 0 and up to a 

maximum of 99,999,999. 

Sell Date When the coin was sold. This value can be empty. 

Sell Price The amount of the sale. 

Sold To Who the coin(s) were sold to. 

Comments You may enter any text comments to associate with the 

transaction. 

 

Priority Want List Grid Fields 

Field Description 

Grade Name The name of the grade you want. This can be set as "Any 

Grade" if you are just interested in adding the coin itself to the 

priority want list. 
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Field Description 

Buy Quantity The quantity of coins you wish to buy. 

Type to Buy A general category or comment to associate with the record. 

Market Value This value is not something which can be changed in the grid. 

EzCoin simply carries over the grade's market value to the PWL 

grid for reference. 

Net Value A calculated value which represents the potential cost of 

buying coin(s) based on the current market value. 

 

Priority Sell List Grid Fields 

Field Description 

Grade Name The name of the grade to sell. 

Sell Quantity The quantity of coins you wish to sell. 

Type to Sell A general category or comment to associate with the record. 

Market Value Market value for the grade. 

Net Value A calculated value which represents the potential sale value. 

 

Custom Fields Data Grid 

Custom fields only have 2 columns: The field name and it's corresponding value. 

Each custom field with a value for the coin will be represented as a single row in the 

grid. You can choose to show the custom field list in a separate window for easier 

access (from the EzCoin View menu). 

 

Coin Information Relationships 

EzCoin doesn't automatically maintain the relationships between the following 5 

sources of grade information: 

 Inventoried grades 

 Purchase History 

 Sell History 

 Priority Want List 

 Priority Sell List 

For example: If you wanted to purchase a grade of MS-65 for a coin, you would add 

it to the Priority Want List. 
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If you then purchased this coin for the same grade, you would add it to the 

purchase history, your inventory, and then remove it from the PWL. 

If you then decided you no longer wanted this coin, you would add it to the Priority 

Sell List. 

Once you sold the coin, you would remove it from your inventory and the PSL, and 

add it to the sell history. 

You would need to manage this sequence of activities manually - EzCoin isn't an 

inventory management system. 

Customizing the Grades Data Grid Field List 
Inventoried grades can contain many fields of information, creating a wide grid 

which can require a lot of left and right scrolling to see every column of data. In 

addition, country files can be assigned several dozen grade classifications which you 

may not require for a given country. For these reasons, EzCoin provides several 

customizations on how to display the grade data. 

You can access these options either from the Utility or Options items in the main 

menu, or by right clicking in the grades data grid to see the following popup menu: 

 

1 The display order determines which grades appear before others in the data 

grid. 

2 The choice of which grade fields to show across the data grid can be chosen 

with this option. 
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3 The editor used for item 2 above has a custom file export option. This will 

generate template files which can be switched out by choosing this menu 
option, allowing for quick swaps on the fields in the data grid. 

4 The master grade configuration editor defines what grades are visible in the 
data grid and on reports. 

 

Setting the Grade Display Order 

The default display order (Inventoried Grades) is based on the following priority: 

 A grade which is assigned to your inventory as a bullion value. 

 A grade which is assigned to your inventory based on market value. 

 Grades assigned to the priority want or priority sell list. 

 Any grade which has a market value or user value (indicated by the red 

checkmark icon). 

 Any remaining grades, sorted by the master grade configuration for the 

country. 

Choosing the priority want or sell list order will bump PWL/PSL grades to the top of 

the grid. 

Choosing Default Grade Order will place the grid in the grade order set for the 

country. This last option may be useful for editing grade data as a whole using the 

quick editor feature. 

If none of the 4 items in the menu appear with a checkbox to the left of the item 

name, then the grade order is based on a specific column you chose to sort on. 

Sorting by column (in ascending or descending order) is achieved by simply clicking 

on the header label. 

 

In the example above, the Net Value is sorted in descending order. A column sort 

order is indicated by the reversed coloring on the column's label. 

To clear the column sort order, hold down Ctrl while clicking the column label. 



EzCoin Reference – Version 2.0 

Page | 55 
 

Editing the Fields to Display 

If you want to add or remove fields from the data grid (this only shows/hides fields, 

it doesn't remove the data from the country file), choose the Edit Display Fields 

menu option to show the following editor. 

 

 

The left side of the editor shows fields available to assign to the data grid. The right 

side shows currently assigned grade fields. 

 

1 To remove fields from the right side, select them and click on the left arrow, 
or right click in the grid. 

2 To add fields from the left side to the right, select them and use the right 
arrow button, or right click on the left-side list. You can assign fields one at a 

time by double clicking the field in the list. 

3 Click on Undo to reset the field assignments to the previous saved copy. 

4 Click on the eraser button to clear all assigned fields. 

5 To reorder the fields, select the ones you want to move in the assigned list, 

and use the up and down arrow buttons. Hold down the Ctrl key to move the 
selected items to the start or end of the list. 
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6 Click on the save button to assign the field list to the grade grid in the main 

EzCoin window. 

7 Click on cancel to discard any changes. 

 

Custom Field Assignment Templates 

The assigned list of fields can be exported to a custom fields file, using the Save 

Custom File menu option. Simply enter a description for this file and it will be 

saved to the User subfolder of EzCoin with an extension of .FGRD. 

To assign a custom field list for the grades data grid, right click anywhere in the 

grid area and choose Select Custom Field List the from the popup menu. 

 

Use the Default button to reset the grade fields in the data grid to the default list 

which was in effect before assigning any custom field file. 

Use the Delete button to remove custom field files. 

Use the Rename button to change the name of the field file. 

Click on Select or double click an entry in the list to use the custom field list. 
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Support Windows 
You can display additional secondary windows which support information contained 

in the main EzCoin window. These secondary windows are displayed (or hidden) by 

selecting options from the View menu. Some of these items are popup dialog 

windows, which must be closed before the main window can be accessed. Other 

window types can be sized and positioned around the main window, and will remain 

on your screen until you close or hide them. When the latter types of windows are 

visible, a small checkmark icon will appear to the left of the menu item name. 

 

 

1 The thumbnail viewer provides a grid of images which can be resized and 

configured to contain up to 14 rows and 14 columns of coin images on screen 
at one time. There are 4 methods for displaying the images. 

2 The special information window is only available for specific coins and specific 
country files – it’s not available for custom countries or custom coin varieties.  

3 Special notes is pre-supplied additional information for specific coin records by 
country. Both special notes and special information are only available when 
the 2 corresponding buttons in the main EzCoin toolbar are displayed in an 

enabled state. 

4 The image comparison window displays coin images in a separate window 

from the main EzCoin image area, allowing you to compare two similar coins 
on screen at the same time. 

5 Custom fields are extensions you can make to any country file, to save 
additional data for coin records. 

6 EzCoin provides a small area below the coin image area for comments. You 
can hide this area and opt for a sizeable window for holding the coin 

comments. 

7 Custom fields can include image link field types. You can display these 

secondary images in a separate window, which is what this item is for. 
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8 If you would like to extend the toolbar button commands to a secondary 

window, this would be the one to use. Many of the options in the main EzCoin 
menu can be attached to a shortcut button window for convenient access. 

9 The Coin List viewer is a small data grid viewer for coin records. You can use 
this viewer as a mini-browser from coin records obtained from bookmarks, 
tag lists, searches and reports. 

10 The data grids at the bottom of the EzCoin window can contain many fields of 
information, which can result in frequent horizontal scrolling to see the fields 

of interest to you. You can display the vertical view window to show one 
record of data from selected rows in the data grids in a top-down manner, 

allowing you to see most, if not all of the field data at one time. 

 

 

Thumbnail Viewer 

The thumbnail viewer provides a convenient grid of coin images. The grid is 

displayed using one of 4 display methods, accessible from the View menu. 

 

 Denomination Order: The default display method will show images ordered 

by denomination, then by year, starting with the current coin record shown 

on the main screen. 

 Year Order: The sort order will be by year, then denomination. 

 Alternate Catalog ID: Only coin records which are inventoried based on the 

current catalog ID selected in the main EzCoin window will be displayed. 

There can be up to 8 (4 user and 4 pre-supplied) alternate numbering 

systems in EzCoin for which you can associate with coin records. Note that 

coins which don't have a catalog ID value assigned will be skipped over. 

 Navigation List: You build navigation lists generally from searches and 

reports. You can show all the coin images which are part of the active list. 

An example of the viewer window is shown below: 
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The number of rows and columns can be configured from the EzCoin general 

preferences. Up to 14 columns and 14 rows can be used. The window itself can be 

resized. Once you release the mouse button when dragging the window to a new 

size, all of the coin images will be adjusted to fill the new dimensions, while 

maintaining the proper image proportions. 

The bottom of the window shows basic summary information for the selected coin. 

If you move the mouse over any coin in the grid, the information will change 

accordingly. You can “lock” a coin record and display it in the main EzCoin window 

by simply clicking an image. A selection rectangle will appear around the image you 

clicked on. 

If you wish to lock an image in the viewer but NOT change the coin record in the 

main window, right-click the image. 

To close the viewer and select a coin for the main window at the same time, either 

double-click an image, or select the image, then click on the show (“S”) button at 

the bottom right of the viewer window. 

To navigate pages of images, use the up and down arrow icons, or press the cursor 

up or down arrows on the keyboard (Note: keyboard shortcuts for thumb viewer 

navigation only work when the viewer is the active window in EzCoin). 
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To move the selection rectangle along the current page of images, use the left and 

right arrow keys on the keyboard. 

To move to the first or last page of images, use the left and right arrow icons, or 

press the Home or End keys on the keyboard. 

Clicking the preferences button will display the preferences tab for thumbnail 

viewer customizations. 

Missing Images 

The viewer will show the primary coin images only. When images are not available 

for a given coin number, the position in the grid will be shown as a blank square. 

Image Display Speed 

EzCoin will build each page of images one coin at a time. As the image page is 

building, you can do other things in EzCoin, or even close the viewer while the 

images are being painted. 

The time to display a page of images depends on a few things: 

 If the images are being accessed from CD/DVD disc (images copied to your 

local disk drive will display significantly faster). 

 The image display quality (a low quality setting will result in faster 

rendering). 

 The performance level of your system. 

Single Row Mode 

You can right click any area in the information pane at the bottom of the thumb 

viewer window to collapse the viewer into a single row of coin records. To restore 

the original number of rows, simply right click on the information pane a second 

time. 

Alternate Labels 

The default text which appears below each image pair is the Denomination and 

Year. You can choose to show alternate information by choosing the label method 

from the Options menu. 



EzCoin Reference – Version 2.0 

Page | 61 
 

 

 

Note that the label text is based on current settings for the country file. Pre-

supplied catalog ID values may also be assigned to the thumbnail viewer if pre-

supplied by SoftPro. The example above shows PCGS for USA. 

 

Image Comparison 

This option displays coin images in a secondary window which can be sized and 

positioned independent of the main EzCoin window. An example of this window is 

shown below. 

 

The comparison window has a few toolbar options available. 
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The number buttons display the primary or alternate image set for the coin record. 

The title bar of the compare window will show which of these images is active. The 

Denomination and Year are also shown in the title bar, with the type and variety in 

the information bar below the images. 

The image compare represents the coin record which the image is associated with, 

not necessarily the one currently visible in the main EzCoin window. 

The swap button (black/white arrows) will exchange the coin record in the image 

compare with the one in the main screen.  

The orientation button (black and white boxes button) will swap the coins between 

a horizontal and vertical orientation, and will also swap the window width and 

height at the same time. This orientation will be saved to your EzCoin general 

preferences after the application is closed. 

 

Custom Fields 

You can choose to show custom fields as a secondary window which can be resized 

and dragged alongside the main window, and/or place the fields as a data grid tab 

in the main window using a general preferences option. An example screen of each 

type is shown below. For details on defining custom fields, refer to the editor in the 

Utilities help section. 

Secondary Custom Fields Window 

 

You can resize this window as small or as large as needed. If the window is smaller 

than the number of fields, scroll bars will automatically appear. 

To show the secondary window, use the Custom Fields Window option under the 

View menu. 
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Main Window Data Grid Tab 

 

To enable the Custom fields tab in the main window use the Preferences option 

(under the Display tab) to enable it. 

 

Custom Field Image Preview 

If you have defined a custom field as an image link data type, you can see a 

preview of the image by CTRL + Clicking the ellipsis (…) button to the right of the 

image link field in the custom fields window (normal single clicking provides a 

browser window to locate an image file). 

If you are using the custom fields data grid view in the main EzCoin window, you 

can show the image by simply selecting the image field in the grid. If the custom 

image preview window isn’t displayed, you can enable this from the View menu or 

by right clicking in the data grid and choosing the show option from the popup 

menu. 

Custom images retain their current image until you decide to preview another 

image, even if you change to another coin or close the country file. 

 

Command Shortcuts 

If you have created custom shortcuts for the EzCoin main menu commands, you 

can show this customized button window by choosing the Command Shortcuts 

option from the View menu. 
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This window can be positioned or resized as needed. There is a minimum allowable 

size for this window; however there is no restriction on how large or how many 

buttons you want to put on it. As you resize the window, the buttons will 

automatically rearrange themselves to fit the window width.  

If you hover the mouse cursor over a button, its help hint message will appear in 

the status bar at the bottom. The title bar shows the current button set you are 

using, and the total number of buttons active in this set. 

To change to a different button set, click one of the numbered buttons at the 

bottom. You can use up to 5 different sets of shortcuts. If you want to swap to 

additional shortcut button configurations, or edit the current button sets, click on 

the shortcut buttons at the bottom right. Refer to the shortcut button editor help for 

more details on customizing the buttons for this window. 

 

Coin List Viewer 

The coin list viewer is a special window which can co-exist with the main EzCoin 

window. You can drag this window to any position on your screen and resize it as 

needed to fit within your workspace. When you run EzCoin for the first time, the 

window is hidden from view. Use the Coin List Viewer option from the View 

menu to show or hide this window. A typical coin list would appear similar to the 

following example. 
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The coin list window has 3 basic components: An optional image preview pane, a 

data grid to show some basic fields of data (this can be customized), and a toolbar 

with a handful of options. 

Toolbar Options 

 

 

1 Add the current coin to the end of the coin list. 

2 Removes the most recent coin added, or if you’ve selected one or more 

specific records in the list, only the selection will be removed. This does 

not remove the record from your inventory. 

3 This clears all records from the coin list. 

4 The active navigation list will be transferred to the coin list. Whatever 

records were in the coin list before the transfer will be lost. 

5 This option transfers the coin list to the active navigation list. The 

contents of the existing navigation list are discarded. 

6 The contents of the current tag list are transferred to the coin list, 

replacing the existing list. 

7 The coin list will be saved to a navigation list file. 

8 The fields within the coin list can be edited to show more, less, or 

different coin attributes. The field profile editor is used to configure the 

fields to be used in viewer. Only the primary coin attributes can be 

added as fields to the coin list viewer. 

9 Since the coin list maintains its own internal connection to the country 

file using special files to contain a copy of the coin records, these files 

will not contain any records you may delete from the main EzCoin 

application. You can use this option to refresh the coin list as needed. 

10 The left side of the coin list window can show an image pane area, 

similar to what the report viewer shows. Use this button to show or hide 

the image pane. 

 

Menu Options 

The coin list options are all contained under the Coin List option in the Navigate 

menu. These options mimic the buttons in the coin list viewer window. 
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Grade Data Viewer 

This window shows a vertical presentation format for the current selected row in 

the Grades tab of the main EzCoin window. The window can be displayed using the 

Grade Data Viewer option under the View menu. 

 

The window is a very simple design. It shows the same fields as in the main data 

grid, but oriented using a top down list. You can resize this window to show as 

many fields as needed. As you select new rows in the main window data grid, this 

view will always be updated at the same time to show the selected row’s field data. 

You can edit the data by double clicking anywhere within the vertical field list. 
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The buttons across the top of the window mimic the functionality of similar buttons 

in the main EzCoin window under the grades data grid. 

 

Comments 

Comments are shown as a small window below the coin images and the coin 

description. The images and comments share the same vertical space within the 

main EzCoin window. You can click + drag the area between the images and 

comments to reallocate the shared space. If you drag downward to completely hide 

the comments window, then you will need to use the alternate comments window 

to view them. 

Main Window Comments Area 

 

You can display the comments in a secondary window using the Comments 

Windows option from the View menu. 
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Secondary Comments Window 

 

Use the blue checkmark button in the comments window to save your coin changes. 

The eraser icon will clear the current comment text. 

Special Notes and Information 
For pre-supplied country files, SoftPro may provide additional information for some 

coin records, in the form of comments or images to convey this information. You 

can determine if special information is available based on the status of 2 icons in 

the main toolbar window. 

 

The special information and notes buttons will be enabled when the associated type 

of information is present for the current coin on screen. 

Simply click on one of these buttons to show the information. 
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Special information windows may have images or text comments. Special notes will 

only contain text comments. 
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Working with Country Files 
EzCoin uses a single database file to store each country. These files are located in 

the DB folder in the EzCoin installation file and have an extension of .SDF. Country 

files supplied by SoftPro will contain pre-supplied coin information, and will need to 

be initialized for first-time use. When opening a country file for the first time, you 

will be asked to confirm a one-time configuration of the file. This task is relatively 

quick and is required before you can use the file. 

Trial (Demo) and Release Country Files 

Trial versions of EzCoin can only work with demonstration versions of country files. 

A trial country has a limited activation period (approximately 30 days) and will only 

contain a limited subset of pre-supplied coin information and images. In addition, 

some of the more advanced features of EzCoin will not be available with the trial 

version. 

Once you register EzCoin, release versions of country files can now be used. 

However, trial versions will no longer function with a registered EzCoin. Trial 

country files can’t work with a registered EzCoin and registered versions of EzCoin 

can’t open trial country files. 

Converting a Trial Country to Release 

If you have inventoried information into a trial country file and wish to import this 

into a Release version, you can do so using the Secure Export feature. Simply open 

a trial country BEFORE you enter an activation code for EzCoin. Then choose the 

Secure Export option to save all your inventoried data to a ZIP archive file. After 

activating EzCoin, open the release version of the same country file as the trial 

version. Then use the Secure Import option to load of the trial data into the country 

file. Note: You will NOT be able to export the data after activating EzCoin, since a 

demo country can’t be opened with the release version of the application. 

 

Opening a Country File 

There are a few ways in which to open a country file: 

 Choose Open from the File menu. This will provide a standard Windows file 

open dialog pointing to the DB folder (or DemoDB for the trial version of 

EzCoin). Select any SDF file from the list and click the Open button. 

 Use the Open with List option from the File menu to show a window with a 

list of country files, their country names (country identity of origin) and their 

descriptions. This window will also show the current build version of the 

country as well as an image of the country’s flag. 
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 Use the Recent Files Open submenu to access the most recent countries 

opened. EzCoin maintains a list of the last 4 country files opened. 

 Enable a general preference option to automatically open the country file 

which was previously opened when you closed the EzCoin application. 

Automatic Backup and Restoration 

A general preference option determines if EzCoin will automatically create a backup 

of your country file if it can be successfully opened. EzCoin will make a 100% copy 

of the SDF file in the Backup folder. 

If for any reason a country file could not be opened, EzCoin will attempt to 

automatically restore the previous backup copy if it’s available. 

EzCoin Country File Browser 

The Open with List option along with many other functions in EzCoin which require 

selection of country files will share a common browser window. 

 

The list shows the country of origin (Country Name), description, file name, and 

build version. All current country files are on version 2.0 of the file format. 

The action button to the left of the Exit button will vary depending on the EzCoin 

option you select (the example screen is for Compacting a country file). 
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The 5 buttons on the left are shared for all options which use this browser. 

Click Hide/Show to change the visibility of country files on this window. You will 

be shown a selection of choices: 

 

Un-opened country files are pre-supplied from SoftPro and have never been 

accessed from EzCoin. You can show/hide these types of files, show all countries in 

the DB folder, or hide the currently selected countries in the list. 

Click on Properties to see statistical information for the selected country. 

The Initialize button allows you to configure all selected countries for first time 

use. Normally, this activity is performed one time as you open each country file. 

EzCoin maintains an installation registry for all country files. If for some reason, 

you have manually removed or added country files directly within the DB folder of 

EzCoin, then they will not appear in the registered list. The Refresh List button will 

examine each country file and update the country registry if needed.  

Double clicking any row in the list can be used as a shortcut for the action button. 

For a file open action, double clicking the row will open the associated country file. 

A country which has never been opened at least one time will show un-initialized in 

the list. Until you open the file, EzCoin will not show any details about the country 

in the list, unless you choose the Refresh List or Initialize options. 

 

Closing a Country 

To close a country, you can choose the Close option from the File menu. However, 

a country file will automatically be closed when you open another country, and also 

when you close the EzCoin application. 
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Creating a New Country 

If you want to create a new country, use the New option from the File menu. 

 

Data File Name This is the actual file name the country will be created as. 

The .SDF extension is not required to be entered here. 

EzCoin will default the country file name if you choose a 

country reference from the dropdown list. You will not be 

allowed to create a country file if the name is already in 

use. 

Country Reference All custom and pre-supplied countries are provided in this 

dropdown list. You can choose any of them from the list, or 

create a custom country reference by simply entering a new 

text value in the dropdown field. 

Description The description is pre-populated when choosing a country 

reference from the dropdown list. To enter a new 

description, enter any text value of your choosing. 

Currency Factor The default currency conversion rate is 1.0, which means 

the country defaults to U.S. Dollar (USD) currency values, 
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which is how pre-supplied country prices are provided. If 

you set a new conversion rate, EzCoin will automatically 

adjust prices and values as needed on screen and in printed 

reports. Internally, the currency is always stored in U.S. 

dollars. 

Currency Decimals The number of decimal places for the fractional part of the 

currency value. The default value is 2, which corresponds to 

cents in U.S. dollars. 

Currency Symbol The currency symbol is an arbitrary text value, which can 

be placed to the left or right of the currency value. The 

default value is the U.S. currency dollar ($) symbol, and is 

placed to the left. You can use more than one character for 

the symbol and it can include spaces. 

Include in Grand 

Totals 

Check this option to include this country in the grand totals 

reports. If not checked, EzCoin will exclude it from the 

report. 

 

Country Labels 

Click the Labels button to define custom labels for the 4 alternate catalog ID 

values, serial number and location fields. EzCoin will assign default label text for 

you should you choose not to customize them. 

Grade and Denomination Source 

You will need to assign a grade list and denomination list for any custom country. If 

you want to use grades and denominations from an existing country file, choose an 

SDF file from the dropdown list. 

To assign grades or denominations from an exported data file, you the Grades or 

Denominations buttons.  

You will need to export a grade configuration to a grade (.GRD) file to use the 

Grades button. 

You will need to export a denominations configuration to a denominations (.DEN) 

file to use the Denominations button. 

Custom Country Creation 

If you enter a Country reference which isn’t in the current dropdown list of available 

supplied/custom countries, then a second window will be displayed, requesting 

additional information before the file can be created. 
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This window provides the basic information needed to register a new country type 

with EzCoin. The identity doesn’t have to be a physical country per se; any type of 

naming convention of your choice will work. 

The data directory name uniquely identifies the country, and determines the folder 

name for custom images. 

The upper case and mixed case names are usually the same. 

The flag/image dropdown list contains all files installed under the Images\~~Flags 

subfolders in the EzCoin installation path. If you intend to create custom flag 

images, you need to adhere to the proper dimensions for the small (80 pixels width 

by 50 pixels tall) and large (176 x 110) files. Each file must have the same name, 

and be located in their respective Small/Large subfolders. 

Once a country file is created, you can open it in EzCoin. The file will not have any 

coin information in it. As a custom country format, you are responsible for 

populating the data. If you want to make use of pre-supplied country information in 

a new country file, you can use the duplicate or merge utilities. 
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Importing Data from Prior Versions of EzCoin 

If you have a previous version of EzCoin with the Version 2 Export menu option, 

you can export all of your inventoried data to a special archive file with an 

extension of .EZ2. Use the Import from Prior EzCoin option from the File menu in 

EzCoin 2 to populate the data into an existing country file. 

 

Use the Open File button to browse for a version 1 export file. If the archive 

contents are validated without error, the following information is displayed at the 

top: 

 Name of the country of origin 

 The country file description 

 The original EzCoin version 1 data file the export was created from 

 The number of inventoried coin records 

Below this information are some import options. 

Location Copy EzCoin version 2 contains location fields for both the 

primary coin record and for individual grades within the 

same coin record. When importing the location field, you 



EzCoin Reference – Version 2.0 

Page | 77 
 

will need to indicate how this field is copied. 

Link Pre-Supplied If the country of origin can be referenced to any installed 

pre-supplied country in EzCoin version 2, then entries will 

appear in the pre-supplied dropdown list and the pre-

supplied checkbox option will be enabled and checked by 

default. Uncheck this option to create a custom country. If 

no pre-supplied data can be matched based on country 

name, you will not have any linking option. 

Copy Custom 

Images 

Check this option to copy all custom images from version 1 

of EzCoin to version 2. Note that this feature is just a 

simple shortcut to physically make copies of all image files 

from their version 1 location for version 2. You will need to 

set the path for version 1 images if you choose this option. 

 

Please read the section at the end of this help topic 

regarding image links between version 1 and 2 of EzCoin. 

Preserve Custom 

Grade Values  

This option determines if you wish to keep any custom 

grade values for pre-supplied coin records in version 2 

which contain the latest market value prices. If you 

preserve your custom values, then your version 1 prices will 

supersede the latest version 2 pricing from SoftPro. If this 

option is not checked, then custom values are only retained 

if there are no pre-supplied prices for version 2 grades, or 

for any record which is a custom variety. 

Market Value 

Assignment 

Unlike EzCoin version 1, you are permitted to define or 

change a market value for any grade, with the 

understanding that any pre-supplied value from SoftPro 

could potentially replace it on a data patch. 

 

Since many grades may lack pre-supplied values, the 

market value should be populated whenever possible, as 

opposed to strictly using the user value field. When you 

check this option, any user value will copy over to the 

market value for any coin grade where a market value 

doesn't currently exist. 

New File Name The file name will be set based on the version 1 file name 

and/or the pre-supplied country file source. See the notes 

below on importing into an existing file versus creating a 

new file. 
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New Description If you want to customize/change the description for this 

country, enter a new value in this field. 

New Versus Existing Country 

If you import into an existing version 2 country file, all customizations and 

inventoried information are discarded.  

If you choose to install into a new country file, with the pre-supplied link option, all 

pre-supplied version 2 information will be merged with your inventoried coin data 

into the new file. 

Note that you may not import pre-supplied version 1 coin data into version 2. 

EzCoin version 1 pre-supplied information is not compatible with version 2. If you 

need the pre-supplied version 2 data for a country, you will need to purchase the 

country file data with EzCoin. 

Adding Version 1 Inventoried Data to Version 2 Data 

If you have inventoried coin records to the target version 2 country file and wish to 

add version 1 data on top of this, you can't do this directly through the import 

utility. You will need to import version 1 data into a new country, and then use the 

country file merge utility to combine the 2 files together. 

Exporting from EzCoin Version 1 

The latest version of EzCoin version 1 will contain a menu option to export the 

current open country as a special archive file. 
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If you don't see the Export for EzCoin V2 menu option in version 1 of EzCoin, you 

will need to download the latest version from SoftPro. 

Selecting this menu option will display a small dialog window. 

 

Click on the Export button and you will be prompted to enter a file name. An 

extension of .EZ2 will automatically be added to the file name, and it will be saved 

by default to the ExpEz2 subfolder of EzCoin. 

This will be the file used for the import option in EzCoin version 2. 

Pre-Supplied Image Link Restoration 

By default, image links (the file name references to images stored in a pre-supplied 

library from SoftPro or image files stored on your PC) for pre-supplied coin records 

will be set to EzCoin Version 2 file names. 

This may produce unwanted results if you've overridden the images with your own 

custom versions. The ideal way to override pre-supplied images is to put files with 

identical names into the Images subfolder in EzCoin using the Image Link utility. 

EzCoin will always take a custom image file with the same name as a pre-supplied 

image. 

However, if you used a different file name in version 1 of EzCoin, you will lose the 

custom link when using the import utility. For this reason, a separate Image Link 

Restoration option is provided (File menu, Export and Import, Restore Image 

Links from Version 1). 

Make sure the country file is opened for image link restoration. Choose the menu 

option to see the following screen. 
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Use the Browse button to select a version 1 backup file (.EZ2 extension). 

Click on Restore to restore all custom image links for pre-supplied coin records. 

Note that custom variety coin records will already have the correct image links and 

will be unaffected. 

EzCoin will generate a log file of any restored links. 

Note that you should have chosen the copy image files from the EzCoin Version 1 

Import Utility, so that the actual image files will be located in the correct folder. 

 

Restoring or Removing Version 1 Custom Grade Values 

The initial release of EzCoin version 2 didn't provide an option to preserve custom 

grade values from version 1, for any coin records which are pre-supplied in version 

2 from SoftPro with the latest market prices. In effect, your custom values would 

have been superseded by default with the latest version 2 market prices from 

SoftPro. 

It's important to provide you the choice to remove or keep these version 1 custom 

prices. As such, after December 20, 2014, the Version 1 import option had the 

Preserve Custom Grade Values option added, which is reflected in this help topic.  



EzCoin Reference – Version 2.0 

Page | 81 
 

For users who have already imported their version 1 coin data into version 2 prior 

to December 20, 2014, a separate utility has been added to the Export and 

Import options under the File menu named Restore V1 Custom Grade Values. 

Make sure the country file is opened for grade value restoration. Choose the menu 

option to see the following screen. 

 

Use the Browse button to select a version 1 backup file (.EZ2 extension). 

Click on Restore to restore all custom grade values for pre-supplied coin records. 

Note that custom variety coin records will already have the correct custom grade 

values and will be unaffected, as will any coin grade values where there is no 

associated version 2 pre-supplied market value. 

EzCoin will generate a log file of any restored values. 
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Secure Import and Export 

This is available from the Export and Import option under the File menu. A secure 

export is a special encrypted portable ZIP archive of your inventoried coin 

information. It’s not intended to be used as a replacement for the archival backup 

process in EzCoin. Secure data exports are designed to take a snapshot of your 

country data for troubleshooting or data transfers between multiple systems. The 

ZIP archive will be much smaller than the SDF file equivalent. 

 

For any open country file, simply enter the name of a file and click the Begin 

button. The files are saved to the Export folder in the EzCoin application path. 

 

For importing the data back into the country file, use the Browse button to locate 

an export file (default location will be the Export folder), then click the Begin 



EzCoin Reference – Version 2.0 

Page | 83 
 

button. Note that EzCoin will close the country file before importing, as the file can’t 

be opened during the restoration process. 

 

  



EzCoin Reference – Version 2.0 

Page | 84 
 

Cross Reference Import and Export 

Cross reference export and import options are available from the File menu under 

the Export and Import submenu. This is an advanced feature which allows you to 

review and revise the alternate catalogue ID data using a tool external to EzCoin 

such as Microsoft Excel. 

 

Since it's possible that data values may contain characters with special accents to 

support multi-lingual text, the export files are always saved in UTF-8 format. 

The fields exported will be the following, and the first row in the data represents the 

field labels, which must never be changed, or you will never be able to re-import 

the data. 

 Denomination 

 Year 

 Type/Reign 

 Variety 

 Mint Mark 

 UID 

 Supplied Cat ID 1, 2, 3, 4 (Only if pre-supplied number is defined) 

 User Cat ID 1 

 User Cat ID 2 

 User Cat ID 3 

 User Cat ID 4 
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The export file will only contain inventoried records. If you import to something like 

Excel, which prompts you to set the type of data for each column, please make sure 

all columns are treated as text fields, and not converted to numbers. 

You must not change the 5 key fields (Denomination, Year, Type/Reign, Variety, 

Mint Mark), as this data is used to match the coin record when importing. If you 

modify a UID or pre-supplied catalog ID value, be aware that any supplied data 

updates from SoftPro with data in this fields will replace your version of this data. 

When you are ready to import the cross reference back into EzCoin, choose the 

import option from the menu. 

 

Use the checkbox fields to selectively choose which ID numbering system to import. 

Note that this feature does not create a country file backup. 

It's recommended you retain the original export file unaltered, so that you can 

always restore the cross reference data if needed from that backup. 

A Note About Saving From Excel  

When saving changes to text export files from Excel, ensure that you always choose 

the “Save As” option and not simply “Save”, as this may alter the content of file to 

be different than what was exported. Either save the file as Unicode format or Tab-

Delimited text as a new file to ensure special characters are preserved. 
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Country File Settings 

This option in the File menu allows you to change some basic settings for the 

current open country file. 

 

You can change the same basic information which is available when creating a new 

country. Refer to the country file creation topic in this manual for a summary of the 

various settings in this window. 

You can change the data file name as long as it’s not in use by any other country 

file. 

Changing the currency conversion factor will automatically result in price and value 

recalculations for the country file when you close the dialog window. 

 

Country File Properties 

This option is available in the File menu and also by clicking the Info icon in the 

top right corner of the EzCoin main window. It will display basic summary statistics 

for the current open country file. 
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Basic information is displayed in a scrollable spreadsheet view. 

Note that you can change the flag image for any country file after it's been created. 

You must choose from an existing flag image or create one yourself. 
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Country File Utilities 
This submenu under the File menu contains several important options for 

maintaining and supporting the data contained in your country files. Some of these 

options require a country file to be opened, and others will prompt you to close the 

country file for proceeding. 

Supplied Data and Pricing Updates 

When SoftPro issues supplied data and pricing updates for country files, they are 

provided as special files which are transparently applied to the read-only pre-

supplied repository inside the country file.  

An EzCoin country file consists of two parts (let's call them Parts A and B): 

 Part A is a read-only copy of all pre-supplied coin information and prices. This 

is how new country files are provided on the original EzCoin CD/DVD media. 

 Part B is a copy of all of the same information as in Part A, PLUS any 

additional inventoried information you add. Almost all of the pre-supplied 

information, including prices, can be modified, and this is all saved in the 

second part of the file. 

When supplied updates are applied to a country file, EzCoin will only make the 

updates to the read-only copy (Part A) of the file. Your inventoried data and the 

modifiable pre-supplied data (Part B) are left intact. A pre-supplied update will 

synchronize the Part A data to the Part B data. 

EzUpdate and Supplied Data Updates 

The EzUpdate application is used to apply supplied pricing and data updates to 

EzCoin. The update application itself doesn’t have any functionality to work with 

country files – that capability is exclusive to EzCoin. What EzUpdate does is place 

country update files into the EzCoin application path, to prepare them for import 

the next time your run EzCoin. 

When EzCoin starts with pending updates (there can be multiple country files 

pending, EzCoin will handle all of them in order), you will see a small dialog window 

appear, which you will not be able to cancel (but you can click STOP and the 

process will stop AFTER the current file has been updated). 
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EzCoin will apply updates to every country file which has pre-supplied data attached 

to it, even if the country is duplicated into more than one file. Once this process is 

completed, a summary dialog window will appear. 

 

This dialog indicates which country files had supplied data updates applied. At this 

point, your inventoried data has NOT been affected, nor have any customizations 

you’ve made to pre-supplied records been touched. Only the read-only pre-supplied 

data repository in the country file has been updated. 

EzCoin and Supplied Data Effective Dates 

Each supplied data update has an effective date assigned to it. When you open a 

country file which has had a supplied data update applied to it, EzCoin will check 

the current data’s effective date to see if new updates have been applied to the 

read-only copy of the coin information. If a newer date is detected, a small warning 

dialog will appear: 
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You can choose to ignore this dialog, cancel, or apply the update. Clicking Ignore 

turns off the nag dialog for this country – you will not get nagged again for this 

update. Clicking Cancel will skip the update process, however you will once more 

be nagged with this dialog the next time you open the country. If you click Apply, 

the supplied data and pricing update window will be shown. This is the same as 

choosing the similar named option from the Country Date File Utilities submenu. 

 

The top of the window shows the current pre-supplied effective date of your copy of 

the coin data, and the effective date of the read-only copy of the same data. If your 

data is up-to-date, only one date will be shown – you can still re-apply the update, 

even if it’s not needed. 

The checkbox options allow you to choose what pre-supplied data to update.  
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Pre-Supplied Prices All pre-supplied grade market values will be updated. Any 

custom grade market values associated with a pre-supplied 

coin record and its associated grades will replace your 

customized market value. 

Primary Coin 

Attributes 

Denomination, year, type/reign, variety, mint mark, pre-

supplied alternate catalog ID values, period, mintage, 

designer, mint location, edge, weight, thickness, 

composition, description. If pre-supplied information for any 

of these attributes is blank for a coin record, your existing 

customized values will be left intact. 

Image Links Your custom image links are replaced with the pre-supplied 

image links. If EzCoin doesn’t provide an image link, your 

custom links will be left intact. 

Zero Price and Blank Data in Pre-Supplied Data 

If SoftPro doesn’t provide a price (i.e. market value for MS-65 for a coin) or data 

value (i.e. Designer or Thickness) for a given coin record, then no update is applied. 

That is, EzCoin will not try and write zero prices or empty data values to your copy 

of the pre-supplied data. A valid coin attribute has to be pre-supplied to be included 

in the update process. 

Price Locks 

The option named Do not update any price values for records which have price 

locks is used to control updates for coin records which you have applied a price lock 

to. EzCoin will leave the pre-supplied prices alone for any price locked records. 

Grade Price Update Method 

There are 3 available choices for how to update grade prices: 

Keep your custom prices and update pre-supplied prices: Any price overrides you 

made on a per grade basis (i.e. you entered a value in the Your Value field in the 

main EzCoin window) will be left intact. 

Zero out your custom prices and update pre-supplied prices: Any custom price 

override values you applied to coin records will be lost. This in effect will restore the 

market value of every grade back to pre-supplied values, with the latest effective 

pricing available. 

Zero out your custom prices and retain current pre-supplied prices: This option 

basically resets the pricing structure for EzCoin to the default state you would get if 

the country were brand new, albeit with the existing pricing. The latest effective 

prices would exist only in the read-only repository of the country file.  
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Update Reminders 

If you chose to ignore the dialog which warns you of pending updates when you 

open a country file, you can still see if new pricing is available by looking at the 

EzCoin main window title bar. 

 

Automatic Backups 

A general preference option is available in EzCoin to perform an automatic country 

file backup before applying a supplied data update. This option is enabled by 

default. 

Note: Normal EzCoin archival backups only save your inventoried records. Since 

you may change pre-supplied data without adding a coin to your inventory, EzCoin 

will also include pre-supplied customizations in any backup archive. Supplied 

updates will always replace customizations of this type, if a value is not blank in the 

update data. 

 

Duplicating a Country 

You can make a copy of the current open country file with the duplicate country 

option. 

 

When duplicating the country, you will provide the following information: 

 The new file name, which can’t be the same as any existing country file. 

 The Country Reference is not modifiable – it’s just there for your reference. 
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 The description is taken from the current country file. You can modify this as 

needed for the duplicated file. 

 If you check the Copy Supplied Data option, then all pre-supplied information 

is copied into the duplicated file. If not checked, you will be creating a 

custom country file, which will no longer be part of supplied data updates. 

 If you check the Copy Inventoried Data option, then all your inventoried 

information will be preserved in the duplicated country. The combination of 

these two checkbox options determines the type of duplicate file you are 

creating. Check both to make a 100% identical copy of the original file. 

 

Merging Country Files 

The merge utility allows you to combine one country file into a second file, or 

combine 2 files into a new third file. 

 

Source and Target Files 

The source country is always the file which information is taken from. It will not be 

altered in any way, and it can exist in the EzCoin DB folder or from any location on 

your system. Use the Browse button to locate a country SDF file, or choose one 

from the drop down list. The list will only show SDF files registered with your copy 

EzCoin. 
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The target file must always be in the EzCoin DB folder. You can choose any country 

file as long as the country of origin is identical. For example, you can’t merge 

Canada and USA together, as they are not the same country of origin. 

By default, EzCoin will merge the source file into the target file. The target country 

will contain the contents of both files (based on the merge attributes). If you want 

to merge the source and target to a brand new country file, check the Merge into 

new country file option at the bottom and you will be prompted for a new name and 

description for this file. 

 

Record Exists Options 

These options are applicable when a coin record number exists in both files based 

on the unique combination of the 5 primary coin fields: Denomination, Year, 

Type/Reign, Variety, and Mint Mark. 

Append the source country record as a duplicate: If the coin record exists in both 

the source and target files, the source record will be set as a duplicate and the 

target’s record will remain as the primary record. 

Insert the source country record ahead of the existing record: This option makes 

the source record the primary one – the matching target record is duplicated. 

Overwrite the target country's record from the source file: For matching coin 

records, the source record will replace the matching record in the target file. 

Skip the source country record and don't add it: For matching coin records, the 

source record is ignored and the record in the target file is left as is. 

New Record Options 

These options are applicable when the coin record doesn’t exist in the target file. 

Add the record from the source country file: Add the source file record as a new 

coin record, which may or may not be a custom variety. 

Skip the source country record and don't add it: The source file’s record is ignored. 

Supplied Data Exists Options 

These options are only applicable if either the source or target files contain pre-

supplied coin information. If both files are custom countries, this dropdown list is 

disabled. 

Select a source and target file first: This appears in the list if you haven’t selected 

both files. It’s not really an option, just a visual cue. 
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No supplied data exists in either file: Both files are custom countries, therefore no 

choice will exist. 

Erase the supplied data in the target country (Custom country): This option will 

result in a custom country – all pre-supplied information is discarded and supplied 

updates can no longer be applied to it. 

Use the supplied data from the source country file: All pre-supplied data from the 

source file is copied to the target file. If any pre-supplied data already exists, it’s 

discarded. 

Use the supplied data which already exists in the target country: Pre-supplied 

information which already exists in the target file is left intact. 

Excluding Duplicate Records 

If you check this option, then all duplicate records in the source file are ignored. For 

example if a coin record exists 3 times in the source file for these key values: 

 Denom.: 1 Cent 

 Year:  1882 

 Type:  Victoria, Diadem, Provincial Leaves 

 Variety: Obverse 1 

 Mint Mk.: H 

The main record is kept and the 2 duplicate records are skipped. Any existing 

duplicate records in the target file are left as is. 

By default, EzCoin will merge the source file into the target file. The target country 

will contain the contents of both files (based on the merge attributes). If you want 

to merge the source and target to a brand new country file, check the Merge into 

new country file option at the bottom and you will be prompted for a new name and 

description for this file. 

Record Exists Options 

These options are applicable when a Scott/Catalog number exists in both files. 

Append the source country record as a duplicate: If the Scott/Catalog numbers 

exist in both the source and target files, the source record will be set as a duplicate 

and the target’s record will remain as the primary record. 

Insert the source country record ahead of the existing record: This option makes 

the source record the primary one – the matching target record is duplicated. 

Overwrite the target country's record from the source file: For collisions on 

Scott/Catalog number, the source record will replace the matching record in the 

target file. 
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Skip the source country record and don't add it: For matching Scott/Catalog 

numbers, the source record is ignored and the record in the target file is left as is. 

New Record Options 

These options are applicable when the Scott/Catalog number in the source file 

doesn’t exist in the target file. 

Add the record from the source country file: Add the source file record as a new 

Scott/Catalog number. 

Skip the source country record and don't add it: The source file’s record is ignored. 

Supplied Data Exists Options 

These options are only applicable if either the source or target files contain pre-

supplied stamp information. If both files are custom countries, the dropdown list is 

disabled. 

Select a source and target file first: This appears in the list if you haven’t selected 

both files. It’s not really an option, just a visual cue. 

No supplied data exists in either file: Both files are custom countries, therefore no 

choice will exist. 

Erase the supplied data in the target country (Custom country): This option will 

result in a custom country – all pre-supplied information is discarded and supplied 

updates can no longer be applied to it. 

Use the supplied data from the source country file: All pre-supplied data from the 

source file is copied to the target file. If any pre-supplied data already exists, it’s 

discarded. 

Use the supplied data which already exists in the target country: Pre-supplied 

information which already exists in the target file is left intact. 

Excluding Duplicate Records 

If you check this option, then all duplicate records in the source file are ignored. For 

example, if Scott #500 exists in the source file as a main record and has 2 

duplicate records, then main record is kept and the 2 duplicates are skipped. Any 

existing duplicate records in the target file are left as is. 

 

Removing Country Files 

When you open a country file in EzCoin, the file will be “registered”. What this 

means is that EzCoin keeps a record of the file, how it’s used and accumulates 

statistics on it for the purpose of grand totals reports and supplied data updates.  
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If you remove country files outside of EzCoin, you remove the file without removing 

it from EzCoin's country registry. EzCoin can usually adjust for this, but it’s 

recommended that you use the built in functionality to remove country files you no 

longer need. 

The remove country option uses the standard country list browser window. Select 

the countries you want to remove then click on the Remove button. Note: You will 

not be able to get the deleted files back unless you have a backup to restore from. 

 

Backups and Restoration 

EzCoin uses special ZIP format archive files to create backups of your data files. 

There are also automated backups, which simply copy a country file to a special 

subfolder in the EzCoin application path. 

Automated Backups 
The automated backup processes in EzCoin simply take the current SDF country file 

and copies it to another backup location. Preference options can disable some of 

these automated backups. 

The following processes in EzCoin can have automated backups. Use the Restore 

SDF Files option under the country data file utilities submenu to restore these files. 

Auto Backup Automatic backups are performed every time you open a 

country file. 

Merges These backups take place just before you merge two country 

files together. 

Supplied Updates When you apply a supplied data/pricing update, the country 

is backed up before the update commences. 

Imports Importing from previous versions of EzCoin will create a 

backup before starting. 

 



EzCoin Reference – Version 2.0 

Page | 98 
 

Restoring from an Automated Backup 

 

This window will appear when you choose one of the 4 Restore SDF File options. 

Each type of backup stores the SDF files in a unique subfolder under Backup in the 

EzCoin application path. 

The list shows the file name, size, and date/time of modification. To restore a file, 

select it and then click on Restore. Note the checkbox option at the bottom. The 

restore can back up the current file to the TempDB folder. There is NO provision to 

restore a backup from this folder. If you need to restore anything from TempDB, 

you need to manually copy the file back to the DB folder. 

Restoring from Outside EzCoin 

If you manually copy an SDF file into the DB folder outside of the application, the 

country file registration will not be accurate and grand totals reports will not be 

correct. If you ever do manual restorations like this, always perform a grand totals 

recalculation. 

Removing Automatic Backup Files 

If you wish to reclaim some disk space and no longer need specific backup files, 

select them from the list and click on the Delete button. 
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Archival Backups 
This is the recommended method by which you should backup your data. This 

option is available as Create Backup from the country data file utilities submenu. 

 

Backup Type 

Current Country: This will create a backup of the current open country file only. 

Country backup archives contain only inventoried coin attribute data and any 

customization/configuration information. 

Specific Countries: Use the Select Countries button to select one or more 

countries to backup. 

All EzCoin Data: This option creates a backup of all non-country specific EzCoin 

data, which can include the following: 

 Configuration settings for all dialog windows. 

 General Preferences. 

 Report Profiles. 

 Default Search Conditions for Reports. 

 Custom Search Export Files. 

 Any files you have saved to the User folder in EzCoin. 

 Custom Grade Group Filter Files. 

 Navigation Lists. 

 Custom Categories. 
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 Custom lists (PWL/PSL types, graders, buyers and sellers). 

 Report Field Customizations. 

 Snapshot Files. 

Application Specific Data: This is a subset of the All Data option which is based 

on the checkbox options which appear in the backup window. 

Application Specific Data 

There are 3 types of application specific data, which can be selected when choosing 

this type of backup. 

Application Data: Country registry, graders, PWL/PSL types, buyers and sellers, 

which are all contained in the EzCoin.sdf application configuration file. 

Application Preferences: EzCoin general preferences are stored in a special file 

named EzUser.cdt. This file is always updated whenever you close the application. 

Check this option to include it in the backup. 

Snapshot Files: Check this option to backup the contents of the Snapshots folder. 

Custom Image Backups 

The installation path of EzCoin contains a folder named Images. If you store custom 

image files under this folder, EzCoin can archive them to backup. The way image 

backups work is based on the type of backup. For open country or selected country 

backup types, only the image files associated with the country are included in the 

backup. For the other two backup types, the entire contents of the Images 

subfolder is backed up.  

Backup Location, Name and Description 

The default location to save the archive to is the Backup folder in the EzCoin 

installation path. Use the Browse button to set a different backup path. The 

backup name and description can be any text values of your choosing. 

Backup Verify 

Use the Verify button to check the amount of data to backup, and to also ensure 

the files to be backed up are without error. 

Backup File Format 

All archive backups are saved as 2 files, one with a .CFG extension and the other 

with a .ZIP extension containing all of the backup data. You can’t restore from 

backup without the .CFG file. You can open the .ZIP file, but you will not be able to 

restore any data to SDF-type files without using EzCoin. All of the other data files in 

the archive are stored as they exist in the EzCoin installation path and its various 

subfolders. 
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Restoring from Backup 

Use the Restore from Backup option to restore all or part of a backup archive. 

 

The restoration window allows you to selectively choose what data to restore from a 

given archive file. 

Use the Browse button to select an archive configuration (.CFG) file. EzCoin will 

locate the associated .ZIP file and validate its contents before allowing you to 

choose the restoration options. 

The top of the window is summary information for the contents of the archive, 

including its type, backup date, description, number of files and size. 

The checkbox options allow you to select which items in the archive to restore. If 

items associated with a checkbox options are not actually in the archive file, the 

checkbox option will be grayed out. 

If country or image files are contained in the archive, then the Select Images and 

Select Countries buttons will be enabled, allowing you to restore the country file 

data and/or the image files associated with the country. The Restore All buttons 

simply select every country or image file directory available in the archive. 
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Once you start a restoration, it can’t be undone. If a restoration did not complete 

100%, you can attempt the restoration again. EzCoin will resume the restoration 

from where it was halted. 

Country file restorations are intelligent. If any error happens during a country file 

restoration, all changes made to it are rolled back and the file is left as it was 

before the restoration started. However, EzCoin data file restorations can’t be rolled 

back. Once files are replaced from backup, they are changed for good. 

IMPORTANT: If any Application settings have been restored from any backup, you 

will need to restart EzCoin in order for these changes to take effect. 

Verification, Repair and Compaction 

These options are available under the country data file utilities as Verify, Repair, 

and Compact. EzCoin uses Microsoft SQL database technology for the country file 

storage format, and as such, these utilities make use of built in features within this 

platform to handle the work. As a side effect of this, all 3 of these features can take 

several seconds or more to complete for a single country file, during which time 

EzCoin will not be able to respond to your input (i.e. you can't cancel the request). 

All 3 options make use of the standard country list browser window. 

 Verification will open selected country files and check them for any internal 

database errors. If any errors are detected, use the repair option to attempt 

to fix them, or make use of data backups to restore from. EzCoin contains 

extensive error handling and detection methods to keep your country files in 

good working condition, which should prevent errors from ever happening. 

 

 The Repair option will attempt to fix a county file which can’t be opened by 

EzCoin. The repair process is part of the Microsoft database product, so the 

effectiveness of the data repair can’t be documented. If you still can’t open 

the country file after a repair, or critical data has gone missing, or the repair 

fails, then you will have to restore from a backup archive. 

 

 The Compact option will attempt to reclaim unused space within the SDF file. 

EzCoin has an automated compaction timer built into each country file, which 

can be configured using the general preferences. 
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Version Upgrades 

Country files contain a highly optimized structure for storing coin records, 

configuration and customization options. If future updates to EzCoin involve 

additions of new features which require extending the country file structure, it will 

be necessary to ensure your existing files are kept up-to-date. Each country file has 

a build number, which is indicated in the country file list browser window. This is 

also shown in the properties window as the Data Version attribute, which is 

currently build version 2.0. 

If the file structure changes, a new build number will be issued in the EzCoin 

application. When you attempt to open a country file which has an older build 

version (i.e. out-of-date), you must upgrade the country file to the latest build 

version. 

The option Update Version in the country data file utilities submenu is provided 

for updating your country file’s structure to the latest format. 

Currently, version 2.0 is the only build format, and as such, the update option will 

simply inform you that the country file is up-to-date. 

Note: EzCoin version 1 files can't be upgraded using this feature. You must export 

the version 1 data from the older version of EzCoin, and then import it with version 

2. 

 

Resetting a Country File 

This option is intended only for restoring a country file to a pre-supplied un-

initialized state. All customizations and inventoried coin information will be 

discarded, leaving the file the way it was when you first installed it from the 

EzSetup application. Be aware that you will not be able to get the data back once 

you reset the country. 

 

EzCoin Cloud Backup & Restore 

The Cloud backup feature is a new option available from the Extras menu. This 

type of backup stores the files remotely on a Cloud server. There are some 

differences between normal backups and Cloud backups which are summarized 

below. It's recommended that you continue to rely on your local backups as the 

primary method to safely store your collection data. 
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Cloud Backup vs. Local Backup 

Given that the Cloud backups must be stored on a remote server shared with other 

EzCoin users, there are some limitations with this type of backup to ensure capacity 

on the server is sufficient, and that the backup process is streamlined for ease of 

use. 

 Only 1 backup of a country file's data can be store on the Cloud server. 

 Country backup files are segregated for efficiency in selective backups and 

restorations. 

 No options are allowed to choose what to backup. Each country is backed up 

as complete inventoried data (excluding pre-supplied information which 

hasn't been customized). 

 Application data is always transparently backed up with any country file. 

There are no options to choose what type of application data to backup. All 

data is backed up, with the exceptions listed below. 

 Supplied & Custom images and snapshot files are not saved to the Cloud 

server. These items can be quite large, making file transfers slower and 

require significantly more capacity than the normal backup data. 

 As data must be moved into and out of the Cloud server, backups will never 

be as fast as the local file backups in EzCoin. The speed of Cloud backups is 

dependent on your Internet connection speed, the Cloud provider's 

bandwidth, and your PC's performance level. 

Registering for Cloud Backups 

Under the Cloud submenu in Extras, choose the item Register for Use. This will 

show a dialog as follows. 
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The Cloud Identity key is a 6 character code used to reserve space on the Cloud 

server for your backups. The key and registration process is a one-time process - 

simply contact SoftPro to obtain a Cloud backup key. Then enter the key into the 

fields in this dialog to complete the registration. A minimal fee applies ($10) 

Re-Registration and Multiple Keys 

A Cloud key reserves one area on the server for your backups. The key is stored 

locally with the installation of EzCoin. If you install multiple copies of EzCoin, or re-

install the application for any reason, you will need to re-register with the key 

again. 

Important Note: You should never perform backups or restorations from 2 

different installations of EzCoin at the same time, even if the application resides on 

different PCs. As there is only one set of backup files on the server, attempting to 

access them at the same time from multiple copies of EzCoin can result in errors or 

potentially lost backup data. 

That being said, if you have multiple installations of EzCoin and prefer to keep 

separate Cloud backups, you can request an additional Cloud Identity key to use for 

a different copy of EzCoin. This allows you to keep the backups completely separate 

from each other. Note that SoftPro may restrict the number of additional keys 

which may be issued. 

Cloud Backups 

Choose the Backup option from the Cloud menu. This will present the following 

dialog window. Note that there will be a brief delay before this dialog appears, as 

EzCoin will need to check the server for backup contents and perform some basic 

integrity checks on the data to ensure everything is valid. 
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The list presented is identical to the one you see using the Open With List menu 

option to select country files to open. If you have hidden any countries from the list 

when using the Open With List option, then they will also be hidden in the Cloud 

backup list. 

Each item in the list will have an icon displayed to the left, which can be any of the 

following: 

 Blank means no backup exists on the cloud server. 

 
The entry is marked for backup. You will need to mark files for backup using 
the marking buttons at the bottom of the dialog. 

 
There is a valid backup file on the server. 

 
When a backup has been completed, the icon will change to the green 

checkmark to indicate success. 

 

Selecting Backup Data 

To backup just the application data, don't mark any country files and click on the 

Backup button. This will transfer the application data to the Cloud server. 

To backup countries, select the ones you wish to backup, and use the Mark Files 

button. To backup all countries, use the Mark All button. 
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Initialize and Refresh 

The Initialize and Refresh buttons serve the same purpose as in the Open With List 

dialog.  

The Initialize button will apply a first-time initialization to all selected countries. 

Note that opening any country file in the main EzCoin window will also perform this 

function automatically for you. The Initialize button is primarily intended for those 

users with many country files for which initialization can be accommodate for all 

files with a single click. Note that initialization for dozens of countries can take 

several minutes to complete. 

The Refresh List button will check all country files for description and version 

details if they haven't been opened yet. 

Starting a Backup 

When you are ready to start the backup, click on the Backup button. As each 

backup is made to the server, the icon status will change to a green checkmark. 

Note that the version and file size information are not updated in the dialog until a 

backup resides on the server. 

Cloud Restoration 

Choose the Restore option from the Cloud menu. This will present the following 

dialog window. As with the backup option, there will be a brief delay before this 

dialog appears while EzCoin checks the server for backup contents. 
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The cloud restoration dialog shows the same basic list of country files, with one 

notable difference: Only files residing on the Cloud server are displayed. 

There are additional icon states for the restoration list: 

 
The entry is marked for backup. You will need to mark files for restoration.  

 
There is a valid backup file on the server AND there is also a local matching 

file with the same country identity.  

 
The backup file on the server has a country identity that doesn't match the 

local country installed in EzCoin. You will not be able to restore from this 
backup unless you rename the local country file to something else. 

 
The restore was completed from the server without error. This only appears 
once you click on the Restore button. 

 
A server backup exists but no local file with the same name exists in the 
EzCoin application folder. See the section below to understand how restoration 

works without a matching country file in EzCoin. 
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Restoring Without a Matching Country File 

Similar to local backups in EzCoin, the backup information only contains inventoried 

records, customizations made to pre-supplied data, or any coin attributes not 

associated with pre-supplied information. 

When restoring custom countries from backup, there is no difference between 

restoring to a country file which already exists in EzCoin, or for when a file doesn't 

exist, as the backup file contains 100% of the country data. 

For pre-supplied countries from SoftPro, pre-supplied pricing, image links, and 

other pre-supplied coin attributes are not backed up, unless you have changed their 

pre-supplied values to create customized records. 

If you restore a local or Cloud backup file to EzCoin and the country isn't already 

installed, you will end up with a custom country restoration without pre-supplied 

data (non-inventoried coin records will not exist in the restored file). 

For this reason, always ensure you have the pre-supplied country files re-installed 

before performing and restoration. If for some reason, you don't do this, then you 

will need to merge the pre-supplied data into the restored file from a copy of the 

pre-supplied country file. If you run into this scenario and are unsure of how to 

proceed, contact SoftPro for assistance. 

Starting a Restoration 

There are two buttons available for restoration. Restore App Data will only restore 

application backup data - no countries are restored. Restore Countries will always 

restore application data first, followed by the countries which are marked. 

As each restoration is made from the server, the icon status will change to a green 

checkmark. 

Resuming Backups or Restorations 

Since Cloud backups require an Internet connection, there is always a remote 

possibility that a connection can be dropped during a file backup or restoration. 

EzCoin has auto-recovery capabilities to restore any prior backup of country or 

application data if the backup session was ended unexpectedly. 

For restorations, a lost connection will result in no lost data, but you will be 

required to manually select the files to restore which were not completed.  

EzCoin maintains a log file for backups and restorations, which can be found in the 

application's User folder as file names CloudRestore.log and CloudBackup.log. 

These log files are plain text format and indicate the status of each file backed up 

or restored, and any error conditions that may have been encountered. 
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Assigning a Country to Import Pre-Supplied Data 

If you attempt to restore from a country which is not already in EzCoin and the 

backup references pre-supplied coin information from SoftPro, you will be provided 

a dialog window to assign pre-supplied information from an alternate installed 

country.  

Responsibility for Data 

By using SoftPro's Cloud Backup module, You acknowledge and agree to take full 

and sole responsibility for all files and data transferred, and to maintain all 

appropriate separate local backup of files and data stored on our cloud servers. 

SoftPro will not be responsible for any data loss of your uploaded data from your 

account under any circumstances. 

 SoftPro does not assume any liability whatsoever for actual, direct or indirect 

losses or for losses incurred due to the unavailability of use or data losses in 

connection with the use of SoftPro's Cloud Backup services.  

It is good backup practice to have multiple backups of your data. SoftPro suggests 

a 3 tier backup solution. 

1. Backup to your hard drive 

2. Backup to a physical external drive or Flash/USB Drive 

3. Cloud Backup 

Should any one fail for any reason, you will have alternate methods of data 

recovery. 

Cloud backups & What to Use them For 

Cloud backups give you extreme flexibility for restoring data across several devices. 

One of the most important is the ability to Synchronize laptops/tablets & PC’s. 

Imagine being on the road or travelling & you forgot to bring your EzCoin backup 

on your flash drive. With Cloud backups, you can restore your cloud data onto your 

laptop & enter your coins or purchases. Then do a cloud backup when you are 

done. When you get home, you can do a Cloud Restore to your desktop & continue 

where you left off. With cloud backups, your data is available to you anywhere you 

have an internet connection. You data is extremely secure in our cloud service. All 

EzCoin cloud data uses AES-256 bit encryption. The cloud backup is intended to be 

an extra layer of data protection for your data. You should still continue to do local 

EzCoin backups to your hard drive & an external drive/flash drive. 

Restoring Backups Without Installed Countries 

When restoring from either local or Cloud backup files, EzCoin will check the 

countries which are being restored to see if they have references to pre-supplied 

coin data from SoftPro. 
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Backup archives only contain your customizations to a country file, plus any 

inventoried coin data not provided by SoftPro. When restorations are made from a 

backup, EzCoin will look for the country file with the same name to see if it's 

already installed. If the country file is present, EzCoin will merge pre-supplied 

information in the installed version and replace all of your custom/inventoried 

information from the backup archive. 

Since the backup archive doesn't contain the pre-supplied coin data, it's important 

to have the ability to import that information from a compatible country which is 

already installed. 

EzCoin will provide you with a special dialog window to assign an installed country 

with pre-supplied coin information to use as the source when restoring a country 

from backup. 

An example of this dialog window is shown below. 
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For a backup file to appear in the list, it must meet the following conditions: 

1. The backup country must not be custom. If the country was not associated with 

pre-supplied data from SoftPro at the time of backup, it will not appear. 

2. The country is not already installed with the same file name in the DB subfolder 

of the EzCoin application path. 

Assigning a Country to Import Pre-Supplied Data 

To assign pre-supplied coin information to a backup country, follow these steps. 

1. Select the country from the list. 

2. Select a compatible country from the drop down list. 

3. Click on the Assign button. Use the Un-Assign button to remove the pre-

supplied association. 

A compatible country is one which is based on the same country of origin, and 

contains pre-supplied coin information from SoftPro. For example, you can choose 

USA for any backup country which is based on the country United States, as long as 

the installed version of United States contains pre-supplied information. 

You may choose to restore any country without pre-supplied information. However, 

a warning will be given asking you confirm your decision. In this case, the country 

will be restore as a custom format, and no pre-supplied coin data will exist after the 

restoration is completed. 

An example of a pre-supplied assignment is shown below. 
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Navigation 

Finding Coin Records 

Primary Key Lookup 

The easiest way to find a coin record is to enter values into one or more of the 5 

key fields in the top left section of the EzCoin main window and press the ENTER 

key within one of those fields. Dropdown lists are provided for each of these fields. 

 

The 5 key fields are Denomination, Year, Type/Reign, Variety, and Mint Mark. A 

coin record's uniqueness is determined by the combination of these 5 fields. You 

are not permitted to use partial values for any of these fields (Power Search can be 

used for that type of lookup). 

If multiple matching records are detected based on the 5 fields, a pick list window 

will appear using the standard EzCoin Report Viewer window: 
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You can simply double click any coin entry in the list to select it into the main 

EzCoin window. 

Note that the most recent 8 lookups using this window can be recalled quickly using 

the popup menu items from the main EzCoin toolbar, as indicated below. 

 

Coin Not Found and Custom Varieties 

If a coin can't be found based on the 5 key fields, you will be informed that the coin 

record can't be found. If you wish to create a custom variety from these 5 key 

fields, click on the button with the Blue checkmark to add this variety to your 

collection. 

Drill Down Mode 

This feature can be enabled by holding down the Ctrl key while pressing ENTER in 

any of the 5 key fields of the main EzCoin window. You don't have to populate any 

of these 5 fields to start a drill down search. A window will be displayed with 

filtering options: 
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For any combination of the 5 key fields shown, all possible matching records will be 

shown. When you have a coin record selected, click on the Choose button (or 

double click the record in the data grid) and it will be displayed in the main EzCoin 

window. 

As you select a value from one of the 5 drop downs, the other 4 fields will 

automatically be filtered to show all possible coin combinations. The selected field 

will be locked from being changed - you are basically forming an "anchor" point, a 

field which determines the available values for the remaining fields. 

Once you select a value from one of the remaining fields, it too will be locked down 

and further filter fields. For example: 

 Choose a year. It will be the anchor for the remaining 4 fields. The dropdown 

values will show all possible values for coins based on the year chosen. 

 Choose a variety. It will be the anchor point for the remaining 3 fields, which 

will further be filtered to show a smaller number of possible coins. 

 Once you have chosen a unique combination of the 5 fields, the match count 

will sit at 1. 
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Click on the Reset button to clear all 5 key fields and start a new drilldown filter. 

You are free to enter partial text string in any field, which can be completed by 

clicking the down arrow button on the right of the associate drop down list. 

Check the Sort by Year option to display matching records in year order. 

Otherwise they are displayed in denomination order. 

Alternate Catalog ID Lookup 

To the right of the Denomination field is an input field with an alternate catalog ID 

label above it. There are up to 4 pre-supplied alternate numbering systems for a 

country file and up to 4 user catalog ID numbering formats available. 

 

Not every pre-supplied country issued by SoftPro will have alternate numbering 

systems. If one is available (such as PCGS for USA), it will appear when you left 

click on the label above the input field. 

The first 2 catalog ID values can come from EzCoin version 1 import files. The 3rd 

and 4th user values are new to EzCoin version 2. Pre-supplied catalog ID values will 

appear below the user versions in the popup menu. 

To perform a lookup on an alternate catalog ID value, make sure you have selected 

the correct type from the popup menu, as only one numbering system can be 

active in the main EzCoin window. 

You can rename the labels for the 4 user catalog ID numbering formats by choosing 

the Rename option from the popup menu. This will present the same dialog as the 

Change County Field Labels item from the EzCoin Options menu. 
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Searches and Reports 

Any of the search and reporting options in EzCoin provide comprehensive search 

conditions to locate coin records easily. Power Search is perhaps the best choice to 

search for coin record with unique properties, as it can partially match on almost 

any field in a coin record. 

 

UID (Coin Unique Identifier) Lookup 

To the right of the Mint Mark field is an input field with the label of UID. The unique 

ID value is assigned for all coin records for pre-supplied coin records. It's an 

optional field for any custom country files or custom variety coin records. 

 

A UID value is a shorthand notation for a coin record. You are free to assign any 

value to the UID for a custom country as a cross reference lookup, and for any 

custom variety coins. This is not a mandatory field and may not be present for all 

coin records. 

When performing a UID lookup, enter the complete UID value or just a portion of it 

(i.e. 1c is acceptable) and press the ENTER key while still positioned in the UID 
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field. If more than one matching record is found, a list of matching records will be 

presented from which you can choose from. 

UID and Alternate ID Uniqueness 

UID and alternate ID values are unique but not mandatory. Each coin record based 

on the combination of the 5 key fields (Denomination, Year, Type/Reign, Variety, 

and Mint Mark) can be associated with only unique UID and alternate ID values. 

For example, 1c-1796 can't be used for 2 different combinations of the 5 key fields. 

This behavior is different than EzCoin version 1, which basically allowed you to put 

anything into UID and alternate ID fields, which in turn could potentially cause 

issues with reporting and navigation of coin records. 

 

Menu Shortcuts 

All of the find options are also available from the Navigate menu and may also 

have shortcut keys associated with them. 

 

 

 

 

Stepping to Next and Previous Records 

There are 3 pairs of colored arrows in the EzCoin toolbar. The color determines how 

you can step forwards and backwards through the coin records. 

Blue Step through all coin records (pre-supplied and inventoried) using the 

current stepping sort order. The # icon between these 2 arrows 

defines the stepping sort method (see below). 

Green Step through coin records which are inventoried. Any non-inventoried 

pre-supplied records are skipped. For custom country files, the blue 
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and green arrow buttons perform the same. 

Violet Step through records in the active Navigation List. Navigation lists 

can be created from most searches and reports, bookmarks, coin lists 

or tag lists. 

 

If you hold down the CTRL key while clicking on any arrow button, you will 

automatically step to the first or last record based on the associated stepping 

method. 

Setting the Stepping Method 

Click on the # icon between the 2 blue arrows to set the stepping method which will 

be used when you navigate using the blue or green arrow buttons. 

 

If SoftPro has provided pre-supplied alternate numbering formats for a country file, 

they will also appear in this popup menu. The above example shows the 7 available 

stepping types which are always available for every country file plus PCGS for USA. 

Denomination is the default stepping method, and will display all records present 

in the country file, in denomination, year order.  

Year will display all records in year, denomination order.  

UID will display records in unique identifier order. Any coin records which have no 

UID value will be skipped over. 
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The User Catalog ID options are for your alternate catalog numbering systems. If 

you have no alternate numbering system attached to the selected numbering 

format for a coin record, then the record will be skipped over. 

Note that violet arrow buttons have only one fixed stepping method. The navigation 

list stepping is based on the sort order of the navigation list, which is usually the 

same order as a report or search which was used to create it. 

Stepping & Duplicate Coin Records 

When coins are duplicated on the same key fields (Denomination, Year, Type/Reign, 

Variety, and Mint Mark), you will notice 3 things at the bottom of the EzCoin 

window in the status bar. 

 

1. The coin status icon changes to the violet “DD” symbol. 

2. The current and total number of duplicate records for the current coin record 

is shown in the status bar. 

3. The 2 yellow arrow icons are used to step back and forth between the 

duplicate records. 

In addition to using the yellow arrows for stepping between records, the blue and 

green arrows in the toolbar will take duplicate records into account. If you want to 

ignore duplicate record stepping mode on the blue and green arrows, a general 

preference option can be used to disable this default behavior (Include duplicates 

when using navigation stepping methods). 

Automatic Back-stepping when Deleting Records 

A general preference option (Step to previous supplied on inventory deletions) will 

cause EzCoin to step backwards to the previous pre-supplied coin record when you 

delete a record from your inventory. This is enabled by default. 

Stepping with Pending Coin Changes 

By default, EzCoin will warn you when you attempt to step away from the current 

coin record if you have made any changes to the data. This warning can be disabled 

from the EzCoin general preferences. 

Navigation Menu Options for Coin Stepping 

All of the navigation options in EzCoin can be found under the EzCoin main 

Navigate menu. Default shortcut keys have been defined for the most frequently 

used options. You can customize the keyboard shortcuts for other options as 

needed, or attach menu options to a customizable tool button window which 

extends the default EzCoin toolbar. 
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Menu Item Shortcut Description 

Next Supplied Coin Ctrl + Up Equivalent to clicking the right blue arrow. 

Next Inventoried Coin Ctrl + Right Equivalent to clicking the right green arrow. 

Next Coin in List Ctrl + Page Up Equivalent to clicking the right violet arrow. 

Next Duplicate  Equivalent to clicking the right yellow arrow icon 

in the status bar. 

Previous Supplied Coin Ctrl + Down Equivalent to clicking the left blue arrow. 

Previous Inventoried Coin Ctrl + Left Equivalent to clicking the left green arrow. 

Previous Coin in List Ctrl + Page Down Equivalent to clicking the left violet arrow. 

Previous Duplicate  Equivalent to clicking the left yellow arrow icon 

in the status bar. 

First Supplied Coin  Equivalent to clicking the left blue arrow while 

holding down CTRL. 

First Inventoried Coin  Equivalent to clicking the left green arrow while 

holding down CTRL. 

First Coin in List  Equivalent to clicking the left violet arrow while 

holding down CTRL. 

Last Supplied Coin  Equivalent to clicking the right blue arrow while 

holding down CTRL. 

Last Inventoried Coin  Equivalent to clicking the right green arrow while 

holding down CTRL. 

Last Coin in List  Equivalent to clicking the right violet arrow while 

holding down CTRL. 

Lookup Method  Equivalent to clicking the label to the left of the 

Alternate Catalog ID text input field. 

Stepping Method  Equivalent to clicking the # icon between in the 

2 blue arrows in the toolbar. 
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Setting Bookmarks on Coin Records 

EzCoin will allow you to bookmark up to 8 coin records per country file. Bookmarks 

are accessed from the Navigate menu under the bookmark submenus. 

 

There is one submenu for setting the bookmarks, and one for recalling them. Use 

the Clear All option to remove all current bookmarks. If you expect to make 

frequent use of the bookmark option, you should assign the bookmark options to 

the shortcut button window or attach shortcut keys.  

Bookmarks are saved to the country file, and therefore will be retained even when 

you close EzCoin. 

If you need to make use of more extensive bookmarking on coin records, consider 

using tags, coin lists or navigation lists. All of these methods require you to export 

the lists to file if you intend to retain them after closing EzCoin. 

  



EzCoin Reference – Version 2.0 

Page | 124 
 

Tagging Coin Records 

The Tag option under the Navigate menu provides you with an easy method to 

create record lists which have an unlimited size. A tag list can be transferred to a 

navigation list, which can in turn be applied to an ad-hoc report or displayed in the 

thumbnail viewer. 

 

A tag list is identical to a navigation list, and is in fact the only way outside of 

searches and reports to build a navigation list.  The tag list was designed to allow 

you to interactively create a navigation list one coin record at a time. 

No default shortcut keys or toolbar buttons are assigned to tag list functions. If you 

intend to make frequent use of the tag list feature, you should create shortcut 

buttons or keys for easier accessibility. 

Adding and Removing Records 

Use the Add option to add the current coin record displayed in the main EzCoin 

window to the end of the current tag list. Use the Delete option to remove the 

current record from the list. Deletions will have no effect if the current record isn’t 

already part of the list. 

Navigation of the Tag List 

Use the Next, Previous, First and Last options to step through the tag list. 

Loading, Saving and Transferring Lists 

The Load from List and Save to List options recall and store tag lists in the 

navigation list file format. As such, the tag and navigation lists are 100% 
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interchangeable allowing you to run reports and thumbnail views from tagged 

records. 

The Coin List viewer works with navigation and tag lists as well. You can transfer 

the tag list to the coin list, or a navigation list to a coin list. Refer to the Coin List 

help section for more details. 
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Navigation Lists 

Navigation lists are collections of coin records for a given country file. A list contains 

a collection of coin records based on the 5 key fields (Denomination, Year, 

Type/Reign, Variety, and Mint Mark), and a duplicate coin status value. 

The primary source for a navigation list is from a search or report. All EzCoin 

searches and reports create an internal navigation list file which in turn is used by 

the report viewer to display the search results. The main EzCoin window supports 

an active navigation list, which can be assigned from any search or report, or you 

can create the list interactively using the coin list viewer or options under the Tag 

menu. 

When a navigation list is active, you can use the violet arrow buttons to step 

through the list. The status bar at the bottom of the EzCoin window will indicate an 

active list when the list status is displayed, showing the current and total records in 

the list. 

 

Loading and Saving Lists 

An active list can be loaded or saved using the Navigation List options under the 

File menu. 
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A list can’t be loaded except for the country file for which it was saved from. For 

example, a list file for Canada is not compatible with a USA country file. 

Lists will automatically be adjusted when loaded, to account for deleted records. If 

you added a coin record to a saved navigation list file and then deleted that record, 

loading the list from file will exclude that record. 

When saving a navigation list to file, you will be prompted for a file name and 

description. The list file will always be saved under the country name’s subfolder, 

within the Lists folder of the EzCoin installation path. The files will have an 

extension of .LST. 

When loading a list, the country subfolder will be checked for list files and their 

names, descriptions, and total coin record counts will be shown as in the dialog 

window below. 

 

Use the Delete button to remove selected lists permanently. There are no backup 

list files, so choose your deletions carefully. 

You can also double click on any list file to open it. 

Assignments from Reports and Other Sources 

1. Reports and searches provide the option to send the coin records directly to 

the active navigation list, as the following screen fragment from the Quick 

Stats 1 Report shows. 
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2. A coin list can be transferred to the active navigation list, or exported to file. 

3. The report viewer provides the ability to assign the report results (or 

bookmark sections of the report) to the navigation list. Bookmarked records 

within the viewer can also be saved to file. 

4. Tag lists can be saved to file and then loaded as a navigation list. 

Creating a Slideshow 

Choose the Run Slideshow option to cycle through the list by showing each coin 

record on the main EzCoin screen for a period of time. The amount of time to show 

each coin record is controlled by a general preference option (default is 5 seconds). 

The slideshow will automatically cancel the next time you run any menu option 

from the main menu. While the slideshow is running, the title bar of the main 

application window will indicate this with the text (Slideshow) appearing after the 

country file name. 

Sorting Lists 

Choose the Sort option to reorder the coin list on any of the primary attributes. The 

sort dialog window is identical to the one used for report profiles, allowing for up to 

5 field levels, in ascending or descending order per field. 

Combining and Editing Lists 

Similar to combining reports together to create custom coin record result sets, you 

can combine 2 navigation lists together in the exact same way. 

Add Coin records from the first list are combined to with the second list, 

such that the records unique to both lists are all that remains. Duplicate 

entries are not created.  

Subtract Subtracts all coin records from the first list which match on the same 5 

key fields from the second list. 

Combine Takes all primary key fields from both lists and discards any records 

which are not common to BOTH lists. 

The combine list dialog window is shown below. 
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Select a list from the data grid and click on Set First. Select the second list and 

click on Set Second. Then click the Combine button (this button will change to 

Add or Subtract depending on the type of combination you chose from the menu). 

Click on the Combine button and you will be prompted for a name and description 

for the list which will contain the combined coin records. 

The Delete and Open buttons work the same as in the Load list dialog window. 

Ad-hoc Reporting and Editing 

There are two methods for editing the contents of the active navigation list. You can 

transfer the list to the Coin List viewer and then remove unwanted records. You can 

also run an ad-hoc report by choosing the Ad Hoc Report option from the 

Navigation List submenu. 

There is no provision to reorder individual records within the list, other than 

applying a sort order. 
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Editing Coin Information 

Coin Record Attributes 

Primary coin details are organized in the top left section of the window, including 

most pre-supplied values. 

The upper right section of the window is for image views, which can show the 

primary or alternate reverse/obverse images. 

The bottom half of the window contains the data grids for secondary coin attributes. 

The data grids are tabbed for easy access. Simply click a tab to view the 

inventoried status for the associated data type. 

Additional windows are available which can be shown alongside the main EzCoin 

window. These windows are available from the View menu, for the following: 

Custom 

Fields 

A country file can be assigned additional data fields for your 

inventory, using whatever naming conventions and data types you 

need. 

Comments EzCoin by default reserves a small space below the coin image area 

and above the data grids to allow for comments to be added to any 

coin record. If you would like more space to view/enter comments, a 

secondary window can be displayed and resized accordingly. 

Grade 

Data 

Viewer 

The grades data grid can contain many fields, requiring horizontal 

scrolling to see all of the record. EzCoin allows you to show a selected 

record from the data grid in a vertical format using the special viewer 

options in the View menu. 

 

 

Saving Coin Records to Your Inventory 

With pre-supplied country files, all records will initially not be part of your inventory 

and will need to be saved to add them. For custom country files you create, there 

will initially be no records whatsoever. 

When saving a record, the minimal amount of information required is the 

denomination – all other attributes are optional. This is under the provision that the 

combination of the 5 key fields (Denomination, Year, Type/Reign, Variety, and Mint 

Mark) is unique for a given coin record. 

Saving a record to your inventory can be accomplished in multiple ways: 
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 Click on either of the blue checkmark buttons. There is one in the toolbar at 

the top and a second one in the grades toolbar at the bottom beneath the 

data grid. Some of the floating secondary windows may also contain a blue 

checkmark button. 

 Use the shortcut key (default is Ctrl + S) or choose the Save option from the 

Edit menu. 

 The report viewer has the ability to add records using either Rapid Multi 

Entry or Quick Inventory methods. 

 Rapid Multi Entry is also available from the Edit menu. 

 Auto-saving options are available from the Grades Quick Edit window for 

grade data. 

 Auto-saving can be enabled when adding grades to the active coin record. 

Auto-saving features are intended for bulk data entry and are disabled by 

default. 

 Use the Duplicate record feature to make a 100% copy of the current coin 

record displayed in the main EzCoin window. 

 The EzImport feature will import all inventoried records from EzCoin version 

1 (you must have the latest EzCoin version 1 with the Export for EzCoin 2 

menu option installed). 

You can determine the status of an inventoried record by checking the status icon 

at the bottom left corner of the EzCoin window. 

 
There is no country file opened, or no current coin record shown in the 

main window. 

 EzCoin is busy performing a background task and can’t be interrupted. 

 
The record is pre-supplied data and has not been added to your 

inventory. 

 The record is part of your inventory and is based on pre-supplied data. 

 
The record is part of your inventory and is a custom variety or part of a 

custom country file. 

 
The record is one of two or more duplicate coins based on the 5 key fields 

(Denomination, Year, Type/Reign, Variety, and Mint Mark). 

 

In addition to this indicator, a small colored checkmark will appear to the right of 

the Denomination dropdown list at the top of the main EzCoin window with one of 3 

colors: 

Green The record is part of your inventory and is based on pre-supplied data. 

Violet The record is one of two or more duplicate coin records. 

Report%20Viewer%20Overview.htm
Report%20Viewer%20Edit.htm
Report%20Viewer%20Edit.htm
Quick%20Edit.htm
EzImport64.htm
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Red 
The record is part of your inventory and is a custom variety or is part of a 

custom country file. 

 

Saving Pre-Supplied Records 

Call up any pre-supplied coin record and simply click the blue checkmark button to 

save it to your inventory. You are free to modify existing pre-supplied fields before 

saving. EzCoin will keep a permanent copy of all pre-supplied data for every record, 

allowing for easy restoration if you changed a field by accident. 

Saving Custom Varieties 

To save a pre-supplied record under a custom variety, call up any supplied record 

and modify any of the 5 key fields to form a unique combination that doesn't 

currently exist. Then click the blue checkmark button to save the record. This will 

display a dialog window. 

 

 

You will be asked to confirm the record as a main variety or sub-variety, after 

which the record will now be marked as a custom type, even if it was based on pre-

supplied data. If any pre-supplied data existed, it will now be treated as custom 

information and no longer associated with pre-supplied data updates from SoftPro. 

Duplicating a Record 

A coin record can be duplicated with a 100% identical copy by clicking on the 

duplicate button in the toolbar. When a given coin record based on the 5 key fields 

has been duplicated, the status bar at the bottom of the EzCoin window will show 

the current and total number of duplicate records. 
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Saving Pre-Supplied Customizations 

If you want to change any pre-supplied information without adding a record to your 

inventory, the special icon to the left of the Help button in the toolbar can be used. 

 

This will save any changes you make to the following pre-supplied values: 

Period Mintage/Proof Mintage Designer 

Mint Location Weight Thickness 

Edge Description Diameter 

Composition Record Coin Quantity Grade Market Values 

 

The record will not be saved to your inventory. Note that if the record is already in 

your inventory, this icon will behave exactly the same as clicking on the blue 

checkmark save icon. 

Removing Records from Your Inventory 

The red X icon adjacent to the blue checkmark in the toolbar is used to remove the 

current displayed coin record from your inventory.  

 

How the record is removed depends on whether the coin record is part of the pre-

supplied data provided by SoftPro, or is a custom variety. For custom country files, 

the records are always treated as custom varieties. 

 Custom variety records are deleted and will no longer be available in the 

country file. 

 Pre-supplied records will be returned back to pre-supplied status – all custom 

changes to supplied fields and any of your own data (i.e. grades, comments, 

location, etc.) will be discarded, leaving only the pre-supplied field 

information. 
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Purchase/Sell History and Priority Lists 

You will not be able to remove a custom variety coin if there is any information 

saved in the Priority Want List, Priority Sell List, Purchase History or Sell History for 

the coin record based on the 5 key fields. You will need to remove the entries from 

those lists first. 

Removing Duplicate Records 

If the displayed coin record is a duplicate (i.e. not the first record in a set of 

duplicated records), it will also be removed, as a duplicate record is considered to 

be a custom variety even if it’s based on a pre-supplied coin record. 

Clearing Field Information 

The eraser icon in the toolbar allows you to clear all fields which are not pre-

supplied values, which includes: 

Comments User Catalog ID values 

Inventoried grades Custom image links 

Price locks Location 

Serial number Custom field values 

 

Clearing the fields does NOT save the record changes to the country file. You must 

still click the blue checkmark button to commit the changes. 

If you want to clear everything in the main EzCoin window, hold down CTRL while 

clicking the eraser button. 

 

These 2 clear field options are also available in the Edit menu as Clear Fields and 

Clear Screen. 

 

Editing Grade Data 

EzCoin uses the bottom half of the main window to show a set of tabbed data grids, 

containing records for secondary coin information. The first data grid is used for 

displaying inventoried grade status, and also the status of any grade if it’s part of 

the priority want or priority sell list. 
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Each of the tabs will show a record count in parentheses to the right of the tab 

label. This is the number of records of the associated type which are assigned to 

the current coin record. 

The status icon indicates each grade’s inventory/PWL/PSL state, according to the 

icon types shown below. 

 The grade is part of your inventory. 

 The grade is in the Priority Want List. 

 The grade is in the Priority Sell List. 

 The grade is part of your inventory and in the PWL. 

 The grade is part of your inventory and in the PSL. 

 The grade is in both the PWL and PSL. 

 The grade is part of your inventory, in the PWL and also in the PSL. 

 

If a data row is shaded in light yellow (this color can be changed in the EzCoin 

preferences), then the grade was inventoried based on its bullion value (precious 

metal content for gold, silver, platinum and palladium). 

If a market value column's cell is shaded in yellow only, it indicates that the bullion 

value of the coin (regardless of grade) is greater than its current market value. 

If the grade row shows a simple red checkmark , this indicates a market value has 

been assigned to the grade, but the grade itself has not been inventoried. 

Grade Status Area 

Details below the grid are based on how many grades are currently selected in the 

data grid itself. The table below summarizes these input fields. 

Your Value EzCoin normally applies a market value to any grade, when 

available. Market values can be pre-supplied from SoftPro or in 
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the case of custom countries, must be supplied by you. 

 

You can override a market value price by entering a value into 

this field and it will be considered the “absolute” price for the 

grade. The market value will be ignored when calculating Net 

Value, which will now be Your Value * Grade Quantity. 

 

Unless you have a reason to lock a price for a grade into a value 

of this type (i.e. to prevent SoftPro updates from replacing 

customized market values from updates), you should always use 

the market value field to set a price. 

Quantity The number of items for the selected grades which will be part of 

your inventory. A value of 0 is acceptable. Note that this quantity 

is not the quantity of physical coins in your inventory. Each grade 

has a Coins Quantity for Sets value associated with it (normally 

this is 1). The physical coin quantity is the quantity in this field * 

the Coin Set Quantity. 

Market Value This field only appears when a single grade is selected in the data 

grid. The market value can be modified or entered (if none is 

present) by simply entering a new price in this field. 

 

If you erase the contents of this field and a pre-supplied market 

value exists, EzCoin will restore the original pre-supplied value. 

 

Always enter prices based on the currency conversion rate you've 

assigned to the country file. 

Bullion Value 

(BV) 

If the coin contains a precious metal composition, and also a valid 

weight, EzCoin will calculate the bullion value based on the 

current precious metal price values assign to the country and 

display it in this field. 

 

If the coin has no precious metal content or a missing/invalid 

weight, the bullion value will not appear. This value can't be 

modified, and it would be the same value for any grade 

inventoried. 

 

Filtering the Grid Fields 

The grades data grid can contain many fields, some of which may not be of interest 

to you for displaying in the main EzCoin window. If you want to only show a subset 
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of the fields for a data grid, you can filter out the ones you don’t want to show. 

Refer to the help topic under Options for the item Field Settings for Grade Data. 

Using the Vertical Grade Display View 

As an alternative to filtering the data grid fields, you can show the fields for the 

current selected row in the data grid in a secondary window. Use the Grade Data 

Viewer item under the View menu to display this secondary window. 

 

This window can be dragged and resized as needed. It will always show the current 

selected record for the active data grid. 

Selecting and Saving 

EzCoin provides a small toolbar within the grades tab area to assist with adding and 

removing grade information. 

 

1. The blue checkmark button provides the same shortcut functionality as the 

one in the top toolbar. It will save all changes for the current coin record to 

the country file. 

2. The green $+ button will add the selected grades to your inventory, using 

the current quantity (and Your Value if entered). Changes are not saved to 

the country file until you click the blue checkmark. Note that EzCoin has a 

general preferences option to auto-select and add grades when you click on 

the blue checkmark. This option basically is the same as clicking the $+ and 

blue checkmark button in one step. 

3. The yellow $+ button will add the selected grades as bullion valued items. 
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The net value will now be based on the bullion value of the coin, not the 

market value of the grade. 

4. The red $- button will remove selected grades from your inventory. If the 

grade isn’t currently part of your inventory, this option will have no effect. 

5. This option will display the single grade edit window (see below), allowing 

you to change all the field values for the grade. You can only select one 

grade at a time to use this option. 

6. This option will display the quick edit window for all grades, in a 

spreadsheet format. 

7. Given that EzCoin has options to auto-commit selected grades when saving, 

you may want to ensure that grades are not selected when working with 

other data such as the coin details fields. This button simply de-selects all 

grades in the data grid. 

 

Adding Grades with Detailed Attributes 

If you hold down the Ctrl key while clicking either the green or yellow $+ buttons, a 

dialog will be displayed allowing you to enter any of the available grade attributes 

at one time.  

 

This shortcut avoids the need to use the quick edit or single edit options after 

adding the grade to your inventory. 

This dialog is also used to edit a single grade record which is already part of your 

inventory. 
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Quick Editor for Inventoried Grades 

The grade tab in the main EzCoin window has a shortcut button for quick edit 

window, allowing you to modify all of grade records at one time. The quick edit 

option is also available from the popup menu when you right click within the data 

grid area. You can also double click any area of a data grid to enter Quick Edit 

mode. 

 

The title bar indicates the denomination, year and type/reign for the current coin 

record.  

There is a small toolbar window below a menu of options, with the remainder of the 

window being the spreadsheet editor. 

Changing the values in the grid is done by simply moving the selection cursor to 

any cell, and typing in a new value (F2 can be used to initiate edit mode, but 

pressing a valid key will also start edit mode). Once in edit mode, enter a new 

value, and press ENTER to commit the change, or press ESC to cancel. Clicking with 

the mouse on any area outside the cell being edited will behave as if you hit the 

ENTER key. New changes will be reflected by a different background color for the 

data cell. 
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Some fields can’t be edited as they contain information which is read-only, such as 

the grade name or the net value. The cells will be color-coded to indicate if a field is 

read-only. 

Grid Display Order 

A general preference option can be used to set the grid display order to match the 

data grid row order in the main EzCoin window. This option is enabled by default. 

For example, if MS-65 is the first grade in the main EzCoin window, then it will also 

be the first grade in the quick editor grid. If this option is not enabled, then the grid 

order will use the EzCoin pre-defined sort order for grade data. 

Grid Fields 

If you have filtered any fields in the data grid in the main EzCoin window, then they 

will also be filtered out in the editor. If you need to edit fields which you have 

turned off, use the single grade edit mode instead. 

Toolbar Options 

 

1. Clear all of the data cells for the selected record (i.e. location, graded by, 

etc.). 

2. Remove all inventoried grade information for the coin record. 

3. Undo all changes since you started the edit session. 

4. Save changes. 

5. Cancel all changes and exit the editor. 

6. Use a pick list window set the grade location. 

7. Use a pick list window to set the graded by value. 

 

Options Menu 

Apply Apply all changes and exit the editor. By default, EzCoin will not 

save changes to the country file until you click the blue checkmark 

icon from the main window. If you want to auto-commit changes 

to the country file directly from the quick edit window, a general 

preference option can be enabled for this. 

Exit This option will exit the editor without saving any changes you 

may have made. 
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Edit Menu 

Undo This option will undo every change you made to all records. 

Clear Erases all field data for the selected grade. 

Clear All Erases all field data for all grades in the grid. 

Pick Lists Pick lists are used to choose from a set of existing values for the 

following information: 

 Graders 

 Location 

Pick lists will show a popup window with a list of choices. 
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Priority Want and Sell Lists 

Priority want and sell lists are used to identify grades which you would like to buy 

or sell. The PWL/PSL system is designed to work with grades; however you can add 

any coin record to the list even if you don’t select a grade. In this case EzCoin will 

identify the PWL/PSL entry as Any Grade, meaning you want to add the coin to the 

list and don’t care which grade it is you wish to sell or buy. 

Adding Grades with the Main EzCoin Toolbar 

To add specific grades to the PWL or PSL, select them in the grades data grid and 

click on either the PWL or PSL buttons in the main toolbar. 

 

When the PWL or PSL buttons are shown as above, this indicates the coin and/or 1 

or more of its grades are part of the want or sell list. Otherwise, the button icons 

will remain in a grayed out status. 

EzCoin provides quick PWL/PSL modes or the standard (default) interactive mode. 

For interactive mode, a dialog window will be displayed with options. 

 

 

You can enter a Quantity and Type to Buy/Sell value for all selected grades. The 

checkbox list will reflect the current grade selection in the main EzCoin window. You 
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can refine this selection by checking or un-checking any of the grades in the list. 

Use the No Grades button to clear the selection. 

The Replace Existing Grades checkbox determines how any existing PWL/PSL 

entries are affected. If this option is checked, then any existing PWL/PSL entries are 

removed and replaced with only the new values in the checkbox list. If you leave 

this option unchecked, then the grades you check will be added to what is already 

present in the record. 

If no grades are selected, this will result in a PWL/PSL entry displayed in the reports 

grade column of Any Grade. 

The Type and Quantity values are applied to the selection. If you want to use 

different type or quantity values on a per grade basis, you must add them one at a 

time, and ensure that the Replace Existing option is NOT checked. 

Removing Grades and Clearing the List 

To remove entries from the PWL/PSL, hold down CTRL while clicking on the PWL or 

PSL button in the toolbar. The dialog window displayed allows for removal of one or 

more grades from the associated list. 

 

The checkbox list will reflect the selection of grades in the main EzCoin window. Use 

the No Grades button to clear the checkbox list. The removal of entries is directly 

tied to the checkbox selections in the list. If you selected every grade, this removes 

all entries from the PWL/PSL, even if the grade wasn’t originally part of the list. 
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The Remove Non-Grade Specific option is designed to allow removal of PWL/PSL 

entries which had NO grades in the list to begin with (i.e. the PWL/PSL entry for the 

coin record is shown as “Any Grade”). This option, if checked, will ensure that a 

generic PWL/PSL entry without grade information is properly removed from the list. 

PWL/PSL Auto-Save and Inventoried Status 

An important thing to note about the PWL/PSL system is that records do not have 

to be inventoried to be part of either list. These lists are maintained separately from 

the inventoried grade information. The blue checkmark buttons are not used to 

save PWL/PSL entries. Instead, when you click on the PWL/PSL buttons in the 

toolbars to add a PWL/PSL entry, the information is automatically saved to the 

country file in the associated list. 

PWL/PSL Quick Entry Modes 

A general preference option can be enabled for PWL/PSL quick entry. When 

enabled, you will no longer be provided any dialog window to enter a type, quantity 

or grade selection list. The selected grades will be added to the PWL/PSL without a 

type value and with a quantity of 1. All existing entries for the coin record will be 

replaced with the new selection.  

You can still use interactive mode to show the options dialog windows by holding 

down the SHIFT key when clicking the PWL/PSL buttons in the toolbar. 

The quick entry modes also apply to removing entries when CTRL clicking the 

PWL/PSL buttons (hold down CTRL + SHIFT to bring up the remove options dialog 

window if quick mode is enabled). 

PWL/PSL Menu Options 

The Edit menu provides PWL/PSL submenu options to add, remove and clear 

entries. If quick entry mode is enabled, you will once again need to hold down the 

SHIFT key while selecting the menu item to display the add/remove dialog 

windows. 

Adding PWL/PSL Entries from Data Grids 

You can add PWL and PSL tabs to the main EzCoin window as data grids for display 

and quick edit the list entries. The tabs can be enabled from the EzCoin general 

preferences. As with any of the data grids in the main window, you can right click 

on the grid for a context-sensitive popup menu with common options which are also 

available from the main menu, or double click the grid for quick edit mode. The 

PWL/PSL data grid tabs will also have their own toolbar for options. 

Quick Edit Mode 

The Quick Edit option under the Edit menu contains submenu choices for using the 

spreadsheet editor for PWL/PSL entries.  
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Editing the Type List 

When you add new entries to PWL/PSL, you can choose the type to buy/sell from a 

dropdown list of pre-supplied values. However, you can also type new custom text 

strings in the dropdown edit field and your custom types will be added to the 

existing list. A list editor is available for PWL/PSL types from the List Editor option 

under the Utility menu. 

Type values are generic notes you can attach to any PWL/PSL entry. 

 

Priority Want/Sell List Toolbar Options 

An alternate method of working with the PWL/PSL lists is by using the toolbar which 

appears below the PWL/PSL data grid tabs. 

 

1 Add to the PWL/PSL using an alternate dialog window than the one you 

would see using the buttons on the main EzCoin toolbar. 

2 Remove selected records from the PWL/PSL. The selection is not in the 

grades tabs grid, but rather then selected records in the PWL/PSL tabs. 

3 This button will present a dialog window for editing a single selected 

PWL/PSL record in the data grid. 

4 This is a shortcut to the PWL/PSL Quick Edit mode. 

5 This is a shortcut to for viewing/editing the PWL/PSL for the country, not 

just the specific coin record. Refer to the Editing Lists via Searches help 

topic for more information. 

 

Adding/Editing from the PWL/PSL Toolbars 

The single record mode for adding and editing PWL/PSL entries is slightly different 

than the versions provided from the main EzCoin toolbar. 
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Purchase and Sell History 

The purchase and sell history maintain an historical record of coin transactions. The 

information in the history is independent of your inventoried grades, and also the 

priority want and sell lists. Transactions are based on the date you make a sale or 

purchase, and can include multiple transactions for the same coin and same grade 

of that coin. There is in effect 5 separate lists of graded coins in EzCoin: 

 The Priority Want List is the list of coins (by grade) for which you want to 

purchase. 

 The Purchase History is the list of coins which you have purchased. 

 The Grade Inventory represents the coins that are currently in your 

collection. 

 The Priority Sell List is the list of coins for which you want to sell. 

 The Sell History is the list of coins which you have sold. 

When you add or remove coin grades for anything except the Grade Inventory, the 

list changes are automatically saved to the country file. Only inventoried grade 

records are associated with the blue checkmark button in the EzCoin main window's 

toolbar. 

As with the Priority Want/Sell Lists, you can add coins to purchase/sell history 

without specifying a grade, for which they will appear in the list as "Any Grade". 

Purchase and sell history also maintain some additional attributes for a transaction 

besides the grade: 

 Quantity of coins purchased/sold (the quantity can't be zero). 

 The price of the purchase or sale (the price can be zero, but it can't be 

empty). 

 The purchase or sell date (the date can be empty, but should be provided to 

allow for transactional reports by date). 

 The party for which you sold to or purchased from. 

 Any specific comments to attached to the transaction. 

Purchase/Sell History Toolbar Options 

 

These options appear in the Purchased/Sold tabs of the EzCoin main data grid area. 

Unlike the PWL/PSL lists, there are no buttons for purchase/sell history in the 

EzCoin main toolbar. 

1 Add a transaction to the history. 
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2 Remove selected records from the transaction history. 

3 This button will present a dialog window for editing a single selected 

transaction in the data grid. 

4 This is a shortcut to the history Quick Edit mode. 

5 This is a shortcut to for viewing/editing the transaction history for the 

country, not just the specific coin record. Refer to the Editing Lists via 

Searches help topic for more information. 

 

Adding or Editing Transactions 

The add/edit button options will show a dialog window like the one below. 

 

The Any/Unknown Grade button is used to assign/add a record without choosing 

a grade from the list on the left. If you click on the OK button, a grade must be 

selected from the list. 

Use the Grades button to create a filtered list of grades to choose from. This will 

create a smaller grade list on the left in the dialog window, which can make 

selecting grades from specific subgroups easier by avoiding scrolling the list up and 

down to find the correct grade. 

The purchase/sell date provides a quick pick calendar popup dialog using the "..." 

button to the right of the date field. 
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Quick Edit for Priority Lists and Purchase/Sell History 

These spreadsheet editors are slightly different from the one used for inventoried 

grades.  

The quick editor for grade information presents all available grades for the current 

country as a fixed number of data rows in the editor window. You can’t add or 

remove records from this grid. 

PWL/PSL/Buy/Sell editing allows for record additions and removals. The editor 

window looks similar to the grade editor, with some changes to the toolbar, which 

are summarized in the table below. 
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The quick edit window works like a typical spreadsheet editor. Select a cell and 

press F2 to start editing the cell, or simply start typing some text. Use ENTER to 

commit your cell changes (or click on a different cell), or press ESC to cancel the 

edit. 

Grade information is based on a drop down list accessed directly from the cell in the 

grid. You can only choose an existing grade from this list, or choose the first item 

from the list which assigns a Non-Specific Grade to the record. This type of record 

indicates you have no preference for a specific grade, just the coin record itself. 

For the type to buy or sell, or who a coin is purchased from/sold to, you can enter 

any text value, or access a pick list window, using any of the following methods: 

 Double click the cell 

 Use the shortcut key 

 Choose the option from the menu 

 Click on the toolbar icon 

The market and net values for PWL/PSL lists are not modifiable. They are for 

display purposes only to indicate the net value of the graded item in PWL/PSL 

based on current market value. For buy/sell history, all values can be modified. 

The toolbar contains several options, which can vary based on the type of coin 

information you are editing. 
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1. Add a new record to the list. 

2. Remove the selected records. 

3. Clear the selected row of information (i.e. type to buy/sell, comments, 

dates). 

4. Clear all data rows of information. 

5. Undo all changes since you started the edit session. 

6. Save changes. 

7. Cancel all changes and exit the editor. 

8. These are shortcut buttons for data pick lists (type to buy/sell, purchased 

from, sold to), which can also be accessed from the Edit menu or the Ctrl 

+ P shortcut key. 

 

For buy/sell history an additional button to set the date of purchase or sale 

will appear. This will present a popup calendar window to choose a date. 

You can also use the Ctrl + D shortcut key. 

 

  



EzCoin Reference – Version 2.0 

Page | 151 
 

Searching Priority Lists and Purchase/Sell Transactions 

These options are available from the toolbars within their respective data grid tabs 

of the main EzCoin window (PWL, PSL, Purchased, Sold) and also from the Edit 

menu. 

 

Choosing these options will provide a simple filter for showing all coins, or a subset 

of the complete list for the country. The Purchase History and Priority Want List 

filter windows are shown below. 
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For purchase/sell history, you can set a date range which is based on when the 

coins were purchased/sold. When left blank, all dates will be matched, including 

coins which have no assigned date in the list. 

The buy/sell quantity has drop down list which allows for some basic types of 

operations: 

 Any quantity 

 And quantity greater than the value you enter. 

 Any quantity less than the value. 

 Any quantity equal to the value. 

 Any quantity greater than or equal to the value. 

 Any quantity less than or equal to the value. 

The buy/sell price has the same set of operations as quantity. 

Comments, purchased from/sold to are general text filters. If you check the Exact 

Match option, then your input values must match completely against the record in 

the list. If unchecked, then the value you enter only has to appear as part of the 

overall text data for the field. 

Check the Case-sensitive option to force all text input fields to match upper/lower 

case letters exactly. 
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The 5 key fields (denomination, year, type/reign, variety and mint mark) work the 

same as in other reports and searches in EzCoin. 

Purchase and sell history results can be sorted by one of 4 methods: 

 Date of the sale/purchase 

 Denomination 

 Year 

 Grade 

Use the Grades button to filter the list to specific grades. Note that once you select 

a grade subset, any coins that were added with a specific grade (i.e. they appear 

on reports as "Any Grade"), they will no longer be visible. 

The 3 radio buttons at the bottom are a master filter against the list. The default 

value of All Transactions displays all coins which match the search criteria.  

Choosing the For Inventoried Coins option will only show transaction history 

against coins which are currently part of your inventory.  

The For Non-Inventoried Coins option will only show transactions for coins which 

are NOT part of your inventory. For custom coin varieties and custom country files, 

this option should not be used, as it will never show transactions. 

Click on Reset to set all inputs fields to blank values, which will result in the 

complete list being displayed. 

Click on Find to start a search. If any matches are detected, they will appear in the 

status area at the bottom left corner of the window. Click on Show to display the 

results. 
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The search filter window for Priority Want/Sell Lists is much simpler than 

purchase/sell history. 

You only have quantity and type (to buy or sell) fields related to the records in the 

list. The remainder of the window is for the 5 key coin fields. 

As there is no purchase or sell date, the sorting options will not include dates. 

The 3 radio buttons at the bottom work exactly like they do for Buy/Sell 

transactions and are used to filter the search results based on coin inventoried 

status. 

Viewing the Results 

Matching coin records in the list will be displayed in a generic list window, shared 

between all 4 list types. 
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It's important to note that the results are not reports and can't be printed. If you 

need to view results as a report, you can run the options from the Search/Report 

menus for these list types, or transfer the results to a navigation list, then transfer 

that list to an ad-hoc report. 

The columns which appear will be fixed for each type of view and may not be 

changed. 

Regardless of the list type, the first 5 fields will always be: 

 Denomination 

 Year 

 Type/Reign 

 Variety 

 Mint Mark 

The remainder will be based on the search type as follows: 

Priority Want List Priority Sell List Purchase History Sell History 

Grade Grade Purchase Date Sell Date 

Quantity to Buy Quantity to Sell Grade Grade 

Type to Buy Type to Sell Quantity Quantity 

  Purchase Price Sell Price 
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  Purchased From Sold To 

  Comments Comments 

 

Toolbar Options 

 

Note: All of these options are also available from the menu and most of them have 

keyboard shortcuts. 

1 Show the coin record for the selected entry in the main EzCoin window. 

2 Transfer the bookmarked coins (or all coins if none are marked) to a 

navigation list in the main EzCoin window. 

3 Add a new record to the list. 

4 Remove marked or selected records from the list. If you choose to 

bookmark records in the list, then they will take precedence over selected 

records. 

5 Edit the selected record. 

6 Export the list to file. 

7 Import the list from file. 

8 Bookmark the selected records. Hold down Ctrl to bookmark all records. 

9 Delete selected records. Hold down Ctrl to invert the bookmarks. Note: You 

will not be able to undo the deletion once confirmed. 

A Clear the bookmarks. 

B Close the window. 

 

Adding and Editing Records 

When you choose to add or edit a record in the list, you will be provided with a 

dialog window like the one for Purchase History as shown below. 
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The 5 key fields shown represent the coin record which the list item is associated 

with. Unlike editing from the main EzCoin window, this dialog allows you to reassign 

a list record from one coin to different coin. This is faster than deleting a PWL 

record from Coin A, and then adding the PWL record to Coin B. 

Since you must know the key field value and it must match exactly to a unique coin 

record (the "Coins" label with the white background must be "1"), the Search 

button has been provided. It will allow you to access the Coin Drilldown feature to 

locate the record you want. If you have no intention of moving a record to another 

coin, then leave these 5 drop down values as is. 

You can change any of the other fields related to the list type in this dialog using 

the drop down lists or text input fields. You can erase comments or other text fields 

from the list item by simply deleting the text. 

The grade list on the left is used to select a new grade for existing records, or add a 

new grade. Use the Grades button to create a subset of the available grades in this 

list. Use the Any/Unknown Grade button to assign the grade value of "Any 

Grade" to the record. Otherwise, click on OK to assign the selected grade in the list. 

The selected grade will always appear between the Grades and OK button for 

reference. 
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Exporting and Importing Lists 

You can save the complete list to a text file for review or further edits. A text file 

can also be imported. Export and import options are advanced features and should 

only be used if you are comfortable with working with tab-delimited text files in 

programs such as Microsoft Excel. 

The export/import format is very specific and can't be changed. 

Along with the 5 key fields, the remaining columns exported are based on the type 

of list. The first row contains the exported field names, and must not be changed or 

omitted if you intend to import the file. 

The file format saved uses UTF-8 encoding. This allows preservation of special 

symbols, characters with accents and international characters. 

When importing the data back into EzCoin, the file format can be plain text, UTF-8, 

or Unicode, but must still be tab-delimited and have the same column arrangement. 

If EzCoin can't match the 5 key fields in the import file to an existing coin record for 

the country, the import record will be skipped. EzCoin will validate the contents of 

the file before starting an import. If there are any errors, you will need to fix them 

before proceeding. 
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Pricing Locks 

Pricing locks are provided to prevent EzCoin supplied data updates from affecting 

current pre-supplied market values associated with coin grades. Once a record has 

its pricing locked, any supplied data updates you make will be prevented from 

changing the current price values. You can lock or unlock prices using any of the 

following methods: 

 Click the padlock icon at the bottom of EzCoin window in the status bar. 

When the icon is grayed out, there is no price lock on the record. When the 

icon is green, a price lock is applied to the coin record. 

 Choose the Lock Pricing option from the Edit menu to lock or unlock pricing. 

Use the Unlock All Pricing option to remove the locks from every record in 

the country file. 

 Pricing locks are enabled through similar menu options in the report viewer. 

If you want to determine what records currently have price locks, run a 

Power Search in which the matching conditions are set to all inventoried 

records with Price Lock = Yes. 

Notes: Price locks have no effect on custom countries or records which are custom 

varieties. In addition, price locks can't be set for any pre-supplied record which is 

not part of your inventory. 

 

Rapid Multi Entry 

Rapid Multi Entry (RME) provides a method to quickly add multiple coin records to 

your inventory using a combination of search conditions and selecting records from 

the Report Viewer window to add. Note that the RME option is not useable for 

custom countries, as every coin record will already be part of your inventory.  

Setting the Search Conditions 

Select the Rapid Multi Entry option from the Edit menu and you will be provided 

with a dialog window to set the search conditions to find matching coin records. 
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The Search In drop down list will contain one of 2 choices. The second choice, 

supplied data, will allow you to run an RME search against pre-supplied coins which 

may already be in your inventory. This allows for creation of duplicate coin records. 

The Duplicates drop down indicates how to match based on duplicate coin record 

status. 

The Filter Method changes the primary search conditions. Aside from the default 

primary coin fields, alternate catalog ID values can be used to define a range of 

coin records. 

The checkbox option for report profile sort order can be disabled, allowing you to 

click on the Sort Order button to define a different order for the report 

presentation. This doesn't affect the way records are added via RME. 

Pre-supplied coin records have an internal status to indicate if a coin is a main 

variety or a sub-variety. Check the Main numbers only option to exclude all sub-

varieties. 

Every search and report option in EzCoin requires a reporting profile to define how 

the search results are displayed in the report viewer. The RME option is no 

exception - use the dropdown list to select a different profile if the default pre-

supplied version is not sufficient for your needs. 
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Click on the Find button to start searching the country file for matching records. If 

any matches are found, you will be able to click on the RME button. This will 

present the search results in the Report Viewer. In addition, the report viewer will 

detect that this is an RME request, and will automatically bookmark the records in 

data grid and enable the RME option. 

 

Once in the report viewer, click on the RME button to add the coin records to your 

inventory.  

 

Quick Duplicate 

EzCoin provides a method to quickly make copies of inventoried coin records, using 

an interactive dialog based on the Rapid Multi Entry (RME) system. This option is 

available under the Edit menu as Quick Duplicate. 
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The left side of this window contains the available grades for the current country file 

with an associated quantity field for each grade. If you check a grade, the quantity 

will be set to 1 for you. 

Use the Grade Select button to check multiple grades using the standard grade 

group selection window. 

The Custom Fields button will display a window allowing you to add custom field 

values to duplicate record. 

The Clear button will uncheck all grades in the grade list. Clear All will erase the 

contents of all fields in this window. 

The current coin displayed in the main EzCoin window is always the source for the 

duplication. 

The duplicate is done exactly one time when you click on the Duplicate button. 

The dialog will remain open until you click on Exit, unless you don’t have an active 

navigation list. In this case, the window will close after the duplication. 

Any existing inventoried information will be discarded in the copy, and will be 

replaced by the information contained in the window above. As such, quick 

duplicate has no provision to add to the existing data, which the RME system does 

provide for.  
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Pre-supplied coin records which have not been added to your inventory will not be 

duplicated, unless the auto inventory option is enabled. 

Duplication by Navigation List 

Quick Duplicate is designed to work efficiently using the active navigation list. Use 

any search or report to create a navigation list and then run the quick duplicate 

option. When you do this, the Quick Dup window will display violet arrow buttons, 

which mimic the behavior of the main toolbar buttons, allowing you to step back 

and forth between coin records in the navigation list. 

In addition the Auto Step checkbox will be enabled. When you check this option, a 

click on the Duplicate button will advance automatically to the next coin record in 

the navigation list – the main window will refresh automatically with the new 

record. 

Auto Inventory Mode 

This checkbox option acts as a safety feature, preventing you from accidently 

adding a non-inventoried pre-supplied record. With this option enabled, any non-

inventoried coin record will be inventoried (only 1 copy will exist after this). The 

Duplicate button will change to Inventory in these cases. 

Automatic Settings 

When you close the quick duplicate window, all settings are saved and restored 

exactly as before the next time you run this option. Use the Clear and Clear All 

buttons to reset these settings. 

Primary vs. Grade Information 

Some of the field data is associated with the coin record (Main Location and Coin 

Record Comments). The remainder is associated with each grade. When you enter 

values into the grade-level fields, the same value (i.e. Purchased From) is applied 

to all grades selected in the checkbox list. If you need to add different values for 

different grades on the same coin record, then you will need to make changes to 

the checkbox selection list for the same coin record. 

Bullion Value Grades 

The checkbox option named Bullion Value is used to add grades as bullion values, 

ignoring the market value when determining the coin grade's net value. 

Image Links 

Each coin record can have primary and alternate obverse/reverse image assigned 

to them. Image data is not stored in the country file - only a link to it is stored, 

which is essentially the file name without an extension or a reference to any specific 

path or disk drive. EzCoin will not store a file extension with the link name, to allow 
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you to change the file format at any time (i.e. BMP to JPEG) without the need to 

update the link information. 

Image File Formats and Locations 

EzCoin will accept image files using the following formats and their associated file 

extensions (extensions are not case-sensitive): 

Image Type Valid Extensions 

Bitmap Files .BMP 

JPEG Files .JPG, .JPEG or .JPE 

TIFF Files .TIF or .TIFF 

GIF Files .GIF 

PNG Files .PNG 

 

Image links do not have a path name component. For example, 

D:\MyImages\myimage.bmp is not a valid link. How images are located by EzCoin 

is based on the following search priority: 

1. EzCoin Application Path (Under the Images\Country folder) 

2. Alternate Image Path (Under the Country folder), which must be defined in 

the EzCoin general preferences. 

3. EzCoin pre-supplied image library file (.IMG) located under the application 

path Images folder (i.e. Images\Canada.img). 

4. EzCoin distribution disc as an image library file. 

The country folder is always the parent for all image files.  

Under the country folder, there will be 2 subfolders named Main and Alt for the 

primary and alternate images respectively.  

Obverse and reverse image files share the same folder space, so you will not be 

able to have a reverse image file with the same name as the obverse image for a 

given coin record. 

Pre-supplied images are always provided as image library files with an extension of 

.IMG. Every image is contained in a single file, and it may reside on the distribution 

disc or under the Images folder of the EzCoin installation path. 

For example, if you have obverse and reverse images of 1959_1c_o.jpg and 

1959_1c_r.jpg, for Canada and have installed EzCoin to C:\SoftPro2010\EzCoin2, 

the images would both be located in: 

C:\SoftPro2010\EzCoin2\Images\Canada\Main 

If these were alternate image links, they would be located in 
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C:\SoftPro2010\EzCoin2\Images\Canada\Alt 

Image Link Editor 

This editor is available by right clicking either image in the main EzCoin window, by 

clicking the image link button in the main toolbar, or choosing the image link editor 

from the Quick Edit submenu under the Edit menu. 

 

The left image pair is for pre-supplied image images. The right side pair is for 

custom image links you provide. A custom country will never have images displayed 

on the left side of this window. 

Images are assigned individually, not in pairs. It's perfectly acceptable to only 

assign a reverse or obverse image for a coin record. The 4 leftmost colored globe 

icons (green or gray) indicate the active link status for the primary images. The 4 

icons on the right side represent the link status for alternate images. 

If the icon is green, it indicates an active link is assigned, even if the image is 

unavailable. If the icon is gray, then no image link is assigned. The 4 icons to the 

left of the Primary Images radio button indicate link status in this order (left to 

right): 

 Obverse Image, Pre-supplied 

 Reverse Image, Pre-supplied 

 Obverse Image, Your Link 
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 Reverse Image, Your Link 

The 4 icons to the left of the Alternate Images radio button indicate similar link 

status for the alternate images. 

Below the status icons are the actual link file names, which are limited to 64 

characters in length. The extension will not be shown in the link name, as EzCoin 

resolves the image based on all possible matching file types and their standard 

extension names.  

The left side contains the pre-supplied link file names, with your custom link names 

on the right side. 

Changing Image Links 

You can assign links by: 

 Enter a file name directly in the input field. For this option to work, you must 

have already placed the correct image in the image folder on your own. You 

must click the Refresh button to validate the image link and display it. 

 Use the Browse buttons to locate an image using the Image Browser 

window. 

 Paste an image from the Windows clipboard using the Paste button. 

Link Targets and Image Files 

The dropdown list will have 2 possible locations to place image files: the application 

installation path and an alternate image location. The alternate image location is 

specified under the EzCoin generate preferences, and allows you to pick any 

location outside of the EzCoin application folder, as long as it follows the same 

subfolder organization (country\main or country\alt). 

If image files are obtained from a different location using the browser, a copy of the 

file will be placed into the folder defined under the Link Target path. The original file 

will remain where it was copied from. 

Image Browser 

When clicking on the Browse buttons, a simple image browsing window will be 

displayed. 
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The window will show list of available image files for the current browse path on the 

left, and the selected image on the right. 

The total number of files and current browse path are displayed in the status bar. 

Click on the Change Path button to select a different browse path. 

Click on Find File to look for a specific file. If you choose a file using this method, 

the browse path will be set to the location where the file resides. 

Click OK to assign the image as a new link. If the file needs to be copied to the 

correct target link path, it will be done at this time. 

Primary vs. Alternate Images 

Use the 2 radio buttons to change between the primary and alternate image links. 

When alternate image links are present, a special alternate image icon will appear 

in the toolbar of the main EzCoin window, allowing you to view the alternate 

images. 

Pasting an Image from the Clipboard 

If you have a valid image in the Windows clipboard, you can click the Paste button 

to place the image into the link window. The file will be saved using the format 

defined under the EzCoin general preferences (Clipboard Save Format, can be JPEG, 

TIFF, PNG or BMP). 
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You will have to provide a valid file name for this image. 

Clearing Image Links 

Click on the Clear button to remove a custom image link. Note: You are not 

permitted to clear supplied image links. EzCoin ensures that your custom image link 

has higher priority than a pre-supplied link. Once you remove a custom link, the 

original pre-supplied image will be used instead. Only the link reference is removed 

- the image files are left as is. 

Pre-Supplied Refresh and Duplicate Coins 

If you have a duplicate coin record, EzCoin will disconnect pre-supplied coin 

information from the record. It will copy the pre-supplied information over before 

creating the duplicate copy, but thereafter the duplicate image will no longer be 

subject to pre-supplied data updates from SoftPro. For this reason, an option to 

refresh a pre-supplied image link for duplicate coins has been added. This button is 

named Pre-Supplied and will only appear for duplicate coin records. Click this 

button and pre-supplied image links will be applied to any image where a custom 

link is not already assigned. 

Customizing Denominations 

Denominations are assigned on a per country basis. You are permitted to have 

denominations which are not assigned to any existing coin record (i.e. the list can 

be larger than what's being used).  

Denomination lists also can be arranged in any order you prefer, and EzCoin will 

ensure that when used in reports and navigating though records, the 

denominations will be presented in the order you expect. 

To access the current denomination list for a country, use the Denominations item 

from the List Editor submenu under the Utility menu. 
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Supplied and User Denominations 

The icon in the list will either show a green S (Supplied) or a red U (User). Pre-

supplied denominations are provided by SoftPro and can't be removed or renamed. 

User denominations are custom values which you added to the country. They can 

be renamed, but not removed if they are currently used by one or more coin 

records. 

Editor Options 

 

1. Click on this button to add a new custom denomination to the end of the 

list. 

2. Click on this button to remove the selected denomination. 

3. Use the up and down buttons to move the selected denominations up and 

down within the list. The order of denominations in this list is the sort order 

used for reports and navigation. 

 

Hold down the Ctrl key while clicking to move the selection to the beginning 

or end of the list. 
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4. Click this button to save all changes in the list. If you reordered the 

denominations, EzCoin will need to update all coin records to adjust their 

sort order. 

5. Click this button to cancel and discard all changes. 

6. Click this button to undo any changes and start the edit session anew. 

7. Use the export option to save the list to a custom denomination file with an 

extension of .DEN. These files can be used when creating new custom 

countries, or as a backup source for restoration. 

8. Use the import option to load denominations from an export file. 

 

Restoring Denominations From Coin Records 

Use the Restore Denominations item from the Options menu to have EzCoin 

search every coin record in the country file and add in any missing denominations. 

This normally should not happen, and is provided only as a data integrity recovery 

option. 

Pre-Supplied Data Comparison 

The Supplied Data/Differences option under the Edit menu provides a quick 

method to preview, modify and compare all fields for a coin record which can be 

pre-supplied by SoftPro. Even if the record has no pre-supplied data, you can still 

use this option to view all the pre-supplied fields at a glance (in which case these 

fields are all customized values). 
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When editing pre-supplied fields in the main EzCoin window, you may notice the 

background and foreground colors of a field may change. This indicates that you 

have modified a field to have a different value then what has been pre-supplied by 

SoftPro. 

This dialog window shows the same color coding on any field where you have 

changed the value from a pre-supplied version. This can also be reflected in any 

supplied data updates when you have elected NOT to apply the changes. 

The pre-supplied values are shown in the bottom half of the window. Your copies of 

these field values are displayed in the top half. For custom variety coin records, or 

for a custom country file, the bottom half of this window will not be shown, in which 

case the dialog window acts as a general purpose coin attribute editor. 

Use the Restore Current button to reset a value for any field which the I-beam 

edit cursor is currently positioned in.  You can also double click any field label to 

reset the value, or click on the Restore All button to change all fields to their pre-

supplied values. 
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Click on Save to apply the changes. This will not save the coin record changes to 

the country file – you still need to click on the blue checkmark button in the main 

EzCoin window to commit the changes. 
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Renaming Key Fields 

Records in EzCoin are uniquely identified by 5 key fields: 

 Denomination 

 Year 

 Type/Reign 

 Variety 

 Mint Mark 

The combination of these fields (only denomination is mandatory of the 5) must be 

unique for coin identity. Duplicate coin records are not considered as a separate 

coin identity based on this definition. 

Pre-supplied coin records from SoftPro are not allowed to be changed, to avoid any 

issues with supplied pricing or data updates. 

For any custom variety coin record, or for any coin record which is part of a custom 

country (i.e. no pre-supplied data whatsoever), you can change the 5 key fields 

using the Change Key Fields option in the Edit menu. 

 

 

Before this dialog is shown, EzCoin will ensure that the current coin record on the 

main application screen doesn't have any pending changes which haven't been 
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saved to the country file. If changes are pending, make sure to save them first 

(blue checkmark button). 

You may change any of the 5 fields for a custom coin record. Spelling is case-

sensitive. Denomination may not be blank, but the other 4 fields can be. 

When you click the OK button, EzCoin will check for any existing coin record 

matching on the new combination of the 5 fields. Matching conditions can be on: 

 One or more inventoried coin records on the new key values. 

 One or more coin records in the Priority Want or Sell list. 

 One or more coin records in the Purchase or Sell history. 

If a conflict should occur with existing coin data, you will be given a confirmation 

warning dialog to proceed. Be aware that if you do proceed, the existing coin 

information will be replaced with the current coin data shown in the main EzCoin 

window. 

This replacement extends to all duplicate coin records as well. If there are 3 

duplicate coin records all on the key fields you are changing to, then all 3 coin 

records will be erased and replaced with the coin records based on the original key 

field values. You will not be able to undo this option without a backup if you choose 

to proceed. 

A special button named Nav List can be used to show the conflicting and source 

coin records in the main EzCoin window as a navigation list. Use the violet arrow 

buttons to navigation between the coin records to verify what information you could 

be potentially replacing. 

Once the key fields are renamed, EzCoin may perform a report totals recalculation 

automatically, for any cases where target coin information was replaced with the 

source coin records. 
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EzCoin Searches and Reports 
The Search and Reports menus contain items which collectively perform the 

common task of finding coin information and showing the results of the search in 

various ways. The division of the searches and reports into separate menus in 

EzCoin is based upon frequency and ease of use. The search menu contains several 

advanced options, and the reports menu contains the most common report types in 

EzCoin. 

All of the items with the exception of eLook, EzBrowse, and EzInventory will 

perform searches/reports using the same 3-step process: 

 Display a dialog with search conditions and reporting options, which you 

provide. 

 Find matching coin records against the current open country file using the 

search conditions. 

 Show the results using the output method you specify, the default being a 

spreadsheet-style report window. 

Search Conditions Dialog 

Searches and reports start with the search conditions dialog window. Each search 

or report may use slightly different types of windows, but they will all share the 

following features. The Basic Inventory Report's search dialog is used as an 

example.  

Note that items 1, 2, 3 and 6 as described in the table below work together to 

create a unique filter that limits the number of coin records that will be searched. 
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1 This sets the type of data to search at the highest level. This is the first step 

in determining what records to find. Depending on the search and the type of 

country file (i.e. custom vs. pre-supplied from SoftPro), not all of the choices 

listed below will be available. 

 All Coins: Every record in the country will be searched. 

 Inventoried Data: Only records which are part of your inventory are 

considered. 

 Modified Supplied Data: Only records where pre-supplied fields 

have been modified from what they were when provided by SoftPro. 

 All Customized Data: Custom varieties in addition to modified pre-

supplied data. 

 Custom Varieties: Records which are not pre-supplied by SoftPro. 

 Supplied Data: Records which are only supplied by SoftPro. 

 Supplied (Not Inventoried): Records which are supplied by SoftPro 

but have yet to be added to your inventory. 

2 Every coin is uniquely identified by the combination of Denomination, Year, 

Type/Reign, Variety and Mint Mark. You can create copies of coin records and 

retain the same 5 key fields, in which case they are considered duplicate 

records. Duplicate records don't have to share any common attributes other 
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than these 5 key fields. This drop down list determines how to handle 

duplicate coin records in searches. 

 All Entries: All duplicate coin records are included in the search. 

 Ignore Duplicates: Duplicate coin records are skipped. Only the 

primary (first occurrence) of the coin record based on the 5 key fields 

is included. 

 Only Show Duplicates: The primary coin records are skipped. This 

type of search is specifically targeted at duplicate records only. 

3 The filter method represents a choice from 2 or more ways to find coin 

records using the primary attributes of coin identity: 

 All Coins: With this option, all coins are searched (in combination with 

your choices for 1 and 2 above), with the addition of specifying the 

time you last updated coin information. 

 Coin Record Key Fields: The 5 key fields for a coin record can be 

searched using partial or exact match conditions. 

 Unique Identifier: The UID value can be searched using a range, 

partial or exact match condition. 

 Alternate and Pre-supplied Catalog ID: Any pre-supplied or 

custom catalog ID values can be searched using a range, partial or 

exact match condition. 

4 There are 6 ways to show the results of a search (the 6th choice is available 

from the Spreadsheet Viewer only). 

 Report Viewer: This shows the coin records in a spreadsheet style 

window, with full editing and printing capabilities. 

 Data Browser: This is similar to the spreadsheet viewer, except that 

the data is presented in a read-only format, similar to the EzCoin 

version 1 reports. Unlike the spreadsheet viewer, the data browser 

offers unrestricted column sorting. 

 Thumbnail Viewer: Displays the coin records in the thumbnail 

window as a set of image pairs. 

 Navigation List: Assigns all of the coin records to the navigation list. 

 Main Window: The results are shown one record at a time in the 

main EzCoin window. The status bar of the search window will expand 

to offer some navigation options in this mode. 

 Coin List Viewer: If you choose the spreadsheet viewer, it will 

contain a menu option (press F8) to transfer the report to the Coin List 

viewer. 

5 Each report profile contains a default sort order for the coin records. You can 

change the sort order using the Report Profile Editor, or as a convenience, 

change it on the fly from the search window. Uncheck this option and the 
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Sort Order button will be enabled, allowing you to set a new ordering for 

the coin records. 

6 Pre-supplied coin records from SoftPro can be classified as a main variety or 

a sub-variety. Use this checkbox option to skip sub-varieties. 

7 Every search and report must be assigned a report profile, which is a file-

based template containing settings for displayed and printed reports. The 

primary components of a profile are the list of coin fields to display/print, 

colors for displayed reports, and the format settings for printed output. 

 

Each search and report in EzCoin is assigned a default profile. You can add 

custom report profiles based on any existing report profile, or create new 

profiles from scratch. These custom profiles will appear in the drop down list. 

SoftPro may also provide additional "stock" profiles for a report type, and 

they would also appear in this drop down. 

8 Most searches and reports will retain their dialog settings from the previous 

search. You can reset all of the search conditions to default/empty values by 

clicking on the Reset button. 

9 Before you can show the results of a search, you need to initiate it by 

clicking on the Find button. The total number of matching coin records will 

be displayed in the status bar. Until at least one matching coin record is 

found, the Show button will not be enabled. 

10 Click this button to show the results based on the output method chosen as 

per item 4 above. 

11 In addition to showing match results, the status bar provides feedback on 

the search while in progress and navigation options for Main Window browse 

mode. 

 

Main Window Browse Mode 

If you want to see the search results one record at a time on the main EzCoin 

window, choose the Show in Main Window output mode. The status bar will 

appear like below after clicking the Find button. 

 

1 Click this icon to minimize the search dialog window, allowing you to see 

more of the main EzCoin window. Click it again to restore the search window. 

2 Total number of matching coin records from the search. 
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3 Click either arrow to move backwards and forwards between the matching 

coin records. As you click the icons, the coin record in the main EzCoin 

window will be updated accordingly. Hold down Ctrl while clicking to move to 

the first/last coin record. 

4 This is the current record shown in the main window. It will be between 1 

and the total number of matches. 

 

Coin Modification Dates and Unfiltered Mode 

You will have the option to set a start and end date based on the date when you 

last updated any changes for a coin to your inventory. If you don't specify an end 

date, then all records modified from the start date to the current date will be 

included. 

Key Field Search Mode 

You can enter a value for one or more of the 5 key coin fields (Denomination, Year, 

Type/Reign, Variety, Mint Mark) in this mode, using complete or partial search 

values. 

For a partial match, ensure that the Exact Match option is unchecked. 

To make sure your searches are not case-sensitive, ensure that the Case-

Sensitive option is unchecked. 

The year range can have a starting value, but doesn't require an ending value. 

Catalog ID and UID Search Modes 

You can choose to search based on exact match, partial match, or using a range of 

values.  

Note that when choosing a range, the ending value is pre-populated with a string of 

"Z" characters equal to the maximum length of the field (i.e. UID will be a string of 

16 Z characters). This is done to ensure that the ending value will in fact 

encompass all coin records by default. 

Catalog and UID matching modes will not pick up any coin record where there is no 

ID/UID value assigned. The only way to find coin records with missing UID/ID 

values is via Power Search. 

All ID and UID matches are always case-sensitive. 

Search Menu Items 

The following table summarizes all of the items under the Search menu. Click on 

any of the links in this table to see additional information. 
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Key Search Find coin records using a combination of primary 5 key 

fields (Denomination, Year, Type/Reign, Variety and 

Mint Mark). 

Attribute Search Find records based on the physical characteristics of 

diameter, thickness, and edge. 

Composition Search Find records based on the composition and weight, 

including special conditions for precious metal content. 

Mint Details Search Find records based on mint location, mintage and proof 

mintage. 

Period Search Find records based on the period of issue. 

Designer Search Find records based on the designer of the coin. 

Notes / Description 

Search 

Coin records can contain notes or descriptive 

comments, which are generally pre-supplied by SoftPro. 

Location Search Find records based on the primary coin location or on 

the individual location values at the grade level. SoftPro 

does not provide location information. 

Serial Number Search Find records based on the serial number. SoftPro does 

not provide serial number information. 

Comments Search Find records based on the primary coin comments or on 

the individual comments at the grade level. SoftPro 

does not provide this information. 

Custom Field Search You can add extra fields to a country file to store any 

data of your choosing, within the restrictions of the data 

types for a custom field format. Custom field searches 

find coins for a specific custom field value. 

EzBrowse These searches are basic at-a-glance type reports of 

either pre-supplied or inventoried coin information.  

Power Search This search type allows for complex data matching for 

almost every possible coin attribute. If other searches 

or reports can't find what you're looking for, Power 

Search likely will. 

Grades Search EzCoin can contain many attributes tied to each grade 

you add to a coin's inventory. The grade search takes 

this into account, allowing you to find records at the 

grade level, rather than at the coin level. Unlike the 

grades report, the grades search presents grade 

information vertically down the page, making more 

efficient use of space when many grade attributes are 
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selected in the report profile. 

Supplied Price Search Coin pricing is based on the market value assigned to 

each grade for each coin. As pricing is based on what 

market values are available, not every grade for every 

coin will have a value. This search option will allow you 

to locate coins based on their market values. 

Change History When you make updates to a coin record, EzCoin will 

keep track of when changes were made to that record. 

The change history search will locate coin records which 

have been modified recently or over a period of time. 

eLook™ This search system will check eBay™ for coin 

information using the same search system provided 

with EzCoin version 1. 

 

Report Menu Items 

The following table summarizes all of the items under the Reports menu, excluding 

the report profile editor and customized report assignments. 

Click on any of the links in this table to see additional information. 

Basic Reports Provides basic information for records in your inventory. 

This report closely resembles the one from EzCoin 

version 1. 

Detailed Reports Same as basic, but adds many more fields of 

information, including grade details. 

Comments Report Provides a specialized report to efficiently show coin 

records containing extended text comments. 

Cross Reference Report Provides catalog ID/location cross reference 

information. 

Quick Stats Report Quick stats reports represent your 3 most common 

report templates in EzCoin. Although SoftPro provides 3 

default quick stats report profiles, you can replace them 

with your 3 favorite templates. 

Priority Want List This report shows all coins you have added to the PWL. 

Priority Sell List This report shows all coins you have added to the PSL. 

Want List Report This is a basic report which includes all pre-supplied 

coin records which haven't been added to your 

inventory. For custom country files, this report isn't 



EzCoin Reference – Version 2.0 

Page | 182 
 

used. 

Grade Details Report A grade details report is similar to a grades search, 

except that the grades report mimic the old EzCoin 

version 1 behavior, in that the grade information is 

displayed left to right across the report. 

Purchase History Report A purchase history report tracks all coin purchases 

independent of your inventory. Unlike normal 

inventoried grades, the purchase/sell history can 

include multiple sales and purchases for a given coin 

based on denomination, year, type/reign, variety and 

mint mark. 

Sell History Report A sell history report tracks all coin sales made. Unlike 

EzCoin version 1, purchase/sell history is not part of 

your inventoried coin record information. 

Coin Information This report provides all of the pre-supplied coin 

attributes. 

Customizations Report This report type includes coin attributes which you have 

modified to be different from pre-supplied values from 

SoftPro. This report can also be used for custom 

varieties. The report isn't available for custom countries. 

Navigation List Report The active navigation list can be viewed as an ad-hoc 

report, by choosing any available report profile, and 

then displaying the results in the spreadsheet viewer. 

Grand Totals Report If you have multiple countries in use with EzCoin, you 

can get summary reports for all of the country files 

together in a single view. 
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Grade Group Selection Dialog Window 

 

The grade selection window allows you to quickly choose specific grades from those 

available in the current country, including pre-supplied grades and custom grades 

which you can create.  

A grade group template allows you to create a custom selection of grades and save 

this to a file. Once you have selected some grades, you can click on the New 

button to save a new template file. It will now appear in the Grade Group dropdown 

list. 

The Delete button can be used to remove group template files. 

There are several places in EzCoin where grade group selection options are 

provided. When you have the opportunity to do so, this dialog window will always 

be available to allow quick selection of specific grades. 
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Key Coin Field Search 

All coin records are uniquely identified by 5 primary key fields: Denomination, Year, 

Type/Reign, Variety, Mint Mark. The key field search is based on a combination of 

these 5 fields. 

 

You must enter at least one of the 5 key fields to start a search. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. For example, a denomination search value of cents will match 

denominations such as 5 cents and 25 cents. 

For a year range, only the starting value is required. Leaving the ending year empty 

will search all coins to present year. 
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Coin Attribute Search 

This search option is based on the physical dimension/type of coin: 

 Diameter 

 Thickness 

 Edge 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

For a year range, only the starting value is required. Leaving both the start and end 

year empty will search all coins. 
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Composition Search 

A composition search is based on the composition field, it's weight and any precious 

metal content. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

The composition field is free format text and generally contains the non-precious 

metal content for the coin, or any special notes regarding the composition. 

The 4 precious metal types of Silver, Gold, Platinum and Palladium are searches 

based on a content percentage greater than zero. That is, this search feature 

doesn't allow you to search for a specific percentage of a precious metal - you will 

need to use a Power Search for that. 

The Pure Compositions option will report on coins where the composition field is 

empty and the coin contains 1 or more of the precious metal components. 
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The weight is expressed in a unit of measurement. Use the drop down list to select 

a weight. Use the operation drop down list to select the type of weight comparison 

to use. 

Mint Details Search 

This search option is based on the mintage attributes 

 Mint Location 

 Mintage Circulation 

 Proof Mintage Circulation 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

For a year range, only the starting value is required. Leaving both the start and end 

year empty will search all coins. 
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For mintage and proof mintage, enter the circulation amounts with or without 

comma separations. 

Period Search 

This search option is based on the period of active circulation. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

For a year range, only the starting value is required. Leaving both the start and end 

year empty will search all coins. 

Check the year range option to force the year from and to values to match the 

period field, as opposed to the year of issue field. 

For example, if a period is 1876-1882 and you enter a year range of 1850 to 1900, 

then this coin record would match on the period as 1876 is greater than 1850 and 

1882 is less than 1900. If you entered 1875 to 1880, the coin record would not 

match, as 1882 falls outside of this year range. 
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Designer Search 

This search option is based on the coin's designer. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 
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Notes/Description Search 

This search option is based on the coin's description/notes field. This is not a 

comments search. The description for a coin appears below the images in the main 

EzCoin window, and above the comments area. 

 

\ 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 
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Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

Location Search 

This search checks both the primary coin location and the location fields at the 

grade level. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

Each grade for a given coin record can have its own location (or sub-location if you 

prefer to associate it that way). The grade location will always appear in the grade 

data grid, and the main location will always appear in the coin details area. 
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When searching for location values, make sure that the status of Main and grade 

both match checkbox option is what you want. 

If this option is checked, then the search must match on BOTH conditions for the 

main location and the grade location. If the option is unchecked, then either 

condition can match to satisfy the search. 

Main Match Search Conditions 

Do not search on the primary location. Ignore checking the main coin location. 

Partial or exact match on the search value. The search value entered must 

partially or exactly match, based on the status of the Exact Match checkbox. 

Find any coin where the main location has a value. This will return a match if 

the location for the coin record contains any value. 

Find any coin where the main location is empty. This will return a match if the 

location for the coin record has no value. 

 

Grade Match Search Conditions 

Do not search grade location values. Ignore checking the grade locations. 

Partial or exact match on the search value. The search value must partially or 

exactly match the grade location for at least one inventoried grade. 

Find coins with at least one grade location. The search is satisfied if at least 

one inventoried grade has any location. 

Find coins with no grade locations. The search is satisfied if every grade 

inventoried lacks a location. 

Find coins with empty grade locations. The search is satisfied if at least one 

inventoried grade has no location. 
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Serial Number Search 

This search option is based on the serial number, a field which is not supplied by 

SoftPro. You can use this for any generic purpose. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 
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Comments Search 

This search checks both the primary coin comments and the comment fields at the 

grade level. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

Each grade for a given coin record can have its own comments. These comments 

are in addition to the primary coin comments which appear below the coin image 

area. 

When searching for comment values, make sure that the status of Main and grade 

both match checkbox option is what you want. 
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If this option is checked, then the search must match on BOTH conditions for the 

main comments and the grade comments. If the option is unchecked, then either 

condition can match to satisfy the search. 

Main Match Search Conditions 

Do not search on the primary comments. Ignore checking the main coin 

comments. 

Partial or exact match on the search value. The search value entered must 

partially or exactly match, based on the status of the Exact Match checkbox. 

Find any coin where the main comments have data. This will return a match if 

the comments for the coin record contains any value. 

Find any coin where the main comments are empty. This will return a match if 

the comments for the coin record have no data. 

 

Grade Match Search Conditions 

Do not search grade comments. Ignore checking the grade comments. 

Partial or exact match on the search value. The search value must partially or 

exactly match the grade comments for at least one inventoried grade. 

Find coins with comments in at least one grade. The search is satisfied if at 

least one inventoried grade has any comments. 

Find coins with no grade comments at all. The search is satisfied if every grade 

inventoried lacks comments. 

Find coins with no comments for some grades. The search is satisfied if at 

least one inventoried grade has no comments. 
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Custom Field Search 

Custom fields represent additional information to associate with a coin, which is not 

part of any default country configuration. Custom fields are created by you, or may 

be imported from version 1 of EzCoin. This search allows you to find information for 

one custom field at a time. 

 

Note: This search type includes denomination and year range filter options. 

Check the Case-Sensitive option to match upper and lower case text. 

Check the Exact Match option to make your search values match 100% of the 

associated key field value. Without this option checked, the text you enter forms a 

partial match. 

Every custom field you've created will appear in the dropdown list. Choose the field 

and then choose the type of search operation from the second dropdown list. 

Enter the search value if one is required. Note that custom field searches are 

always based on a partial match scenario. You are not required to enter the full 

custom field value to match a record. 
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EzBrowse and EzInventory 

These 2 options provide a quick at-a-glance view of coin information, for both pre-

supplied and inventoried coins. 

 

Unlike other searches, you will be presented with a simple dialog with the following 

choices: 

 Select the record type. 

 Select the duplicate coin status. 

 Choose either a year or denomination sort order. 

 Set the output to report, navigation list or thumbnail images. 

 Check the option to exclude sub-varieties as necessary. 

EzBrowse by default will choose the all coin records option. EzInventory will default 

to inventoried coin records only. 
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Market Value/Pre-Supplied Price Search 

Market values are the prices associated with each grade for each coin record. It's 

not required (and in fact is almost certainly the case) that every grade for every 

coin will have a market value assigned to it. Market values pre-supplied by SoftPro 

are based on the availability of pricing information at the time a country file is 

generated for use with EzCoin. 

If a market value doesn't exist for a coin grade, you are free to add your own 

prices. Be aware that if you modify a pre-supplied market value, it may be replaced 

by one from SoftPro on the next supplied pricing update you download. 

 

The left side of the dialog window provides a list of grades to filter on. Check any 

grades you want to search for pricing.  

Click on the Clear button to clear the checked status for all grades. Click on Select 

All to check every grade in the list. 

Use the Grades button to selectively choose grades and access the Grade Selection 

dialog window, allowing you to choose grades using custom grouping templates. 
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Check the Custom Prices Only to restrict the search to only include coins which 

have custom market values you supply, or for coins for which you've changed a 

price provided by SoftPro. 

Choose a comparison type, and if required, a price amount. 

Power Search 

This option is available in the Search menu under Power Search. The power 

search provides the most comprehensive method to find coin records and filter the 

results down to what you are looking for. It doesn’t provide the ability to replace all 

of the other searches and reports, especially the grade search feature, but it can be 

used as a substitute for many of them. 

  

A power search is comprised of 1 to 3 levels, each level being a unique search unto 

itself. The Level of Search drop down list provides the conditions by which the 

results of the each search level are combined to create the final list of coin records 

which will be in the report. 

The Ignore Duplicates option is a simple checkbox type (you can’t choose to 

show only duplicates using this option. However, you can accomplish this using a 

field search based on duplicate sequence numbers greater than 1). 
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The level of search is used based on matching conditions between each level. For 

each single coin record searched against, each level counts a match result 

independently. For the example above, if a coin record has a denomination of 25 

cents, the first level is considered to be a match. If any coin has any grade value 

greater than $10,000, then the second level is considered to be a match.  

Level of Search Types 

As you choose a level of search, the number of levels in the dialog window will 

increase or decrease accordingly. You will not be able to perform a multi-level 

search unless each level’s input conditions are entered. 

Level 1 Only Matches The simplest power search type, only one level of 

search, so a record is considered valid for the report 

if the search conditions are met. 

Level 1 And Level 2 Match A two level search when both levels of search must 

be valid. In the example above, the record must 

have a denomination of 25 cents and at least one 

inventoried grade must have a value greater than 

$10,000. 

Level 1 Or Level 2 Match A two level search where either level must be valid, 

but not both. 

Level 1, 2 And 3 All Match A three level search where all 3 levels must have a 

matching condition. 

Level 1 Or 2 Or 3 Match A three level search where ANY of the 3 levels must 

have a matching condition. 

(Level 1 Or 2) And Level 3 

Match 

A three level search where either level 1 or 2 has a 

matching condition, AND level 3 MUST always have 

a matching condition. 

Level 1 And (Level 2 Or 3) 

Match 

A three level search where either level 2 or 3 has a 

matching condition, AND level 1 MUST always have 

a matching condition. 

Level 1 Or (Level 2 and 3) 

Match 

A three level search where either level 1 has a 

matching condition OR BOTH level 2 AND level 3 

have matching conditions. 

(Level 1 And 2) Or Level 3 

Match 

A three level search where either level 3 has a 

matching condition OR BOTH level 1 AND level 2 

have matching conditions. 
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Search Criteria: Type 

The Type dropdown list specifies a subgroup of the information in a coin record. 

Once you select the type, additional filtering options will be adjusted based on the 

type you chose. Not all types shown below will be available, depending on the 

country which is currently open.  

Primary Fields Primary coin information, including fields from main 

application coin details area, catalog ID values and 

calculated price/quantity totals. 

Any Text Field Any field which is classified by EzCoin as simple text 

information will be searched. You can filter the text fields 

to a more restricted subset using the Fields button. 

Any Numeric Field Any field which is classified by EzCoin as numeric data 

(quantity or other non-currency numeric types) will be 

searched. Fields can be filtered using the Fields button. 

Any Date Field Any field which is classified by EzCoin as a date value will 

be searched. Fields can be filtered using the Fields 

button. 

Any Currency Field Any field which is classified by EzCoin as a monetary value 

will be searched. Fields can be filtered using the Fields 

button. 

Custom Fields If you have attached custom fields to the country file, you 

can search on any of them using this option. 

Inventoried Grades This option allows you to search specific fields related to 

grades which have been inventoried to the coin record. 

The Grades button will be enabled allowing for additional 

filtering to one or more specific grades. 

Priority Want List This option will search against records which are part of 

your Priority Want List. 

Priority Sell List This option will search against records which are part of 

your Priority Sell List. 

 

Note: The search types for the PWL and PSL will search against all data rows 

associated with the coin record. For example, if you executed a PWL search and 

there are 4 priority list entries on a single coin record, the search is performed 

against all 4 entries, and if at least one entry matches the search, then the coin 

record is a valid match. 
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Search Criteria: Field 

For the “Any” search types, such as Any Text field, this drop down list is disabled. 

For all other search types, this drop down list will contain all the fields which can be 

chosen to search against, based on the data type you chose. Only one field can be 

chosen for the power search level. 

Grades Filter 

For the Inventoried Grades search type, this button will be enabled, allowing you to 

restrict which grades will be searched. Clicking the button will show the Grade 

Selection Dialog Window. 

Any Field Filter 

For the “Any” search types (Text, Numeric, Currency, Date), this button will be 

enabled, allowing you to provide additional restrictions to which fields are in scope 

for the search. 

 

Select which fields should be part of the search and click on the OK button. If you 

want to create a custom filter and save it to file, click on the Save button. You can 

recall this filter by using the Load button. 

Note: To clear a field filter, click on Select None then OK. For clearing a grade 

filter, you click on Select All then click on OK. 
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When either a Grade or Field filter is in effect, a small white arrow icon will be 

shown between the two buttons, indicating that a filter is being applied to the 

search. If there is no filter in effect, the icon will not appear. 

 

Search Criteria: Operation 

This drop down list contains the operations available to compare your search 

value(s) against the field values in the coin record. The types of operations 

available are automatically adjusted based on the type of data you are searching 

against. 

Contains For text fields, the search value matches on part of 

the coin record field value. The search value can be 

contained anywhere within the field. 

Doesn't Contain For text fields, the search value can’t exist anywhere 

within the coin record field value. 

Empty The field value in the coin record doesn’t contain any 

data. 

Not Empty The field value in the coin record contains any data 

other than “nothing”. 

Starts With For text fields, the search value matches on the 

starting characters of the field value. 

Ends With For text fields, the search value matches on the 

ending characters of the field value. 

Greater Than The search value > coin field value. 

Less Than The search value < coin field value. 

Equal To The search value = coin field value. 

Greater Than or Equal To The search value >= coin field value. 

Less Than or Equal To The search value <= coin field value. 

Not Equal To The search value ≠ coin field value. 

Between The coin field value is between the two search values 

inclusively. 

Is No For Yes/No type field searches, the coin record value 

is No. 
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Is Yes For Yes/No type field searches, the coin record value 

is Yes. 

 

Case-Sensitive Searches 

For text-based fields, you can specify that the text search is to distinguish between 

upper and lower case characters by checking this option. 

Search Values 

Depending on the data type, you will enter data into the input field (there will be 

two input fields for the Between search operation) as numeric, text, currency or 

date formats.  

 Numeric data can be either whole numbers without fractions (i.e. quantities), 

or numbers with a decimal point and fractional value. 

 Currency values can be entered with the country file’s defined currency 

symbol, or without it. In effect, a currency value can be entered as a numeric 

type. The currency value is always based on the current conversion rate, 

which is applied to all price values in the data. 

 Date values can be entered using either the display or input date formats 

defined in the EzCoin general preferences. In addition, EzCoin will also accept 

dates entered using the current format defined at the Windows system level. 

Time values (hours, minutes, and seconds) are not acceptable, as EzCoin 

doesn’t store time information for date fields. 

 String data is limited to the maximum allowable length of the field you are 

searching against. 

Last Search, Save and Load Options 

These 3 buttons allow you to save and recall power search input conditions. By 

default EzCoin resets the power search to a default blank state. Once you execute a 

successful power search, the settings are saved automatically as the “last power 

search”. By clicking the Last Search button, the previous input conditions will be 

restored. 

The Save and Load buttons can be used to save customized power search 

conditions to a file name of your choosing. When loading a saved search, you will 

be asked for a file with a .pwr extension, which by default is saved to the 

Searches\Power folder within the EzCoin application path. 

Running a Power Search 

Click on the Find button to start the search. Depending on the type of search 

conditions (specifically, the “any” field types), the search may take several seconds 

to complete. A progress status will appear at the bottom of the dialog during the 
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search. If any matches are found, the Show button will be enabled, allowing you to 

display the results using any of the 5 display options. 

 

Grade Searches and Reports 

The Grade search provides a comprehensive set of input conditions to find coin 

records based on your inventoried grade data. The dialog’s dual tab nature also 

provides the basic search conditions common to most other report types. These two 

tabs of search conditions are effectively combined together to generate the report 

data. 

The grade search is available in the Search menu as Grades Search. The 

grades report is available in the Reports menu as Grade Details Report. There is 

only one key difference between these 2 menu items. The report generated from 

the Search menu presents the grade data horizontally across the page. The report 

generated from the Reports menu presents the data vertically down the page. 

Examples of each type are shown below. 

Grades Report from the Search Menu 
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Grades Report from the Report Menu 
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Type Search Conditions 

The second tab in the search dialog contains search parameters common to most 

other report types. 

 

When choosing a filter method, the associated search values will appear in the 

lower section of this window.  

The middle section of the window contains 3 fields unique to inventoried grades: 

Comments, Graded By and Location. You can enter complete or partial values in 

each field, and choose to make the search case-sensitive. Note that the filter 

methods use their own checkbox options for case-sensitivity and exact matching. 

 

Search Condition Priority 

The priority for matching coin records is based on the Type Search Parameters 

first, followed by the Grade Search Parameters. For example, if the type search 

conditions in Tab #2 resulted in 100 matching coin records, then the grade search 

conditions in Tab #1 will only be applied to the 100 records. 
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In effect, the Type Search conditions are applied before the Grade Search 

conditions. 

Grades Search Conditions 

The first tab in the search dialog contains search parameters unique to a grades 

report. 

 

The default report profile will be different depending on whether this window was 

displayed from the Search or Reports menu. For the search menu selection, all 

pre-supplied report profiles in the dropdown list will be based on a horizontal 

presentation of the grade data. From the reports menu, the profiles will be based 

on a vertical presentation. 
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Inventoried Grade Information 

The following table describes the fields associated with a single inventoried grade. 

Field Description 

Grade Name The name of this grade, i.e. MS-65. 

Market Value The price of the grade, either a pre-supplied value or one 

which you assigned, expressed in the current currency format 

and conversion rate assigned to the country. 

User Value You can choose to override any market value for any grade. By 

default no user value will be applied to any inventoried grade. 

Bullion Value If a coin was inventoried as a bullion value based on precious 

metal content and a valid weight, this will be the value of the 

coin, superseding the market/user value. 

Quantity Quantity can be a value from 0 and up to a maximum of 

99,999,999. A grade can be inventoried with zero quantity. 

Net Value This is quantity * the user value/bullion value/market value. 

Coin Qty The total coins associated with a single grade. This value is e 

grade quantity multiplied by the Coin Set Quantity (which 

normally is 1 coin for non-set records) to result in the total 

number of physical coins. 

Comments You may enter any text comments to associate with a grade. 

This search value appears only on tab #2. 

Location You may enter an optional location to associate with a grade. 

This search value appears only on tab #2. 

Graded By You may enter an optional value for who graded the coin. This 

search value appears only on tab #2. 
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Search Conditions 

The following table shows the various input conditions for a grade search. 

Attribute Description 

Value Type This determines what currency value of the grade data will be used 

for the search. See the next section for a list of possible types. 

Quantity Type Quantity can be chosen for single grades, selected (from the check 

box list) or net total. You can also choose to search on a specific 

Coins per Grade value. 

Value and 

Quantity 

Comparison 

Types 

These are basic comparison operations. The default value of All 

Values implies matching any value or any quantity, regardless of 

what those values are. In order words, if the grade is inventoried, 

it will be counted. 

Suppress Zero 

Quantity 

When checked, any grade record where the quantity is zero will be 

excluded from the search. 

Suppress Zero 

Values 

When checked, any grade record where the grade user value, 

bullion value, and market value are ALL zero will be excluded from 

the search. 

Bullion Added 

Grades Only 

This checkbox represents a convenient method to generate bullion 

reports. Check this option and only grades which were inventoried 

as bullion values will be included. 

Grade Selection A grade search is not allowed until you select at least one grade in 

the checkbox list. The Clear, Select All and Grades buttons can 

be used as alternative methods to checking and un-checking 

grades one by one. Only grades which are selected are used as the 

basis for the search. The exceptions to this are “Totals” Quantity 

and Value attributes, which affect all grades inventoried on the coin 

record. 

 

Value and Quantity Types 

The two Type drop down lists for currency and quantity values are summarized in 

the following table. 

Single grade types will appear on the report if at least one of the selected grades 

in the checkbox list satisfies the search conditions. For example, if MS-63 and MS-

65 are checked, and you specify a Single Grade Market Value greater than 

$1000.00, then the coin appears on the report if either grade has a market value 

over $1000.00. 
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Selected grade types will appear on the report only if the sum total of the 

quantity or value match on the search conditions. For example, if you have checked 

MS-60 through MS-70, and specified Selected Net Grade Quantity over 25, then the 

sum net quantity of the inventoried grades matching from MS-60 to MS-70 for the 

coin must total more than 25. 

Total grade types apply to all inventoried grades, regardless of the grades 

checked in the list. You will still need to check at least one grade for this type of 

search, even though every grade inventoried will be counted. 

Type Description 

Single Grade Market Value The price for a single grade. 

Single Grade User Value Your custom value for a single grade. 

Single Grade Bullion Value The bullion value of the grade, if inventoried as such. 

Single Grade Net Value The user value/market value/bullion value * quantity. 

Selected Grades Net Value The sum of Net value for all selected grades. 

Total Net Worth The sum of all Net values for every grade inventoried 

on the coin record. 

 

Single Grade Quantity The inventoried quantity of a single grade. A value of 

zero is allowed. 

Single Grade Coin Quantity The Coin Qty for Sets * Quantity result for a single 

grade. For records which are represented by a single 

physical coin, this will be the same as the Single Grade 

Quantity value. 

Selected Net Grade 

Quantity 

The sum of all quantities for all selected grades. 

Selected Net Coin Quantity The Coin Qty for Sets * Quantity result for all selected 

grades. 

Total Net Grade Quantity The sum of all quantities for all inventoried grades. 

Total Net Coin Quantity The Coin Qty for Sets * Quantity result for all 

inventoried coins. 

 

Filtering Rules 

The following table indicates how grade records and the coin record the grades are 

associated with will be filtered in the search. For searches where a single grade is 

excluded from the report, it will still allow the coin record to appear with the grades 

which did match the search conditions. However, if the search results in elimination 
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of every grade from the report, the coin record will also be eliminated from the 

report. 

Rule/Condition Result on Failure 

No inventoried grade data present The coin record will never show in the report. 

Default conditions (what you see 

when you click the Reset button) 

status. 

Every coin record which has at least one 

inventoried grade will appear in the report. 

Comparison type of All Values for 

Values 

No currency values will be subject to filtering 

– any grades with a price count. 

Comparison type of All Values for 

Quantities 

No quantities will be subject to filtering – any 

grades with a quantity over 0 will count. 

Grades not selected in the checklist 

box 

They will be excluded from a search except 

when using value or quantity Types with the 

“Total” prefix such as Total Net Worth. 

Selected grades Net Quantity or 

Net Value fail to match the search. 

The entire coin record is excluded from the 

report. 

Total net quantity or net worth 

failed to match the search. 

The entire coin record is excluded from the 

report. 

User comments, location or graded 

by failed to match the search. 

Only grades which don’t match on the 

comment, location, or graded by text will be 

excluded from the report. 

Suppress Zero quantity is enabled, 

but the grade has no quantity. 

Exclude the grade from the report. 

Suppress Zero value is enabled, 

but the grade has no value. 

Exclude the grade from the report. 

Bullion Added Grades option 

enabled. 

Exclude any grades which are not inventoried 

as a bullion value. 

Single Grade search types where 

the grade Quantity or net value 

failed to match the search. 

Exclude the grade from the report. 

 

How Grade Selections Work 

You must select at least one grade to execute a search. The grade list itself will act 

as a filter for Selected and Single Grade quantity/value Type attributes, dates and 

buy/sell information. Unchecked grades are excluded, as if you didn’t inventory the 

grades at all for the coin record. The exception to this is for the Totals Types in the 
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quantity and value drop down lists, in which all grades will be used to calculate net 

totals on the coin record. 

Each grade inventoried is counted as “this grade record has data” even if all of the 

following grade attributes are zero or blank: 

 Quantity 

 User Value 

 Market Value 

 Bullion Value 

 Comments 

 Location 

 Graded by 

It’s perfectly acceptable to inventory a grade in this way. However, only the default 

All Values comparison search conditions will pick up these types of records on the 

report. Every other comparison type will require the associated attribute to be 

populated for the grade. 

Performing the Search 

Click on the Find button to search the country file for matching coin records. If any 

matches are found, then the Show button will be enabled, allowing you to display 

the results using any of the 5 output types. If the Show in Main Window option is 

chosen, the first matching record will automatically be displayed in the main EzCoin 

window. 

Loading and Saving Search Conditions 

Use the Load and Save buttons to store search conditions to files which can be 

recalled at a later time. These files are saved in the application folder under 

Searches\GRD. 
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Change History Report 

EzCoin will keep track of when you last made changes to an inventoried record. The 

type of change (i.e. changing the name of the Designer) will not be recorded. Only 

the date of a change is saved. 

  

The report can provide results based on all inventoried data, or only on custom 

varieties not pre-supplied by SoftPro. 

The date of change can be searched using recent days, recent months, or a specific 

date range. 

Note: The last change date is affected not only by your updates to the country (via 

the blue check button, Rapid Multi Entry, or from the spreader viewer), but also by 

pre-supplied update patches from SoftPro. 

  



EzCoin Reference – Version 2.0 

Page | 215 
 

Basic and Detailed Inventory Reports 

The basic and detailed reports are identical in terms of setting the search 

conditions. The only difference between them is the default report profile assigned 

for spreadsheet views and printed reports. 

Detailed Report with Key Field Filter Method 
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Detailed Inventory Report - Unfiltered Default Method 

 

 

Report Fields - Basic vs. Detailed 

Basic Report Detailed Report 

Denomination Denomination 

Year Year 

Type/Reign Type/Reign 

Variety Variety 

Mint Mark Mint Mark 

Notes Notes 

Location Location 

Serial Number Serial Number 

 Quantity and Net Value for Each Grade 

Total Grade Quantity Total Grade Quantity 

Total Net Value Total Net Value 

 

Although the reports look quite similar, the detailed report shows a column for 

every inventoried grade associated with a coin record. 
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Quick Stats Inventory Reports 

These reports all use the same common search conditions dialog window. The only 

difference between them is the choice of default report profile. 

Quick Stats 1 Report with UID Filter Method 

 

 

Report Fields - Quick Stats 1, 2 and 3 

Quick Stats 1 Quick Stats 2 Quick Stats 3 

 Image Preview  

Denomination Denomination Denomination 

Year Year Year 

Type/Reign Type/Reign Type/Reign 

Variety Variety Variety 

Mint Mark Mint Mark Mint Mark 

  Individual Grade Qty + Net Value 

Columns 

Total Grade Quantity Total Grade Quantity Total Grade Quantity 

Total Net Value Total Net Value Total Net Value 

  Total Net Purchased 

  Total Net Sold 

  Total Net Profit 
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Comments Report 

The comments report is not a comments search. Whereas the search option allows 

you to selectively find comments using text matching conditions, the comments 

report is a summary listing of all coin records for which you've attached a comment. 

 

Other than the basic filtering methods common to most reports, you won't see a 

comment text filter - you get all coin records containing comments after applying 

the common search condition filters. 

The report profile is different as well, in that comments reports divide the results 

window between the primary coin attributes and the comment text. 
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The bottom section of the spreadsheet viewer will show the comments for the 

selected coin record in the data grid. You won't be able to edit the comments from 

the comments area under the grid - use the Comments edit option from the 

Summary menu instead. 

When printing the comments report, each coin record's comments will be displayed 

in a page-width spanning format, underneath the other coin report fields. 

Note: This report type doesn't provide any grade level comments information. 
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Cross Reference Report 

A cross reference report is designed to show basic coin information with associated 

location, serial number and alternate catalog ID values. 

 

The serial number and location fields are not part of the search conditions. They are 

simply included in the cross reference. The default search conditions for this report 

type will show all coin records assigned to the country with the associated cross-

reference fields listed below. 

 Unique Identifier (UID) 

 Location (main location only, not grade level locations) 

 Serial Number 

 Pre-supplied alternate catalog ID values (if applicable) 

 Your custom catalog ID values (if used) 
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Priority Want and Sell List Reports 

These two report types provide a summary of all coin records you've added to the 

Priority Want List (PWL) and Priority Sell List (PSL) repositories in the country file. 

 

These report types are similar to the other basic reports, with an additional button 

at the bottom labeled PWL Filter (or PSL Filter). Clicking on this button will show 

the following dialog. 
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This filter window allows you to select specific grades or types to buy (sell for PSL) 

to show on the report. 

The default PWL/PSL reports only show the following basic information: 

 Denomination 

 Year 

 Type/Reign 

 Variety 

 Mint Mark 

 PWL/PSL Data: Grade, quantity, type to buy/sell, market value, net buy/sell 

value 

The PWL/PSL data is represented by a data group in the report profile. This means 

each grade for a given coin record is represented by one row in the report, and will 

be presented down the page in a vertical format. 

If you have added the coin record to the PWL/PSL without any specific grades, the 

report will show just one row for the coin record, with the grade set to "Any". In 

addition, the net buy/sell value would be $0.00, since there is no actual grade to 

determine the market/price values available. An example report is shown below. 

Note the third record has no net buy value, as the quantity was added as zero, 

without an available buy price or market value. This is an acceptable PWL entry. 
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Want List Report 

Unlike a Priority Want List report, where you pick coins and grades one by one to 

add to a specialized list, the want list report is simply a report on all pre-supplied 

coin records from SoftPro for the current country which are not currently part of 

your inventory. 

 

You can choose either pre-supplied non-inventoried coin records (default) or all pre-

supplied coin records from the Search In dropdown list. Want list reports will not 

work for custom country files which have no pre-supplied coin records from SoftPro. 
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Purchase/Sell History Report 

EzCoin maintains transactional history for all coins purchased or sold independent 

of inventoried grade information. This is a notable change from version 1 of EzCoin, 

where purchase/sell information could only be attached to inventoried coin records. 

The transactional history is cumulative. For a coin uniquely identified by 

denomination, year, type/reign, variety, and mint mark, you are free to make 

multiple purchase/sale transactions over time. 

The dialog window shown is for a Purchase History Report. The Sell History Report 

has the same settings and is not shown here. 

 

 

The lower second of the report search conditions window provides the basic filter 

for the 5 primary coin fields. The upper section of the window contains fields related 

to purchase/sell history information. 

Field Description 

From/To Date When you record a purchase or sale, you should enter a date 

for when the transaction took place. The from/to values allow 

you to set a range of dates for when coins were 
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Field Description 

purchased/sold. If you leave the "to date" field empty, the 

range will extend to today's date. 

 

Use the ... button to the right of the date field to use a popup 

calendar to choose the date. 

Buy/Sell 

Quantity 

The quantity of coins purchased or sold. Use the drop down list 

to the right of the field to set a comparison method. 

Buy/Sell Price The price of the purchase or sale (total, for all coins in the 

transaction). 

Comments Optional comments you can attach to the purchase/sale. 

Bought From / 

Sold To 

Who you purchase the coin(s) from or sold them to. 

Grades The grade list isn't shown on this window. By default, all 

grades are selected for the report. If you wish to filter by 

grade, click on the Grades button at the bottom of the 

window. 
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Coin Information Report 

This report provides a quick summary of the key attributes for a coin record. 

 

Other than the basic filtering methods common to most searches and reports, the 

only difference is the report profile, which by default will contain the following 

information: 

 Denomination 

 Year 

 Type/Reign 

 Variety 

 Mint Mark 

 Unique ID (UID) 

 Period 

 Mintage and Proof Mintage 

 Designer 

 Mint Location 

 Diameter, Weight and Thickness 

 Composition 

 Edge 

 Notes/Description 
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 Set Coin Quantity 

Note that the composition on this report is defined to be a merged version of the 

precious metal content percentages and the other composition information. This is 

to keep the report similar to what was provided in EzCoin version 1. If you wish to 

see a report with the precious metal content in separate fields, you should create a 

custom profile and assign it to the report. 

 

Customized Data/Records Report 

For countries which contain pre-supplied data from SoftPro, you may have 

customized records where some of this pre-supplied information isn't the same, or 

in the case of custom coin varieties, isn't available. 

 

The Search In condition is slightly different for this report type.  

All Customized Data: Includes modified pre-supplied records (where at least one 

field of data has been altered) and any custom variety coin records (no pre-

supplied data at all). 

Modified Supplied Data: Only report on pre-supplied coin record differences. 
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Custom Varieties: Only report on coin varieties which have no pre-supplied 

information. 

The report format will also be slightly different than standard reports. Any field 

which contains a value which is modified from a pre-supplied version will be 

displayed in the report and automatically shaded in a different color to indicate this 

scenario. 

 

Navigation List Report 

Navigation Lists are simply a list of coin records maintained by EzCoin and 

accessible using the violet arrow buttons in the main toolbar. These lists can be 

generated from the Report Viewer, Tag Lists, Coin Lists, and Searches. A navigation 

list has no special formatting characteristics – it’s just a collection of coin records 

based on the 5 key fields of denomination, year, type/reign, variety and mint mark. 

Since a report profile represents the presentation style and printing attributes for a 

report, you can attach a report profile to a navigation list to generate an ad-hoc 

report for the coins in the list. 

You can find the ad-hoc reporting option from the Navigation List submenu under 

the File menu. 

 

Choose a report profile (every pre-supplied and custom report profile is available in 

the drop down list) and click Show to bring up the Report Viewer. 
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Grand Totals Report 

The grand totals report provides summary statistics for all country files installed 

and registered with your copy of EzCoin. For a country to appear in the report, you 

must have opened it at least one time. By default all countries are un-registered 

until the first time you open them. 

The grand totals report uses a unique dialog window for the search input conditions 

as shown below. 

 

Report Orientation 

The Horizontal format will show one line of information for each country file across 

the report. The Vertical format will show grade information vertically, similar to the 

Inventoried Grades Search report.  

There are 2 separate menu options under the Reports menu for each format type. 

Grade Selection 

The grade checkbox list is used to filter the grades which will appear on the report. 

The Grades button can be used to select from pre-defined grade groups. The All 

Grades checkbox can be used to show all grades on the report and the grade list 

selection will be ignored. 



EzCoin Reference – Version 2.0 

Page | 231 
 

Country Selection 

By default all registered countries are included in the report. If you want to show 

totals for specific countries, then click on the Countries button. Note the title bar 

at the top of the search window. It indicates how many countries are available and 

how many will appear in the report. If a country isn’t registered (i.e., opened at 

least one time) or there are no inventoried records on the country, then it will be 

excluded from the report. 

Country Exclusion 

The County Settings dialog accessed from the File menu allows you to turn off 

visibility of a country in a grand totals report. This can be useful for alternate 

working copies of a master country file. 

Report Attributes 

Report for the Open 

Country File 

If checked this option will restrict the report to the 

current open country file only. 

Group by Common 

Country Name 

If you have several country files based on a single 

country of origin (i.e. USA), checking this option will 

take the totals for all of the country files of that origin 

and show results as a net sum under a single row in 

the report. 

Include Countries with 

Disabled Totals 

The Country Settings window allows you to disable 

any country file from showing its totals in the report. 

If you check this option, then every country file will be 

included in the report even if disabled at the country 

file settings level. 

Show Flag Images in the 

Report Viewer 

Check this to display flag images in the on screen 

report viewer. 

Show Flag Images on 

Printed Reports 

Check this to print the flag images on your reports. 

Display Individual Grades 

Horizontally 

This option will enable the display of totals for each 

grade across the report. This option is disabled for a 

Vertical Format report, as this information would 

always be shown. 

Data Groups Data groups apply to the horizontal report format 

only. These checkbox options will filter the types of 

data in the report. For example, if you only want to 

see summary statistics for grade information, then 

uncheck all but Grade Totals. Note that purchase and 

sell history information are part of the Grade Totals 



EzCoin Reference – Version 2.0 

Page | 232 
 

option. 

Currency Selection By default, a GT report will show totals based on USD 

(USA) currency conversion rates. If you want to 

display the totals based on the conversion rate of a 

different country, then uncheck the USD option and 

select a country from the drop down list. 

Grade Format for 

Horizontal Grades 

This drop down list will be enabled when you choose 

to display grades horizontally. You have the following 

display choices: 

Net Value Coin Quantity 

Net Profit Record Quantity 

Purchase Price Grade Qty + Net Value 

Sell Price Coin Qty + Net Value 

Grade/Item Quantity Record Qty + Net Value 
 

 

Running the Report 

Once you have chosen all the input conditions for the report, click on the Show 

button. Depending on the orientation of the report, you will get a view in either the 

horizontal or vertical format. An example of each format is shown below. For 

options available in the menu, refer to the Report Viewer section of the manual. 

Example screens for both formats are shown below. 

Setting Value Types for Individual Grades 

For the horizontal report format with individual grade totals enabled, you can 

change the type from the Totals menu without having to re-run the report. 
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Horizontal Display Format 

 

Vertical Display Format 
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eLook™ 

This feature allows you to perform an eBay™ search using your default Internet 

browser. This option is available in the Search menu under eLook™ (or use the 

Ctrl + E shortcut key). 

For version 1 users of EzCoin, this search system has been carried over into version 

2 with minimal change. The Preferences option from version 1 with the eLook™ Fill 

Method has been removed and replaced with a search history drop down list 

instead. 

 

The current country selected in the drop down list is based on the current file 

opened in EzCoin. Note that custom countries which are not derived from a valid 

world country reference provided by SoftPro will not be valid for eLook™. 

The denomination and year list is taken from the current open country file and will 

not change, even if you choose a different country from the drop down list. You will 

need to manually insert the year and denomination information into the search text 

if the new country selected doesn't have a suitable value in the drop down. The 

drop down lists are an aid for the current open country only to pre-populate the 

search text. 

Click on the Search button to perform the appropriate search. EzCoin will launch 

your default Internet browser to point to the corresponding web page with the 

matching search conditions. 

Check the Keep this window open option to leave the dialog window open after 

running the search. This allows you to perform multiple searches. 
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The search text drop down list keeps a record of all of your previous searches in 

most recent used order by country. You can clear the search history for the current 

country by clicking on the Clear button. 
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EzCoin Report Viewer 
All searches and reports have a display option to show the data in a Spreadsheet 

Viewer.  

 

The report viewer shows coin records in a row and column grid format much like a 

spreadsheet. An example for the Coin Information Report search is shown below. 

The Data Browser option available from the Search and Report menus  is a 

scaled-down version of the report viewer, without any data manipulation 

capabilities. 

 

 

The viewer consists of a menu, toolbar, status bar, and a data grid showing the coin 

report data. Color coding of grid cells and the row tabs is shown in the above 
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example. The color coding serves as visual cues for specific attributes about the 

data in the grid. 

An image preview window can be toggled on or off using the F12 key. When turned 

on, the image preview pane will appear on the left. The width of the window is 

divided between the image and the data grid. You can drag the divider between the 

two areas to make the image area smaller or larger. 

 

 

The title bar at the top of the viewer window shows as many of the search input 

conditions as will fit. An option is available under the Help menu (View Report 

Title) to see all of this information in a separate dialog window. 

Record Tab Color Coding 

The leftmost column of the data grid is fixed and contains the record number. The 

color of this tab indicates a specific status of the record as follows (Note: this 

manual refers to the default colors, which can be changed using the EzCoin general 

preferences). 
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Green The record is part of your inventory. 

Blue The record has at least one column which matched on a search 

string using the Find menu option. 

Red The record has been book marked. 

Green + Red The record is inventoried and book marked. The tab cell will be 

a half-and-half color fill. 

Default The normal color used for data grid header labels based on 

your current Windows color scheme indicates a pre-supplied 

coin record not part of your inventory. 

 

Under Data Browse viewing, no color coding is used so the row 

tabs will always be this color as well. 

Column Header Color Coding 

The column headers which run across the top of the data grid normally use a basic 

default label color consistent with your Windows color scheme. If you are displaying 

Data Groups in your report profile, the header captions will be color coded to match 

the type of data group, and will be colored for only the columns which are part of 

the group. You can change these colors using the EzCoin general preferences. 

Green Inventoried Grade data group – each column under this color 

will be one of the separate attributes associated with individual 

grades assigned to the coin record. 

Violet Priority Want List data group – fields which are part of coins 

added to the list. 

Blue Priority Sell List data group – fields which are part of coins 

added to the list. 

Yellow Purchase history data group. 

Orange Sell history data group. 

Default For any columns not part of a data group, or when using Data 

Browse view mode. 

 

Special Color Coding of Data Cells 

The data value for a specific row cell within the grid can be color coded to indicate a 

special status. Normally, all data grids in EzCoin (for all windows) alternate the row 

colors: White for odd rows, Gray for even rows. In addition, a cell may be shown 

with the following colors. 
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Images The background color for images can be set in the EzCoin 

general preferences. The default is Black. 

Totals Lines These lines will always use the same color as the column 

header caption row. 

Dark Blue When you click or click and drag to select cells, the selection 

will be highlighted in this color. 

Light Blue The complete data row for any coin record where at least one 

cell is selected will be highlighted in this color, giving you a 

visual cue of the selected status of the record even when the 

actual cell selection may be scrolled off the left or right side of 

the window. 

 

Note that coin records can span multiple rows, such as detailed 

grade reports using the vertical presentation format, with 

multiple inventoried grades for a single coin record. In this 

case, all grid rows associated with the selected coin record are 

highlighted in this color. 

White on Green EzCoin has a general preference option to show high currency 

values in this color. You can enable this option and set the 

minimum currency value for which the highlighting will be 

applied. 

Yellow The viewer has an option to search every cell in the report for 

a specific data value. Matched cells will be highlighted in this 

color. In addition, the record number tab will be highlighted in 

the dark blue cursor color to indicate “at least one matching 

column for a coin which matched on this row”. 

Orange The cell represents a pre-supplied coin attribute, such as 

Designer, where the pre-supplied value has been altered. This 

color is not applicable to custom country files without pre-

supplied data, and is not enabled by default for every report – 

use Alt+F7 to toggle this color coding on and off. 

 

Report Viewer Toolbar Options 

 

1 Print the current report. 
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2 Show the selected coin record on the main screen. 

3 Close the report viewer. 

4 Find a value in the data grid. 

5 Hide selected columns. 

6 Show all hidden columns. 

7 Remove selected coin records from the report (does not remove from 

inventory, only the report view). 

8 Sort the report based on the selected column. 

9 Perform rapid multi entry on the bookmarked/selected coins. 

A Perform rapid entry into the Priority Want List. 

B Perform rapid entry into the Priority Sell List. 

C Add the bookmark/selected coins to your inventory. 

D Remove the bookmark/selected coins from your inventory. 

E Add the selected coins to your bookmark list. Hold down Ctrl to add 

everything. 

F Remove the selected coins from your bookmark list. Hold down Ctrl to invert 

the bookmarked selection. 

G Clear the bookmark list. 

H Data presence indicator for inventoried grade information. This indicator will 

be gray when there is no current data. Click on the button to perform a 

quick edit. 

Note: Indicators under items H to M in the toolbar are not active unless you 

select a single coin record. 

I Data presence indicator for the Priority Want List. 

J Data presence indicator for the Priority Sell List. 

K Data presence indicator for the Purchase History. 

L Data presence indicator for the Sell History. 

M Data presence indicator for Custom Fields. 

N If this button is enabled, then special information (for pre-supplied coins 

from SoftPro) is available for viewing. 

O If this button is enabled, then special notes (for pre-supplied coins from 

SoftPro) is available for viewing. 
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Report Viewer Status Bar 

 

 

1 If any columns are hidden in the current report profile, this icon will appear. 

Hidden status is retained even after the report viewer is closed down and is 

unique for each profile. You can click this icon to unhide all hidden columns. 

2 This is the coin inventory status icon. Refer to the main EzCoin window 

status bar help for the various icon types. 

3 This icon will appear if the selected coin is price locked.  

4 When you bookmark coin records, this indicator will reflect how many coins 

are in the bookmark list. 

5 The denomination and year of the selected coin record is shown here, 

assuming only one record is selected. 

6 If you are selecting individual cells with the mouse, the cell contents are 

copied to the status bar in this area. Otherwise, this area contains progress 

and help hint messages. 

 

Report Viewer Menu Options 

The Report Viewer (a.k.a. Spreadsheet Viewer), Data Browser, and Grand Totals 

Report View all share some common functionality, as they use the same viewer 

window. Data Browser and Grand Totals Viewers have limited functionality 

compared to the Report Viewer, and many of the options described in the next 

several sections will not appear with the latter two viewing modes. 

The following table is a quick summary of the menu options. Each of these will be 

described in detail in separate help topics. Use the links at the end of this topic to 

see additional information for each menu group. 

Menu Item Shortcut Description 

Options Show in Main Window F5 Show the selected coin record 

in the main EzCoin 

application window. 

Options Show as Thumbnail View F6 Show the report in the 

thumbnail viewer. 

Options Assign as new Navigation List F7 Assign the report to the 

Navigation List. 
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Menu Item Shortcut Description 

Options Assign to Coin List F8 Assign the report to the coin 

list viewer. 

Options Print Ctrl + P Print the report. 

Options Change Report Profile F10 Change to a new report 

profile. 

Options Show Image Preview F12 Toggle the image preview 

pane on and off. 

Options Show Comments Preview Ctrl + F12 Toggle the comments 

preview pane on and off. 

Options Create Snapshot Ctrl + S Create a snapshot file from 

the report. 

Options Clear Image Cache Ctrl + Shift + C Clear the thumbnail image 

cache. 

Options Report Merge  Report merging menu. 

Options Exit Ctrl + Esc Exit the viewer. 

    

Bookmarks Add Selection Ctrl + B Add the selected coin records 

to the bookmark list. 

Bookmarks Remove Selection Ctrl + Del Remove the selected coin 

records from the bookmark 

list. 

Bookmarks Add Everything Ctrl + Shift + A Add the report to the 

bookmark list. 

Bookmarks Invert Bookmark List Ctrl + Alt + B Reverse the bookmark 

selection. 

Bookmarks Clear Bookmark List Ctrl + Shift + B Clear the bookmark list. 

Bookmarks Save as Navigation List Ctrl + N Assign the bookmark list to 

the Navigation List. 

    

Edit Quick Add to Inventory Ctrl + I Add to your inventory. 

Edit Remove from Inventory Ctrl + Shift + I Remove from your inventory. 

Edit Grade Quick Edit Ctrl + G Quick edit for inventoried 

grades. 

Edit Priority Want List Edit Ctrl + F1 Quick edit for PWL data. 

Edit Priority Sell List Edit Ctrl + F2 Quick edit for PSL data. 

Edit Purchase History Edit Ctrl + F3 Quick edit for purchase 

history. 

Edit Sell History Edit Ctrl + F4 Quick edit for sell history. 

Edit Lock Pricing Ctrl + L Lock pricing on coins. 

Edit Unlock Pricing Ctrl + U Unlock the locked pricing. 
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Menu Item Shortcut Description 

    

Summary Supplied Data Alt + F1 View/edit pre-supplied data 

fields. 

Summary Your Data Alt + F2 View/edit your data fields. 

Summary Custom Fields Alt + F3 View/edit custom data fields. 

Summary Special Information Alt + F4 View notes and special 

information. 

Summary Images Alt + F5 Run the image links editor. 

Summary Comments Alt + F6 View/edit comments for the 

coin record. 

Summary Shows Differences from Supplied Alt + F7 Toggle pre-supplied color 

differences on the data grid. 

    

Rapid Entry Rapid Inventory  Perform Rapid Multi Entry of 

all selected or bookmarked 

records and add to your 

inventory. 

Rapid Entry Priority Want List  Perform rapid entry for 

selected/marked coins to the 

Priority Want List. 

Rapid Entry Priority Sell List  Perform rapid entry for 

selected/marked coins to the 

Priority Sell List. 

    

View Sort Ascending Order Ctrl + 1 Sort the report on the 

selected column. 

View Sort Descending Order Ctrl + 2 Sort the report on the 

selected column. 

View Reset Sort Order Ctrl + 3 Restore the original sort 

order. 

View Hide Selected Columns Ctrl + H Hide all selected columns. 

View Auto Hide Empty Columns Ctrl + Alt + H Hide any columns which have 

no data in them. 

View Unhide All Columns Ctrl + Shift + H Show all columns which were 

hidden. 

View Remove Rows Ctrl + R Remove rows from the 

report. Note: this doesn't 

remove coin records from 

your country file. 

View eLook™ Search Ctrl + E Perform an eLook™ search. 

View Find Ctrl + F Perform a text search on the 

data grid. 
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Menu Item Shortcut Description 

View Find Next F3 Find the next occurrence of 

the search text. 

View Find Previous Shift + F3 Find the previous occurrence 

of the search text. 

View Clear Find Ctrl + Shift + F3 Reset the text search. 

View Reset Column Widths Ctrl + W Restore all report column 

widths to default values. 

    

Help Report Viewer Context Help F1 Context sensitive help for the 

viewer. 

Help EzCoin General Preferences F2 Show the EzCoin general 

preferences dialog window. 

Help View Report Title Ctrl + T Show all the input conditions 

for the search data which 

generated the report results 

which can't fit within the 

window's title bar. 

 

Options Menu 

Navigation List (F7), Coin List (F8) and Thumbnail Viewer (F6) 

You can assign the entire report to one of the alternate report view methods using 

the options available under Options. When you assign the report, the viewer will 

close. If thumbnail view mode or coin list modes are chosen, the corresponding 

window will be displayed with the report data. For navigation list assignment, any 

current list will be discarded and replaced with the report data. 

If you want to assign a subset of the report, create a bookmark list, and only the 

bookmarked coin records will be assigned. 

Printing Reports (Ctrl + P) 

EzCoin will use the printer settings in the current report profile (RPT) file assigned. 

The standard printer settings for most report profiles are as follows: 

 Landscape orientation. 

 The current default printer defined in your version of Windows. 

 The current default paper size and print quality for this printer. 

 Half-inch margins on the left and right, with 1 inch margins top and bottom. 

 Arial font varying between 8 and 10 points. 

 Multi-page format, with Denomination and Year columns repeating on each 

page across. 
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 No alternate color banding on data rows – the report is plain black text on a 

white background. 

EzCoin has a general preferences option to enforce the following global settings, 

which will override all report profile settings. These options are available in the 

Printer Setup tab. 

 Printer to send the report to. 

 Paper size. 

 Orientation. 

 Margins. 

 Column width auto-sizing. 

 Column width fill mode for fit-to-page reports. 

Use the print icon, or choose Print from the Options menu option to begin. The 

standard Windows printer settings dialog will appear, allowing you to choose the 

printer, page range, and number of copies.  

EzCoin does not pre-calculate the pages as the choice of printer and any changes 

made to Properties within the printer setup dialog window can result in different 

page totals. In addition, collating copies is not allowed in EzCoin. If you specify 3 

copies, then each copy will be printed in turn before the next copy. 

EzCoin will send the report using whatever color settings you define in the report 

profile, provided that the printer you chose supports color output. 

EzCoin relies on the Windows spooler to accumulate the report data and print it in 

the background. Until all the pages are sent to Windows to print, you will not be 

able to perform other tasks in EzCoin. A progress dialog will appear to indicate the 

printing status. You can click on the Cancel button to stop printing at any time. 

Reports can be printed in one of 3 formats:  

 Multi-page: The columns of the report span multiple pages wide. 

 Staggered: The report is one page wide, and columns wrap to multiple rows. 

 Fit-to-Page: The report columns must fit into one page width. 

Note: There is a 4th report type, On-Screen Only, which disables all printing 

attributes and can only be used for the report viewer without printing. 

Fit-to-Page reports must not contain too many columns of data, or the scaling 

needed to fit the report onto a single page width will be too great to be printed with 

a readable font size. If this happens, you will be informed that the report can’t fit 

the page width. You can either adjust font sizes, paper width, remove/hide 

columns, or change to a multi-page format. 
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Reports and Images 

The default report profiles do not contain any image fields. However, image fields 

can be attached to any custom report and displayed in both on screen and printed 

reports. Preference options determine what the image size will be on screen (pixel 

dimensions) and what it will be on printed reports (width and height in inches). The 

quality of the images displayed and printed can also be adjusted. 

Changing the Profile (F10) 

Every search and report item in EzCoin has a default report profile file (RPT) 

associated with it. These profiles can be changed from within the drop down list 

which appears in the input condition window. Since a profile represents the display 

characteristics and field list for reports and the data itself is independent of this 

profile, EzCoin allows you to swap out profiles on the fly using the Change Report 

Profile option. 

 

Select a new profile from the drop down list and click OK. The Edit button can be 

used to run the custom report editor. 

Profile switches don’t affect the default profile associated with any menu option 

under the main EzCoin Search or Reports menus – i.e., if Default Coin Information 

was the profile used to run the report, it will remain so even after switching profiles 

within the viewer. 

Profile Settings (Widths and Hidden Columns) 

The report viewer bases the default widths for columns on the master field 

definitions shared among all report types in EzCoin. These field definitions can be 

edited using one of the Field Editor options under the Utility menu. There is a width 

setting for displayed information and a width setting for printed reports.  

Since the displayed reports have no physical limitation on the total width available 

to show a report (printed pages can’t have scroll bars) the default width may not 

always show the full information and the field will be cropped on the right. 
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You can adjust this by double clicking the divider in the header caption row 

between two fields or simply click and drag the divider area to make the column 

larger or smaller. 

EzCoin will remember the width of a column even after you close the viewer window 

and use it for the next time you run the report. The widths are saved on a per 

report basis, meaning that you can use a different width for Denomination on 

different reports. The settings are saved under the Profiles\Settings folder in the 

EzCoin application path. 

You can also choose to hide columns from the report by using the Hide/Show 

buttons in the toolbar. Hidden columns will not appear in the data grid and will not 

be printed. The data is still present in the report – you can bring the fields back into 

view by clicking the icon to reshow all hidden columns. As with the column widths, 

the hidden status of the columns are also preserved when you close the viewer 

window. 

Image Preview Pane (F12) 

This option will toggle the image preview pane which appears to the left of the main 

data grid. Images will only appear if you have selected exactly one coin record. 

You can resize the image pane by dragging the divider bar between the left side of 

the data grid and the right side of the image window. The new width will be saved 

after the report viewer window is closed. 

Comments Preview Pane (Ctrl + F12) 

This option will toggle the comments preview pane which appears below the data 

grid. Comments will only appear if you have selected exactly one coin record and 

the record contains comments. By default a Comments report will show this pane 

when the viewer starts. For all other report types, the initial visibility is based on if 

the images were displayed at the time you closed the viewer window. 

Comments fields in the main data grid can only show a limited amount of text 

information. The remainder can be displayed using either the comments pane or 

the Comments option under the Summary menu. The latter choice provides full 

editing capability. 

You can resize the height of the comments pane by dragging the divider bar 

between the bottom of the data grid and the top of the comments window. This 

height will be saved when you close the viewer window. 

Creating Snapshot Files (Ctrl + S) 

A snapshot file is a read-only capture of the report data grid. This file can be 

exchanged with other EzCoin users or recalled at any time to view the contents of 

the report. 
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When you create a snapshot, you will be asked for the name of the file and a 

description. Once entered the file will be saved to the Snapshots folder where 

EzCoin is installed. 

To view a snapshot file, use the Snapshot Viewer under the Extras menu, or the 

standalone Snapshot Viewer application, available from the SoftPro Web site. 

Report Merges 

EzCoin provides powerful searching capabilities to drill down into the data for a 

country file. However, you may want to combine the search results from different 

reports to make unique “hybrid” report types.  

Report merging doesn’t involve the fields displayed in the report viewer, but rather 

the underlying set of coin records which populate the data grid. When merging 

reports, the coin record data is combined together to generate a new set of coin 

records and will be displayed using the profile of the current report in the viewer. 

You can for example, combine a Power Search and Grades Search into a single 

Power Grades Data Search. 

The first step in merging reports is to create an export of a report to combine with 

a second report. There is no limit to the number of combines you want to make. 

However, you have to export each previous report to combine with one which 

follows. If you want to use the results of a power search to filter the results of a 

Grade Search report, then you would perform the following steps: 

 Run a Power Search and display in the report viewer. 

 Choose Export this Report from the Report Merge submenu. 

 Run a Grade Search report and display it in the report viewer. 

 Choose one of the merge options under the Report Merge submenu. 

Add Coin records are combined to make a new report with the unique 

records from each individual report. Duplicate entries are not created.  

Subtract Subtracts all coin records from the current report which match on the 

same key fields (denomination, year, type/reign, variety and mint 

mark) from the previous report. 

Combine Takes all coin records from the previous and current reports and 

discards any records which are not common to BOTH reports. 

Report Viewer Image Cache (Ctrl + Shift + C) 

If Image Caching is enabled in the EzCoin general preferences, then small 

thumbnail images of the coin records are cached to files for faster navigation of the 

report. Image caches are only used for reports where the field profile contains one 

or more coin image links. 



EzCoin Reference – Version 2.0 

Page | 249 
 

A general preference option allows EzCoin to auto-clear the cache when the 

application is closed down. If this option is disabled, then the cache files will remain 

within the EzCoin installation path until they are cleared. 

The preferences window provides a Clear Cache option. The report viewer has a 

similar option to perform the same task. You should consider clearing the cache if 

you change the cell size for images in the report viewer, as the cached images will 

be scaled to the previous cell size before you changed it to a new size. 

 

Bookmarks Menu 

Creating Bookmarks (Ctrl + B) 

Bookmarks are used to tag specific coin records in the viewer. The record # column 

on the left side of the data grid will be highlighted (default color is red) to show 

which records are bookmarked. There are many options in the report viewer which 

make use of selections and bookmarks according to the table below. 

Viewer Option Selected Records Bookmarked Records 

eLook™ Yes  

Quick Inventory Yes Yes 

Remove from Inventory Yes Yes 

Pricing Lock Yes Yes 

Pricing Unlock Yes Yes 

Rapid PWL Entry Yes Yes 

Rapid PSL Entry Yes Yes 

Add to Bookmarks Yes  

Remove from Bookmarks Yes  

Save Navigation List  Yes 

Hide Report Rows Yes Yes 

Creating a Snapshot  Yes 

Assign to Coin List  Yes 

Show as Thumbnails  Yes 

 

To add to the current bookmark list choose the Add Selection option under the 

Bookmarks menu. You can also click on the add bookmark icon. Right clicking this 
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icon will add all records to the bookmark list, as will right clicking on the clear 

bookmarks icon. 

When creating selections in the viewer, hold down the SHIFT key to select ranges of 

records. Hold down the CTRL key to select individual records without affecting the 

current selection. 

Removing Bookmarks (Ctrl + Del) 

Use the Remove or Clear options to remove selected records or all records from 

the bookmark list. The Invert option can be used to mark all records which are not 

bookmarked and unmark all records which are bookmarked. 

Saving to a Navigation List (Ctrl + N) 

The Assign option in the Options menu will apply the bookmark list to the main 

Navigation List in EzCoin, replacing the current active list, if present. The Save 

option under the Bookmarks menu however will allow you to save the list to a file of 

your choosing. Provide a description and file name, and this will be saved to the 

Lists folder in the EzCoin application path, under a subfolder with the name of the 

current country file. 

Saving to a Coin List (F8) 

This option will transfer the marked records to the Coin List viewer. This is a 

convenient way to keep the report results available for reference while working 

within the main EzCoin Window. 

 

Edit Menu 

The following options are available from the Edit menu of the Report Viewer 

window. 

Quick Add to Inventory (Ctrl + I) 

Selected/bookmarked records will be added to your inventory. This is the same as 

selecting each record in the main EzCoin window and clicking the blue check mark 

icon to save to inventory. If the record is already inventoried, no action will be 

taken. 

Remove from Inventory (Ctrl + Shift + I) 

Selected/bookmarked records will be removed from your inventory. Note: If you 

remove a custom variety, or the country file is custom without pre-supplied values, 

the records will be permanently deleted and not recoverable. If the record has pre-

supplied data, removing it from your inventory will reset the record back to a pre-

supplied state. 
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Quick Edit Options for Coin Information 

Each of the quick edit options shown in the table below will present you with a 

spreadsheet editor, much like the report viewer itself. This is the same editor you 

will see when using the quick edit options from the main EzCoin menu. When you 

save changes from the editor, the report view will update automatically to account 

for these changes. 

Quick Editor Shortcut Description 

Grades Quick Edit Ctrl + G Edit inventoried grades. 

PWL Quick Edit Ctrl + F1 Edit the priority want list. 

PSL Quick Edit Ctrl + F2 Edit the priority sell list. 

Purchase History 

Quick Edit 

Ctrl + F3 Edit the purchase history. 

Sell History Quick 

Edit 

Ctrl + F4 Edit the sell history. 

 

Price Locking (Ctrl + L) and Unlocking (Ctrl + U) 

You can lock pricing from being overwritten by EzCoin supplied data updates 

directly from the report viewer, using either the current record selection in the 

viewer or the active bookmark list. Once a record is price locked the padlock icon 

will appear in the status bar. Use the unlock option to remove the lock status. 

 

View Menu 

Sorting the Report Data (Ctrl +1, Ctrl +2, Ctrl + 3) 

Most report columns can be sorted in the viewer when using the Spreadsheet (full 

edit capable) view mode. The Data Browse (read only) view mode allows for rapid 

sorting on any column.  

Columns which can’t be sorted on include any belonging to data groups (PWL/PSL 

lists, purchase and sell history). For these latter field types, the sort order is 

dictated by settings in the report profile and can’t be changed on the fly when 

clicking the column headers in the report viewer data grid. 

To sort on a specific column in the data grid, select any cell in that column and click 

on the sort icon. A single click will sort ascending order, and a second click will sort 

in descending order. Ctrl +Click the icon to reset the sort order to the default report 

profile order (which is generally by Denomination or Year in pre-supplied profiles). 
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You can also click on any column’s header label at the top of the data grid without 

selecting any columns to sort. Use the Ctrl + 2 shortcut key to quickly set a 

descending sort order without the need to click icons or headers 2 times. 

Hiding Columns (Ctrl + H) 

The report viewer allows you to remove columns from the data grid, hiding them 

from both the on-screen display and also from printed reports. The data is still 

present in the report, it’s just not visible. Select one or more columns in the data 

grid and click on the hide columns icon. 

Un-hiding Columns (Ctrl + Shift + H) 

Use this option to restore all hidden columns to the data grid. This affects the 

current report profile only. Hidden status is tied to the actual RPT files containing 

the profile settings, not to the report or search options in the main EzCoin menu. 

Removing Rows (Ctrl + R) 

This option can be used to create a smaller report data grid without exiting the 

viewer. Row removal does NOT remove records from your inventory or the country 

file. It simply discards them in the data grid of the report. Unlike hiding columns of 

data, the rows can’t be recovered in the report once removed – you would have to 

re-run the same report to get those rows back. 

eLook™ Search (Ctrl + E) 

This option is the same as the one accessible from the main EzCoin menu. 

However, you can select up to 10 coin records at one time, and this will be passed 

to the eLook™ dialog window as a coin group to search on. 

Finding Data (Ctrl + F, F3, Shift + F3, Ctrl + Shift + F) 

The find option is a simple text string matching feature allowing you to search 

across all rows and columns in the data grid for any coin attribute which matches 

on the text. The match is always a partial text match; if the text value of a coin 

attribute contains the text string you entered for the find, then the match is 

satisfied. 
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Check the Case-sensitive option to force upper and lower case letters to match 

exactly. 

Check the Selected Columns option to restrict the search to data contained only in 

those columns. 

Use the 4 special character buttons to enter those characters into the text value 

string at the current cursor position. 

Click on Clear Find to remove any existing find status in the report viewer window. 

If you don’t enter any text value and click OK, then the find status is also cleared. 

Once you start a search, the data grid will be checked to find cells containing your 

search text. Every matching cell will be highlighted (default color yellow) to indicate 

a match status. In addition, the record # tab on the left (default color blue) will 

indicate at least one matching cell for that row in the data grid. The viewer will 

automatically scroll the grid to the first matching cell. 

Use the Find Next and Find Previous options to step forwards and backwards 

through all matching cells in the data grid. Once again, the grid will automatically 

scroll to keep the matching cell in view. 

The Find button in the toolbar provides all the functionality of the separate menu 

options: 

 Click to start a new find. 

 SHIFT + Click to clear the find status. 

 Right Click to step forwards. 

 CTRL + Right Click to step backwards. 

Resetting Column Widths (Ctrl + W) 

Each report profile (RPT file stored under the Profiles folder in the EzCoin 

application path) can have an associated Settings file stored in the Profiles\Settings 

subfolder. When using report profiles for the first time, there will be no settings file 

in this subfolder. As you run reports in EzCoin, these settings files are created or 

updated when the report viewer window closes. 

The settings file only contains 2 types of information: 

 The hidden column status of the data grid. 

 The width of each field displayed on screen in the data grid. 

When a report profile is first used against any type of search or report, the viewer 

will assign a default column width to each field shown in the data grid, based on 

settings in the Master Report Fields configuration (you can alter the default field 

settings using the Field Editors in the Utilities menu). 
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You can drag the divider bars between the data grid’s column headers to resize 

columns on the report. The widths will be saved to the settings file when you close 

the viewer.  

If for any reason you need to force a report profile back to default widths, choose 

the reset option under the View menu. Deleting the RST file from the Settings 

folder will accomplish the same thing. 

 

Summary Menu 

Supplied Data (Alt + F1) 

This option displays a window which shows you differences between pre-supplied 

field data and the current inventoried data for a selected coin record. If the country 

file is custom, or the record itself is a custom variety with no pre-supplied data, the 

dialog window will show only one set of coin attributes instead of two. 

 



EzCoin Reference – Version 2.0 

Page | 255 
 

The top section shows the current value of pre-supplied fields. The bottom section 

is the original pre-supplied data. EzCoin maintains a read-only copy of pre-supplied 

fields which can’t be altered. You are free to override any of them in your copy of 

the coin record. If a value is different, you will see the field displayed with an 

alternate background color, as in the Thickness field above. 

You can restore one or more pre-supplied fields to their original values by clicking 

inside a field’s text box and clicking on the Restore Current button, the field label 

to the left of the text box, or by pressing F5. 

You can restore the entire collection of field values by clicking the Restore All 

button. 

Your Data (Alt + F2) 

This option shows all of the basic coin details which are not part of the pre-supplied 

data. 

 

This includes the 4 alternate catalog ID values, location, serial number, comments, 

and pricing lock status. 

If the coin record is custom variety, then the Main Number Variety checkbox will be 

enabled, allowing you to switch the record between main and sub-variety status. 
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Custom Fields (Alt + F3) 

This option shows a window containing all of the custom fields you attached to the 

country file. If you have no custom fields created, this option will be disabled. 

Special Information (Alt + F4) 

This option is identical the one in the main EzCoin window. If the special 

information icon is enabled in the report viewer toolbar, you can view special pre-

supplied notes and coin specifications for the Scott number. 

Images (Alt + F5) 

This option will show the Image Links editor. 

Comments (Alt + F6) 

This option displays a sizeable comments dialog window, which can be used to view 

and edit your comments attached to the coin record. 

Show/Hide Differences from Supplied (Alt + F7) 

This menu option toggles special cell coloring on the data grid to indicate which pre-

supplied fields have data values which are different in the inventoried data 

compared to what has been supplied by SoftPro. 

Rapid Entry Menu 

The following options are available from the Rapid Entry menu of the Report 

Viewer window. Rapid entry options allow you to perform bulk updates of selected 

(or bookmarked) coin records in the report viewer for inventoried coins, priority 

want/sell lists, and purchase/sell history. 

Rapid Multi Entry for Quick Inventory (RME) 

This option will add selected or bookmarked records to your inventory. Even if 

records are already in your inventory, they can still be updated using the RME 

option. 
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The left side of this window contains the available grades for the current country file 

with an associated quantity field for each grade. If you check a grade, the quantity 

will be set to 1 for you. 

Use the Grades button to check multiple grades using the standard grade group 

selection window. 

The User Fields button will display a window allowing you to add custom field 

values to the selected/bookmarked records in the report viewer. 

The Previous button will recall the RME settings from the previous run of rapid 

entry you performed. 

The Clear button will uncheck all grades in the grade list. Clear All will erase the 

contents of all fields in the RME window. 

The checkbox option named Bullion Value is used to add grades as bullion values, 

ignoring the market value when determining the coin grade's net value. The 

checkbox option next to this will control if the bullion value is assigned based on the 

market value for the grade. If this option is checked, then the grade will be 

inventoried based on market value if it exceeds the bullion value. 

The drop down list at the top determines how any selected/bookmarked records 

which are already inventoried will be affected by the RME operation. 

Do Not Inventoried records will not be updated by the RME. 
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Update 

Replace Replace grade and data information for existing inventoried records. 

Add Any grades which are already inventoried will be added to whatever 

grades are being applied from the RME operation to create net sum 

totals on those grades. 

 

Click the Inventory button to start the Rapid Multi Entry process. When completed, 

the affected records will automatically be updated in the report viewer. 

Rapid PWL and PSL Options 

The rapid entry modes for the priority want and sell lists are used to quickly add (or 

remove) records based on the current selection or bookmark list in the report 

viewer. As these entry dialog windows are basically the same presentation format, 

the PWL dialog window will be used as a reference. 

 

The choices you make in this dialog will be applied to all selected (or bookmarked) 

coin records in the data grid. You can specify the quantity and type to buy (or sell). 

There is no requirement to enter a type or check off a grade. In this case, the coin 

record is entered into the list as a generic status of “any grade, no type specified”. 

Use the Grade Select button to select grades from the pre-defined grade group 

lists. Click on No Grades to uncheck all grades in the checkbox list. 
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The 4 buttons above the grade buttons provide the choices on how to update the 

PWL or PSL. 

Add to PWL Add the grades selected to the existing PWL/PSL grades 

currently in the list under the coin record’s Scott/Alternate 

catalog ID number. If no grades are selected, the record will 

be added to the PWL/PSL if not already present. 

Replace Grades Remove any grades from the PWL/PSL on the coin record 

which are NOT selected in the checkbox list and add any 

grades which ARE in the checkbox list. If the coin record is not 

currently in the PWL/PSL, it will be added. 

Remove Grades Remove only selected grades in the checkbox list without 

removing other grades currently in the PWL/PSL. This option 

will NOT remove the coin record from the PWL/PSL unless all 

grades have been removed for the coin. 

Remove PWL Remove the coin record from the PWL/PSL and any grades 

which may be present for this record (complete removal). 

 

Rapid Entry for Purchase and Sell History 

The rapid entry modes for the purchase and sell history provide for a quick method 

to perform a bulk update for multiple coin records and grades. 

You must select or bookmark the coin records you wish to update. The below 

example dialog is for the sell history rapid entry. 
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The choices you make in this dialog will be applied to all selected (or bookmarked) 

coin records in the data grid. You can specify any of the history record attributes. 

The only mandatory fields which require a value are Quantity (must be at least 1) 

and price (can't be empty, but can be zero). It's recommended you supply a date, 

but this isn't required. If no grades are selected, the history record will be tied to 

the coin variety only without association to a specific grade. 

Use the Grade Select button to select grades from the pre-defined grade group 

lists. Click on No Grades to uncheck all grades in the checkbox list. 

The 4 buttons at the bottom provide the choices on how to update the history, 

similar to the options provided for the PWL/PSL rapid entry dialog. 

Add to History Add the grades selected to the existing history. If no grades 

are selected, the coin variety will be added to the history if not 

already present. 

Replace Grades Remove any grades from the existing history on the coin 

record which are NOT selected in the checkbox list and add 

any grades which ARE in the checkbox list. If the coin record is 

not currently in the history, it will be added. 

Remove Grades Remove only selected grades in the checkbox list without 

removing other grades currently in the history. This option will 

NOT remove the coin record from the history unless all grades 
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have been removed from the history for the coin. 

Remove History Remove the coin record from the history and any grades which 

may be present for this record (complete removal). 

 

Help Menu 

Topic Help (F1) 

This option provides context-sensitive help for the report viewer. 

Preferences (F2) 

This option provides access to the EzCoin general preferences window. 

View Report Title (Ctrl + T) 

The title bar of the report viewer will attempt to show all of the input conditions 

which were used to generate the data for the report. For complex searches with 

many input conditions, the information will not fit the title bar. You can use this 

option to show a popup window with all of the search input values listed. 

Other Report Viewer Features 

Right click on the data grid for a popup menu with many of the choices from the 

primary viewer menu. 

If you add images to a field list for a custom profile, you can click the image cell to 

highlight it, then hold down SHIFT and click again to popup an image preview 

window. 

If you hold down SHIFT while clicking in a selected comments field cell, it will bring 

up the comments viewer/editor window. 

Double click any cell in a coin record to show the associated record in the main 

EzCoin window. 
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Report Editor and Custom Profiles 

Reports and Profiles Overview 

Searches and reports in EzCoin rely on a profile of settings which contain the basic 

information for a report to be displayed and/or sent to the printer: 

Style The presentation style for a report, such as fit-to-page or multi-page 

print formats. 

Filters Settings which alter how data is presented in both the report viewer 

data grid and on the printed page. 

Fields The set of columns which make up the report. Fields can be single 

values, value pairs, or groups of related subfields. 

Ordering The primary sort order for the report and secondary sort order for 

field data groups. 

Printer 

Settings 

A set of basic printing attributes (paper size, orientation, margins, 

etc.). 

Titles & 

Subtitles 

The header and footer areas of each printed page contain margins, 

into which the titles and subtitles will be printed. There are up to 6 

title areas and 6 subtitle areas for a given report. 

Print 

Attributes 

Options which specifically affect the printed pages only and have no 

effect on displayed coin records in the report viewer.  

Fonts & 

Colors 

Every area of a printed page (headers, footers, grid headers, total 

lines and data cells) have an associated font and text color which you 

can change. 

Background 

Colors 

For cells contained within the data grids which are printed, special 

background colors can be added for easier readability. 

 

All of this information is self-contained into a single file called a Report Profile, 

which has an extension of .RPT and can be found in the EzCoin installation path 

under the Profiles folder. Profiles have automatic backup capabilities to allow for 

one level of Undo if you are not happy with your customizations and wish to change 

back to the previous settings.  

Profiles are also divided among the primary files for general searches and reports, 

plus a small set for Grand Totals reports. Although they share a common RPT file 

extension and use the same editor to make changes to the profile settings, they are 

not compatible with each other, and as such are stored in separate folders within 

EzCoin. 
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Profiles are further divided into Pre-Supplied and Custom file types. There are a few 

key differences between them, and they are separated into their own folders to 

avoid mixing your custom profiles with ones supplied by SoftPro. 

 Supplied profiles can’t have their field lists modified – you will not be able to 

add, remove, or reorder the fields for these profiles. If you need to alter a 

field list for a supplied profile, you will need to make a copy and save it as a 

custom profile. 

 Supplied profiles are defined for each search and report menu item within the 

main EzCoin Search and Reports menus. Many of these profiles are 

specifically prefixed with the text of “Default” to denote a pre-supplied stock 

profile. You will not be able to rename the RPT files or the description text. 

 The backup copies of supplied profiles are read only, and can’t be modified. 

This is to ensure that if you have any issues with a supplied profile, you can 

easily restore from the pre-supplied backup copy. 

 Supplied profiles are segregated from custom profiles in the editor, using a 

pair of drop down lists. 

 Custom profiles are the only ones allowed for profile switching in any search 

or report window where a profile swap is allowed. A pre-supplied profile can 

only be used for the corresponding search/report menu item where it has 

specifically been assigned to work from. 

 Custom profiles can have fields assigned to them which only exist for a 

specific country file (i.e. you have created a custom field and assigned it to 

the field list of a custom report). For these types of profiles, they will not be 

useable if they are attached to any search or report for another country file 

which doesn’t have that field defined – an error will be displayed when you 

attempt to run the report stating that the field can’t be found in the country 

file. 

 

  



EzCoin Reference – Version 2.0 

Page | 264 
 

Using the Report Editor 

There are 3 menu options under Reports for running the editor. The Grand Totals 

Profile editor is available all the time and is divided into profiles for horizontal and 

vertical data layouts. 

The standard Report Profile Editor is only available when a country file is open. This 

is due to the fact that field lists requires an active country file to be able to access 

any custom fields attached to the profile. 

The editor window is organized exactly as described in the overview section, broken 

into several tabs.  

 

Before working with a report profile, you will need to choose one from either the 

Supplied Profile or Custom Profile drop down lists. If you don’t choose a profile in 

either list, you will be editing an undefined blank template filled with default profile 

settings. If you attempt to save such a profile, you will be asked to provide a name 

and description for it before the save can occur. 

Report Editor Attributes 

Each tab in the editor will be shown with an associate summary table below it to 

describe the various options assigned to the tab. The title bar of the editor will 

always show the file name and description for the current profile selected. 
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General Setup 

 

 

Supplied 

Profile 

This list will contain all of the pre-supplied report profiles which are 

assigned to the items under the Search and Reports menus. 

Custom 

Profile 

This list will contain all custom report profiles, which you have 

created and which may also be supplied by SoftPro.  

Report 

Style 

There are 4 choices for the report style: 

Screen Only The report can only be used for the report viewer 
window. This option should only be chosen to 
create ad-hoc custom profiles which don’t require 

all of the printer settings to be configured, as the 
report can’t be sent to the printer. When you 

choose this type, all tabs except the first 2 in the 
editor window will disappear. 

Fit to Page This type of report will attempt to fill the page 
width with all of the fields in the field list. If the 

fields will not fit onto the width of a single page of 
paper, you will not be able to print the report. 

Multi Page This is the default type for pre-supplied profiles 
which ensures that the report can be printed by 

spanning the fields across multiple pages. 
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Staggered The staggered report is useful for creating 
condensed reports which make maximum use of 

the available area on each printed page. This is 
useful for saving paper for very large reports. The 

fields in the coin record are staggered left to right 
then top down within a single page width, creating 
a row-column block of cells per coin record. 

 

Column 

Repeats 

The leftmost fields in the field list can be replicated onto each page 

which spans all the pages of a multi-page format report. The default 

value of zero means no fields will replicate across pages (unless 

Denomination/year field repetition is used, see below). If you put a 

value of 3 in this setting for example, then the first 3 fields in the 

field list will appear on each page which spans the width of the 

report. 

Header 

Rotation 

For reports with fields which contain many narrow fields (such as 

grade price or quantity details), the header labels can be significantly 

wider than the data values in the grid. This can result in wasted 

paper and the chance that a report defined as fit-to-page won’t fit 

the paper width. Header rotation can print the label text at 90 

degree angles to the page orientation, allowing for a more 

condensed report, at the expense of some vertical paper space to 

contain the header area of the grid. 

Justification The data grid can be justified to align to the left margin, center 

within the margins, or fill the paper width. For the last option, the 

grid cells will proportionally be resized to ensure that the grid will 

have its edges flush with the left and right margins. 

Rotation 

Alignment 

When using 90 or 270 degree header rotation, you can choose if the 

vertical alignment of the text is flush with the top or bottom of the 

cell containing the header label. 

Data Group 

Repeat 

The three choices here determine how the field list is replicated 

across the pages of a multi-page report. If the Denomination/Year 

choice is used, then these fields appear on each page, even if the 

column repeat option is set to 0. For the Repeat on Regular fields 

option, the column repeat value defines how many of the leftmost 

fields in the field list will appear on each page. This value is not 

applicable for staggered or fit-to-page reports. 

Comments 

Span Page 

Width 

The comments field can contain up to 4,000 characters of data. As 

such, how this field is presented in a report can determine how many 

pages of paper are needed to print it. By using the spanning option, 

the comments will appear below all other fields in the grid, as a 

single cell of data, exactly the width of the page, and as tall as 
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needed to show all the text. 

 

You should NOT enable this option for any report profile which has 

the comments field in the field list, or you will be showing the same 

information twice. 

Yes/No 

Text Values 

EzCoin is currently provided as an English-only distribution. 

However, all of the text which appears on the printed report can be 

customized by editing the Master Fields configuration to suit any 

language. Since there are fields defined in the this list which are 

classified as Yes/No data types, you can choose to use other text 

values in place of the default “Yes” and “No” strings. 

Header 

Long Name 

Format 

Check this option to print header labels using the long format text. If 

you want to conserve paper, use the short formats of the labels. 

Both the long and short names can be customized in the Master 

Fields configuration. 

Hiding “No” 

Values 

Check this option to suppress the “No” text for Yes/No field types on 

the report. 

Suppress 

Zero Values 

Check this option to suppress currency and quantity fields on the 

report if they have no value assigned to them (i.e. $0.00 and 0). 

Quantity & 

Value 

Masks 

For fields containing quantity and price values, you can set a default 

“mask”, which is simply an arbitrary string of characters which are 

used to set the column width on the report. Despite the fact that the 

default values are sets of “9”s, you can use letters, digits or 

punctuation in any combination. 
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Report Fields  

 

This tab doesn’t really provide field editing capabilities, but rather a summary of 

what fields are assigned to the report. To edit the field list, click on the Report 

Fields button to run the field profile editor. The Total Fields label indicates primary 

field totals only. Any primary field which is based on a data group with subfields can 

in turn contain many additional report fields. 

Data Group Sort Order 

Any profile where you have assigned one of the 3 types of data groups (fields which 

contain multiple subfields) for Grades, Purchase History, or Sell History can be 

assigned a secondary sort order, independent of the primary field sort order for the 

report. Note that PWL/PSL data groups have a preset sort order which can't be 

changed. 

Clicking any of the 3 "Sort" buttons will bring up the sort options window as shown 

below. 
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The drop down list will contain the field which will act as the secondary sort for all 

the rows of data within the report.  

The sort will be applied even if the field itself is not part of the report profile. 

Click on the Reset button to apply the default sort order for the data group. 

Field Profile Editor 

The field profile editor is available from the EzCoin Report Profile editor utility. You 

will find it on the Fields tab in the editor window. 

 

Click the Report Fields button to run the field profile editor. 
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The editor window is organized into the following sections: 

 A menu bar across the top contains all editor options. 

 The toolbar contains short cut icons for frequently used editing options. 

 The left side list contains the available report fields which can be assigned to 

the profile. 

 The right side list contains the current fields assigned to the report. As you 

add more fields, the left side list will shrink and the right side list will grow. 

 The small scrolling grid at the bottom is the current field list preview pane. It 

provides a visual cue of the complete set of primary and subfields which will 

be part of the report. 

 The status bar at the bottom is used to display help hint messages. 

Toolbar Options 
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1 Use the left arrow to remove fields from the report (move from the right 

list to the left). 

NOTE: As a shortcut, you can simply right click the selected fields in either 

list to move them to the opposite list. You can also double-click individual 

fields to assign or remove them. 

2 Use the right arrow to assign fields to the report (move from the left list to 

the right). 

3 Undo all field edit changes since you started the editor. 

4 Erase all fields in the report. You will not be able to remove the 

Denomination or Year issued. 

5 The up arrow moves selected fields in the assigned (right) list upwards. 

Hold down the Ctrl key while clicking to shift all selected fields to the top of 

the list. The top-down ordering of fields in the editor is the actual left-to-

right ordering on displayed and printed reports. 

6 The down arrow moves selected fields in the assign list down one position. 

7 Click this button to change the primary report sort order. 

8 This button saves all changes to the field list. This does NOT save the 

report profile changes (The field list is only one part of the overall profile). 

You must click Save from the report editor window to save changes to the 

report file. 

9 Click this button to cancel all changes made to the field list. 

A Export the field list to a file which can be recalled at any time. 

B Use this button to import a field list which was exported. 

C Access the grade values and quantities configuration for any report profile 

which uses the Grades/Values Quantity List field item. 

D Access the field configuration for the grades data group. 

 

Items D to H use the vertical format of data presentation in reports, where 

each grade in the associated data type is shown as one row in the report. 

E Access the field configuration for the purchase history data group. 

F Access the field configuration for the sell history data group. 

G Access the field configuration for the priority want list. 

H Access the field configuration for the priority sell list. 
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Exporting and Importing Field Lists 

Use the export option to save the field list configuration to a file. The files are saved 

with an extension of .RFST. You can import a field list into another report profile, 

provided that any custom fields in the list are also present in the current country 

file. The editor will also reject an import file if it references a custom grade 

definition not defined in the current country. 

Setting the Field Preview Format 

Use the Field Preview option (Ctrl + N) in the Edit menu to change the way the 

preview pane at the bottom displays the field configuration. Short names will 

substitute the shorter labels for the fields and swap the field sample text with field 

position numbers. 

Setting a Primary Sort Order 

Choose this option from the Edit menu to bring up the field sort dialog window. 

 

 

You can sort the report data using up to 5 fields, each of which can be in ascending 

(A to Z) or descending (Z to A) order. Check option for Z to A on each field to 

reverse the sort order. 

The sort field is limited to a specific set of primary coin attributes and can be 

extended to use custom fields which you can attach to the coin record. You can’t 
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choose attributes which are considered secondary data within EzCoin (Priority Want 

and Sell Lists, purchase/sell history, and inventoried grades). 

The 2 default buttons are used to set a standard sort order based on the 5 primary 

coin fields. 

Field Data Groups 

There are 6 data groups which can be assigned to a report profile field list. You can 

assign one or more of these groups to the report, after which you should configure 

how the subfields are organized for the group. 

Five of these groups are defined under the Data Groups menu. These groups always 

show their data vertically in the report: 

 Grades 

 PWL Data 

 PSL Data 

 Purchase History 

 Sell History 

You will find the data group fields at the very bottom of the available field list, 

below any custom fields which will appear below the regular coin fields. 

 

Once you assign any of the fields with the (Data Group) tag to the right side list, 

you can access the data group editor by choosing the menu option or clicking on 

the appropriate button in the toolbar. 
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The data group editor looks similar to the field profile editor. The 2 lists represent 

subfields which belong to the group. The left side list contains the available 

subfields, and the right side list contains the assigned fields. The menu and icon 

options are identical in behavior to the ones in the field list editor. 

Grade Values/Quantities (Horizontal Format Data Group) 

The 6th data group is slightly different than the other 5, as this one is specifically 

designed for horizontal presentation of grade information using combinations of 

quantity and currency values. 
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This editor involves creation of custom subfields based on combinations of quantity 

and currency values assigned to each subfield. The editing of grade subfields for 

this type of data group is perhaps the most complex option in EzCoin to work with, 

yet it is also the reason why the report profiles can appear completely different 

from each other by using just a single data group field in the profile. 

 The + and – buttons are used to add and remove subfields from the list. The 

editor button is used to change the subfield configuration after it’s already 

been added to the list. 

 The clear button will erase all subfields in the group. 

 The undo button reverses all changes made since you started editing the 

group. 

 The up and down arrows move selected subfields up and down within the list. 

 The save button will commit all subfield changes for the group to the profile. 

These changes will not be saved until you commit the field profile 

configuration and then save the profile from the main profile edit window. 

 The cancel button will discard all changes you made and close the editor. 

The list itself shows the display name for on-screen labels and the report viewer, 

the short and long names for header labels on printed reports, the display format 

for the data and the grades which are used to build the net sum for quantity and 

currency values. These names can be changed to fit any description you like. 

When adding a new subfield to the configuration, you will see the following dialog 

window. 



EzCoin Reference – Version 2.0 

Page | 276 
 

 

Each subfield is referred to as a Grade Group. It can consist of any of the 

combinations of currency and quantity shown below. 

 Grade Quantity + Grade Value 

 Grade Quantity + Net Value 

 Coin Quantity + Grade Value (useful for reports on set items) 

 Coin Quantity + Net Value (useful for reports on set items) 

 Grade quantity 

 Coin quantity (same as grade quantity if not a Set with multiple physical 

coins) 

 Grade value (will be based on market value, user value and bullion value) 

 Net value (quantity * grade value) 

 Market value (if available) 

 Bullion value (if applicable) 

 Purchased coin quantity (from purchase history) 

 Sold coin quantity (from sell history) 

 Purchase price (from purchase history) 

 Sell price (from sell history) 

 Net Profit (based on purchase + sell history) 

This information is summarized in more detail in a table at the end of this topic. 

Note that grade value is based on the following rules: 

 If the coin was added as a bullion value, it will be the bullion price. 

 If the coin was added as non-bullion (normal inventory mode), then the user 

value will take precedence over the market value. If no user value is present, 

market value is used to determine the grade value. 
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Single Subfield Configuration 

If you only add one subfield (aka Grade Group), then the labels will not be used on 

the report headers. Instead only the grade names (i.e. MS-65, VG-8, etc.) will 

appear on the report header. When multiple subfields are in use, then labels are 

needed to distinguish the type of data in each column. 

Each grade defined for the current country which has a value (quantity or price) will 

be assigned to one column on the report. For the special split fields (i.e. Quantity + 

Net Value), the quantity will always be left justified and the price right justified in 

the report column. 

In the example shown above, assuming there is valid data for MS-65 and VG-8 for 

a coin record, the columns in the report (left to right) would be shown as: 

1 Market value for MS-65 

2 Grade quantity + net value for MS-65 

3 Sell price for MS-65 

4 Purchase price for MS-65 

5 Net profit for MS-65 

6 Market value for VG-8 

7 Grade quantity + net value for VG-8 

8 Sell price for VG-8 

9 Purchase price for VG-8 

10 Net profit for VG-8 

 

Note that reports in EzCoin auto-suppress columns for which there is no data. For 

example, if there is no purchase price for any coin on the report, then column #9 in 

the above example will never appear. This auto-suppression keeps the report as 

condensed as possible by removing wasted blank space for columns which are 

empty. 
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Grade Group Format Types 

The following formats are available to display on reports using the horizontal grade 

quantity/value group. 

Grade Quantity + Grade Value The grade quantity will appear together with the 

grade value (user custom value, bullion value or 

market value) in one cell, with the quantity on 

the left and the currency value on the right. 

Grade Quantity + Net Value The grade quantity will appear together with the 

net value in one cell. 

Coin Quantity + Grade Value The coin quantity (grade quantity * set coin 

quantity) will appear with the grade value in one 

cell. For non-set coins, the grade and coin 

quantity values will be identical. 

Coin Quantity + Net Value The coin quantity will appear with the net value in 

one cell. 

Grade Quantity The grade quantity will appear in the cell. 

Coin Quantity The grade quantity * set coin quantity will appear 

in the cell. 

Grade Value The grade value (bullion value, user custom value 

if provided, or market value) will appear in the 

cell. 

Net Value The grade value * quantity will appear in the cell. 

Purchase Price The purchase price will appear in the cell. 

Sell Price The sell price will appear in the cell. 

Net Profit The net profit (sell price – purchase price) will 

appear in the cell. If there is no sell price, then 

the net profit will be zero. 

Market Value Pre-supplied or user-supplied market value for 

the grade. 

Bullion Value If the coin has a precious metal content and a 

valid weight, then the bullion value will be based 

on the current precious metal prices assigned to 

the country file. 
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Printer Setup 

 

The printer setup tab allows you to set specific printer settings for this profile. Much 

like the EzCoin General Preferences printer settings, the default report profile 

settings are based on the following: 

 Your default Windows printer. 

 Default paper size. 

 Left and right margins of ½ inch. 

 Top and bottom margins of 1 inch. 

 Landscape orientation. 

You can change these settings and they will be applied to the current report profile 

only.  

Note: If you don’t see any printers in the drop down list, use the Refresh Printers 

option in either the main EzCoin menu or from the general preferences window. 

EzCoin creates a printer list when the application is first initialized. If you add or 

remove printers after EzCoin has been installed, you will need to refresh your 

printer list.  



EzCoin Reference – Version 2.0 

Page | 280 
 

Titles and Subtitles 

 

A report has 6 title areas and 6 subtitle areas as follows: 

Left 
Margin 

Top Margin 

Right 
Margin 

Title 1 Title 2 Title 3 

Subtitle 1 Subtitle 2 Subtitle 3 

Data Grid 

Title 4 Title 5 Title 6 

Subtitle 4 Subtitle 5 Subtitle 6 

Bottom Margin 

 

The titles and subtitles are printed within the top and bottom margin areas of the 

page. If you decrease the size of these margins, you reduce the available space to 

print the text – always ensure there is sufficient space to print the titles and 

subtitles, unless you intend to create a report without any of the areas being used. 

Each of the 12 areas is defined by choices made in the appropriate drop down lists. 

You can choose from one of several attributes to place into a title or subtitle area. 
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Nothing No attribute will be printed in the title/subtitle area. 

Report Title The text which appears in the Report Title text box. 

Report Sub Title The text which appears in the Report Subtitle text box. 

Date and Time The date and time based on the date and time format 

chosen from the 2 drop down lists. 

Page Numbers Page numbers, using the format chosen from the drop 

down list. 

Country Name The name of the country identity, for example any country 

derived from USA will be the text “USA”. 

Country Description The description as stored in the country file settings. 

Country File Name The file name as stored in the DB folder of the EzCoin 

application path. 

User Defined 1 Any text of your choice, which is entered in the 

corresponding text box in the dialog window. User Defined 2 

User Defined 3 

User Defined 4 

Report Parameters EzCoin will attempt to output as much of the search input 

conditions as will fit without overwriting any other text in 

the report or running off the margin edges. This is the 

same text as appears in the title bar of the report viewer 

window, less the report title. 

EzCoin Signature For trial versions of EzCoin, a special copyright signature 

string is attached to the bottom left of all reports, and can’t 

be removed. You are free to add or remove this message 

as long as you have a registered copy of EzCoin. 

 

One last item on this tab is the date format for Data cells. Choose from this drop 

down list to enforce a specific format pattern on all dates in the report data grid. 
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Print Attributes 

 

This tab contains several options which control how each page will be formatted on 

the report. With the exception of the value format setting, all other attributes are 

for the printed pages only. 

Data Row Coloring If this option is enabled, the odd and even rows of the data 

grid will alternate background colors, much like the on-

screen report viewer’s data grid. 

Row Band Gap This value, which is in inches, is the amount of white space 

to add between each row in the data grid. This gap value 

can be useful for staggered reports, as it will provide a 

clear division between the coin records. 

Staggered Report 

Indent 

When used the staggered report style, this indent is 

applied to rows 2+ for each coin record. For example, if a 

coin record requires 3 physical rows on the page to print all 

the fields, an indent of 1 inch would be applied to the 

second and third rows to clearly show the starting row for 

each coin record. 

Header and Footer 

Lines 

Check these options to draw a thin horizontal line across 

the page between the header/footer titles/subtitles and the 

data grid. 
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Grid Line Type This option specifies the border style to use when drawing 

gridlines around the cells in the data grid. 

Grid, Header & 

Footer Line Thickness 

These drop down lists give you a choice of line thickness to 

use for the lines which separate titles, subtitles, and the 

data grid cells. 

Header/Footer Gaps These gaps provide a small amount of white space between 

text areas. The margin gaps are measure upwards from the 

top margin (header area) and downwards from the bottom 

margin (footer area). The title gap provides extra white 

space between titles and subtitles. 

Cell Indents The indent values provide a safe margin of white space 

within each cell of the data grid. The 2 values act as 

margins within each cell to keep the text from creeping into 

the grid lines which separate each cell’s data from one 

another. 

Grid Offsets Grid offsets of 0 and 0 will align the grid to fit within the 

page margins. A negative value will force the grid to 

expand into the margin areas, while a positive value will 

make the grid shrink within the margin areas. 

Vertical Alignment This option specifies how the text should vertically align 

with each cell of the data grid. 

Image Size The image width and height values allow you to set the 

size of all image fields on the report. Image dimensions 

must fall between ¼ and 4 inches in either direction. 

Image Quality This option controls the print quality of images. Bicubic 

options provide the highest quality output. 

Quantity & Value 

Format 

This text box contains arbitrary text which defines the 

default number of measurement characters to use for 

grades and values appearing as part of an inventoried 

grade data group. EzCoin will measure the width of this 

string to set the default column widths in the report viewer. 

This option is not used for printed reports.  

Pixel Size for Image 

Reduction 

When printing images, EzCoin can reduce the size and 

increase the printing performance of the reports by scaling 

down the images before sending them to the print spooler. 

This setting controls the maximum width or height of an 

image before it is scaled down. 
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Fonts and Text Colors 

 

This tab contains all of the font settings for printed reports. 

Header Rows Font The top row of the data grid containing the header labels 

for each column on the report. 

Data Rows Font The interior data cells representing the coin information. 

Total Rows Font The bottom row(s) of the very last page of the report, for 

showing sum totals on columns which can be totaled. 

Title and Subtitle 

Fonts 

Each of the 6 titles and 6 subtitles can have unique font 

assignments. 

Font Scaling The 3 attributes in the upper right corner define how font 

sizes can be dynamically reduced for the data grid text if 

the information doesn’t fit within the cell. For multi-line or 

fixed width field types, scaling doesn’t apply, as the text 

will either wrap to multiple lines, or the cell width will auto-

size to fit the text. 

 

If font scaling is disabled, then text which doesn’t fit a cell 

will be truncated and denoted with the … ellipsis string. 
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When font scaling is applied, EzCoin will attempt to reduce 

the font size by the adjustment value down to the 

minimum allowable point size you specify until the text fits. 

If the text still doesn’t fit, truncation will be used. 

 

Changing Fonts 

For each font in the window, you can click the ellipsis buttons to display the font 

picker dialog. 

 

The easiest way to set a new font is to click on the Font button and use the 

standard Windows font selection dialog window. This will populate the font name, 

width, height, bold and italic attributes. The color can be changed by clicking on the 

color swatch in the above window. 

The 3 labels at the top display character samples in the current font chosen. 

The Copy button can be used to duplicate the current font settings to other report 

fonts without having to individually adjust each report font for the same values. 
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Background Colors 

 

 

This tab contains the background colors for the printed reports. The Transparent 

buttons to the right of each color swatch are used to set a background color to 

transparent. This will be indicated with the text of “None” on the swatch. 
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Header Rows  Color Applied to the background of the top row of the data grid 

containing the column header labels. 

Odd Rows Color Applied to rows 1, 3, 5, etc. of the data grid cells. 

Even Rows Color Applied to rows 2, 4, 5, etc. of the data grid cells. 

Totals Rows Colors The bottom row(s) of the very last page of the report, for 

showing sum totals on columns which can be totaled. 

Banding Gap Color If you set a banding gap (the space between each row of 

coin records in the data grid), then this will be color of the 

spacing band. 

Grid Line Color The color for the grid lines surrounding the data cells, and 

also the color for the header and footer grid lines. 

Image Background 

Color 

When printing images, this color will fill up the empty space 

within the cell where the coin image itself isn’t occupying. 

 

Report Profile Edit Options 

The Save button is used to save all changes from all the various editors within the 

report editing tool (fields editor, data group editors and all the attributes within the 

tabs of the main editor window). If you attempt to close the editor without saving 

changes, you will be given a warning and a chance to back out. 

The Save As button will create a copy of the current profile under a new name and 

description of your choice. New reports are always saved as custom format – you 

can’t save new reports as supplied format. 

Click on Delete to remove the current report profile. You will not be able to delete 

supplied profiles. Once a profile is deleted, it can’t be recovered except from a 

backup. If the report you deleted was assigned to any report or search in EzCoin, 

you will have to choose a different profile when you run that search or report. 

The Rename button is used to change the description for a report profile. You will 

not be able to change the file name (save the report under a new name to do this). 

The Restore button will undo the previous report profile edit changes by taking the 

profile from the backup folder and replacing the current copy. When you save 

changes to any report profile, the current file is saved to the backup folder. There is 

only one level of undo, as there is only one backup of any report profile. 

Note: Supplied profile backups are read only, so a restoration of a supplied file will 

restore the profile back to the original pre-supplied state. 
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The restoration screen provides a list of all RPT files stored in the EzCoin Profiles 

folder. Simply select one or more profiles from the list and click on the Restore 

button. 

The Reset button will apply default settings to the current report profile. 

The Copy button allows you to transfer some of the common printing attributes 

(paper size, orientation, title/subtitle font information, etc.) from the current profile 

to one or more target profiles. 

 

Note that the title bar shows the source profile you are copying attributes from. 

Check any option you wish to copy from the current profile you have selected. Then 

check which report profiles you want to copy to in the checkbox list at the bottom. 

Use the 3 buttons to select/deselect multiple profiles. The All Custom button will 

select all profiles which you have created and de-select all pre-supplied profiles 

from SoftPro. 

Note that every target profile will be backed up before the attributes are copied. 
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Custom Report Assignments 

When you create many custom Report Profiles, you might want to be able to assign 

these to specific reports or searches without changing the default profiles assigned 

to the items under the Search and Reports menus. This is where the Custom Report 

Assignments feature helps. 

A submenu is available in Reports under the Custom Reports menu item. This 

submenu contains 10 custom search/report positions where you can assign a 

custom profile to, along with the associate search/report type. Use the Assign or 

Remove Reports item under the submenu to attach a search/report to one of the 

10 available positions. 

 

The 10 radio buttons are used to select one of the 10 menu positions to assign a 

report to. As you click each button, the information in this dialog window will 

change to reflect the report currently assigned to that position. 

Report Types 

The following searches and reports can be assigned to a custom report position: 

Quick Stats 1 Quick Stats 2 Quick Stats 3 

Basic Inventory Detailed Inventory Customized Coin Information 

Catalog ID Cross Reference Comments Report Detailed Grades Report 

Coin Information Want List Priority Want List 

Priority Sell List Purchase History Sell History 

Search: Key Fields Search: Coin Attributes Search: Composition 

Search: Designer Search: Mint Details Search: Supplied Notes 

Search: Period Search: Serial Number Power Search 

Grade Search Location Search Comments Search 
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Custom Field Search EzBrowse EzInventory 

Data Change History Price/Market Value Search Rapid Multi Entry (RME) 

 

Report Profiles 

Only customized report profiles can be assigned to a custom report menu position. 

The pre-supplied “Default” profiles will not appear in this list. Use the Report Profile 

Editror to create new report profiles, or make copies from any of the pre-supplied 

stock reports. 

Menu Description and Report File Name 

When you pick a report profile, the file name and current description embedded in 

the RPT file will be shown below the profile drop down list. You will not be able to 

rename the profile; however you can label the report to any text of your choosing. 

This description is what will appear in the submenu when you select it from the 

main EzCoin menu. 

Exporting and Importing Report Sets 

Even though you are limited to 10 custom report positions in the submenu, you can 

swap out profile sets using the Export and Import buttons. Use the Clear button to 

remove a report from a submenu position. The Clear All button will reset all 

submenu positions to empty status. 

Clicking on Save will assign the report positions to main EzCoin menu, and also 

save this information to a special pre-named report set file in the application 

installation path. This will retain your custom menu assignments after EzCoin has 

been closed down. 
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Report Fields Configuration 

There are 3 Report Field Editors under the Utility menu: 

 Standard Reports contain all the fields which can be included in any search 

or report in EzCoin which uses a report profile for a country file. Custom 

fields are not part of this list and are maintained on a per country basis, 

using a separate editor. 

 Grand Totals Horizontal contain fields specifically for use in a grand totals 

report where the grade information is presented horizontally across the page. 

Unlike standard report fields, a grand totals report works with all country files 

collectively, and the fields are primarily focused on net quantity and value 

totals. 

 Grand Totals Vertical contain fields specifically for use in a grand totals 

report where the grade information is presented vertically down the page. 

Standard Report Fields 

There are more than 100 report fields available which can be used in your report 

profiles. The following table categorizes the fields based on primary and secondary 

coin information, and special net totals fields. 

Primary Coin Details 

Denomination Alternate Pre-supplied Catalog Numbers 

Year Alternate User Catalog Numbers 

Type/Reign Unique Identifier code (UID) 

Variety Duplicate Coin Number 

Mint Mark Set Coin Quantity 

Custom Variety Indicator Inventoried Status Indicator 

Price Lock Indicator Main Variety Indicator 

Pre-supplied modified status indicator Date the coin information was last changed 

Secondary Coin Attributes 

Period Mintage 

Proof Mintage Designer 

Mint Location Diameter 

Weight Thickness 

Composition (without precious metals) Composition (including precious metals) 

Silver content Gold content 

Platinum content Palladium content 

Edge Notes/Description 

Pre-supplied special information Pre-supplied special notes 

Your Inventoried Details 
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Serial Number Coin Location (not grade level) 

Comments Custom Fields (based on country file) 

Image Links 

Primary Obverse Image Primary Reverse Image 

Alternate Obverse Image Alternate Reverse Image 

Net Values and Quantities 

Total inventoried grades on the coin Total item quantity for inventoried grades 

Net value for all inventoried grades Total coin count for inventoried grades per coin 

record 

Total records added to the PWL for the coin Total quantity to buy for all PWL records 

Total records added to the PSL for the coin Total quantity to sell for all PSL records 

Total purchase price for all grades in the 

purchase history for the coin 

Total sell price for all grades in the sell history for 

the coin 

Net profit for all grade buy/sell prices Total coins in the sell history 

Total coins in the purchase history  

Inventoried Grades 

Grade Name Market Value 

User Value Bullion Value 

Grade Value Quantity 

Net Value Coin Quantity 

Bullion Value Indicator Graded By 

Grade Comments Grade Location 

Purchase/Sell History 

Purchase/Sell date Grade Name 

Purchase/Sell quantity Purchase/Sell price 

Purchased From/Sold To Purchase/Sell comments 

Priority Want and Sell Lists 

Grade Name Quantity to Buy/Sell 

Type to Buy/Sell Market Value 

Net Value  

 

Reports and Image Links 

An image link is a file name reference to a coin image located on the original EzCoin 

supplied CD/DVD/BD media, in the EzCoin Images folder of the application path, or 

in an alternate location you define. The primary image links can be represented on 

reports as either the image itself, or the file name reference. Primary images are 

named with the word “link” to denote the file name in a report. For example, 
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“Obverse Image” is the image to display on the report, and “Obverse Link” is for 

the file name link on the report. 

 

The report field editor allows you to change display and print attributes for the 

fields which appear in the report viewer and on printed reports. Some of these 

fields can also appear in drop down lists and in various dialog windows, or as 

header labels within data grids. The following table summarizes what field 

attributes can be modified. 

Display Name This attribute is used in most dropdown lists within EzCoin 

windows, as header labels in data grids, and as general 

purpose labels. 

Short Name This label type can be used in data grid headers to shorten the 

width of the grid columns. A general preference option in 

EzCoin allows you to switch the data grid header labels from 

Display Name to Short Name. 

Print Short Name This attribute will populate a printed report’s header row if 

short print names are set at the profile level (short names can 

also be enabled globally across all reports using an EzCoin 
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preference option). 

Print Long Name This attribute defines the label text on printed reports when 

long labels are in effect. Note that you can rotate the labels on 

printed reports 90 or 270 degrees to allow for shorter column 

widths. 

Alignment This attributes determines if the fields should be left, center or 

right justified within the cell area of a report. 

Displayable 

Characters 

For a field which can have a variable number of characters 

(such as Denomination and Color), EzCoin allows you to define 

the default number of characters to set for the column width 

in the report viewer. 

This is just a default for every report profile. Once you resize a 

field within the report viewer, the new size gets locked in and 

saved to a configuration file on a per profile basis. 

This attribute is not used for printed reports and will not be 

allowed for any field which is defined as fixed width (such and 

currency and quantity fields). 

Print Width The default width of the field for printed reports only, 

measured in inches. Fixed width fields will not allow for this 

setting, as those field types are auto-sized on the printed 

report to “just fit” within the cell. 

Display Mask This attribute is specifically used for the report viewer (not 

printed reports) to define a default “nominal” size for fixed 

width fields. Printed reports will auto-size as needed. Columns 

in the report viewer will set a default size for fixed width fields 

based on the text value defined in the display mask. 

The mask doesn’t require any special format – it’s just a 

collection of arbitrary characters which makes up a default 

text value. You can use strings such as “Abcdef”, “9,999-99” 

or “123xYz” for any field mask. EzCoin will simply measure the 

on-screen width of this text value and use that to set the cell’s 

column width in the report viewer. 

Once you resize columns in the report viewer, the new widths 

are saved individually on a per-report basis. 

 

Field Types 

The fields are grouped according to primary and secondary types: 

Primary Fields Main coin details and inventoried attributes. 
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Comments The main comments for the coin record. 

Special Info Special pre-supplied notes and information. 

Grade Data Inventoried grade information. 

Purchase 

History 

Fields which are part of the purchase history. 

Sell History Fields which are part of the sell history. 

Priority Want 

List 

Fields which are part of the priority want list. 

Priority Sell 

List 

Fields which are part of the priority sell list. 

 

Custom fields are not defined in this list. Refer to the custom fields edit utility for 

more information. You assign custom fields to a report profile from the profile 

editor, and set the printing/display attributes for these fields from the custom fields 

editor. 

Data Types and Attribute Restrictions 

A field has a base data type and a report data type. The base data type can be one 

of the following: 

 A general purpose text field. 

 A Yes/No status field. 

 An image (image is displayed/printed) or image link (file name is 

displayed/printed). 

 A currency field. 

 A numeric value which can include fractions. 

 A whole number value which can’t have fractions. 

 A date field (which can’t include a time component). 

The field is further classified by EzCoin with a print attribute used for printed 

reports only, which can be one of the following: 

Fixed Width: The field will never be truncated or resized on a printed report. This 

type is reserved for dates, currency and quantity fields. 

Multiline: The text information will not be truncated or resized, but will instead 

wrap around to multiple lines on printed reports, causing the data row to grow 

taller. 

Truncated: The text information will always occupy one line of text on the report. 

However, if the text value doesn’t fit within the cell width, it will be resized (the font 
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size will shrink as needed), and if it still doesn’t fit, it will be truncated on the right 

and marked as such using the ellipsis (…) notation. 

Image: The cell is defined to contain an image, and as such will be sized based on 

the cell image size in the EzCoin general preferences. 

When editing the display mask, print width, or number of characters attributes in 

the editor, the ability to do so is based on the field’s print attribute type. 

 The Display Mask can be changed for Fixed Width field types. 

 The Display Characters and Print Width can be changed for Truncated and 

Multi-line field types. 

Editing Field Data 

To change settings for a field, move the cell cursor to the field you want to change 

and press F2 (or start typing with any valid character). Press ENTER to save the 

new cell value, or ESC to cancel the change. 

You will not be able to edit any read-only cell in the grid – this will be indicated 

using a different text and background color. 

Undo and Revert 

Use the Undo option to restore all field settings back to the original values before 

you made any changes. Use the Revert option to restore all fields back to pre-

supplied values. EzCoin maintains a read-only copy of all field settings to allow for a 

full restoration. 

Revert and Supplied Data Updates 

If SoftPro makes any changes to the read-only copy of the report fields from a 

supplied data update, they will NOT be applied to your copy of the configuration. 

You will need to use the Revert option to see the changes. The only exception to 

this is when SoftPro adds new report fields in the future – these will automatically 

show up in your configuration. 

Any changes between current and pre-supplied data field values will be shown in 

the data grid with different cell coloring. When reverting back to pre-supplied data, 

you can choose to revert some or all of the attributes, and also choose if you only 

want to revert on the current selected row. 

Copy and Paste 

You can use the Copy and Paste options in the Edit menu to copy the contents of 

one cell to another. 
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Setting a Global Currency Mask 

Use this option in the Edit menu to change the mask value for all currency fields. 

Note: There is no similar option for quantity fields, as they have variable sizes – 

use the Copy and Paste options to quickly change a quantity mask for multiple 

fields. 

Grand Totals Field Editor 

This editor is identical to the standard report field editor. The only difference is that 

the field list is based on the grand totals reports only and will contain a basic set of 

summary totals information. 
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Utilities 

List Editors 

EzCoin maintains lists of text values for the following: 

 Denominations (per country file) 

 Graders 

 Priority Want/Sell List Types 

 Who you purchase coins from or sell coins to 

 Coin locations 

The editor for these lists is accessed from the List Editor submenu under Utility. 

 

Denominations Editor 

A denomination list is slightly different than the other text lists, in 2 specific ways. 

 The list is specific to each country file. 

 The sort order of the list determines how the denominations are displayed in 

reports, and how the coin navigation works (stepping forwards and 

backwards through coins sorted by denomination). 
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Denominations can be pre-supplied by SoftPro or custom ones you create. The 

editor will display a pre-supplied denomination with a green “S” icon in the list, and 

custom values you create will be shown with a red “U” icon. 

Toolbar Options 

 

1. Add a new denomination. Note that newly added values will always be 

placed at the end of the list. 

2. Remove selected denominations. You will not be allowed to remove a pre-

supplied denomination. You always will not be allowed to remove a custom 

denomination if it’s currently being used by one or more coin records. 

3. Use the arrow buttons to move selected entries up and down in the list. 

Hold down the CTRL key to move the selection to the beginning or end of 

the list. 

4. Click this button to save all changes. Note that if you changed the sort order 

for the denominations, EzCoin will need to re-index the coin inventory for 

this new sort order. 

5. Click this button to cancel all changes and close the editor. 

6. Click this button to undo all changes and restore the list to the original state 

when you first launched the editor. 
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7. Denomination lists can be exported to a file and then imported at any time 

into the same or a different country file. An exported file will have an 

extension of .DEN. 

8. Note that the import facility doesn’t touch the current displayed list. What 

EzCoin will do is check all denominations in the .DEN file and if there are 

any new denominations, they will be appended to the existing list. 

 

Restoring Denominations 

You can restore missing denominations from the current country file using the 

Restore Denominations item from the Options menu. EzCoin will scan every coin 

record in the country file for denominations and re-insert them back to the list if 

any are missing. This option should never be needed under normal EzCoin usage. 

Renaming Denominations 

There may be a case where you create a new denomination, and started adding 

new coins under this value to the country file, only to notice that the denomination 

was misspelled (EzCoin denominations are case-sensitive, be aware of this). 

You can rename a custom denomination by choosing the Rename Denomination 

item from the Options menu. EzCoin will rename all references for this 

denomination wherever they may occur in the country file. 

 

Generic List Editor 

The other list types use alphabetically sorted text values. As such, the editor 

window uses a simpler design. 
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Each item in the list can be edited (renamed or removed) and new items can be 

added at any time. 

The lists grow with new entries being added to the end, when adding items from 

the main EzCoin screen, or from Report Views. To keep the lists in a sorted order, 

you can use the editor to automatically sort the list, or you can manually select one 

or more list items and use the Up and Down buttons. 

When you select a value in the list, it’s current text string will appear in the List 

Item edit field.  

Toolbar Options 

 

1. Add the text in the bottom input field as a new entry in the list. If the item 

already exists, you will be given a warning message, as EzCoin doesn’t allow 

duplicate items in a list. 

2. Remove selected items from the list. If you remove items, in most cases 

you can get them back, provided: 

a. They are a pre-supplied list item from SoftPro. 
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b. The item is currently used in one or more inventoried coin records. 

In any other case, once you save changes to the list after removing items, 

you will not be able to get them back (lists can be saved as part of an 

EzCoin data backup, or by using the export option). 

3. The current selected list item will be updated with the text in the bottom 

input field. If no items are selected, or more than 1 item is selected, this 

option has no effect. 

4. 

5. 

The import and export icons provide the ability to store lists as external 

files. Lists can only be exported as UTF-8 format text files with a .TXT 

extension. Importing lists can also accept .TXT text files or as .LST list files. 

LST files are only provided by SoftPro. 

6. This option will erase all items in the list. 

7. This option is only enabled if you have a country file currently opened. 

EzCoin has the ability to check all coin records to see if any list items exist 

which may have been deleted. For example, if you refresh Graders from the 

country file, every inventoried grade record will be checked for a Grader 

value and added to the list if it doesn’t exist. This is the only way to get 

deleted list values back outside of an import file or a backup archive. 

8. Click this button to save all changed made since you launched the editor. 

9. Click this button to cancel all changes and close the editor window. 

10. Use the up and down buttons to move the selected list items in the list for a 

custom sort order. Hold down the Ctrl button while clicking to move the 

selected items to the start or end of the list. 

 

Sorting Lists 

Choose the Sort option from the Edit menu (or press F5) and you will have a choice 

to sort the list Alphabetically or Numerically.  

A numeric sort looks at the start of each list item, for up to 18 digits which can be 

determined to be a number. If this is the case, the numeric values will always come 

before the non-numeric values and be sorted as numbers. 

Since EzCoin will not automatically maintain a list in sorted order when you add 

new items (i.e. add a new location when inventorying a new coin record), you will 

need to make use of the sorting feature in the list editor from time to time. 

Reverting to a Supplied List 

This option is available in the Options menu, and allows you to restore the current 

list of pre-supplied entries. All of your custom entries will be left intact, and only 
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pre-supplied values are replaced with the original backup data. This option is 

available for Graders, Purchased From, Sold To and Priority Want/Sell List types. 

List Import Merges 

When importing from .TXT or .LST files, the current list will be left intact. All new 

text additions will be attached to the end of this list. Any duplicate items will 

automatically be ignored. 
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Search and Replace 

This option allows you to perform a search against all coin records in the current 

country file and replace values as needed. The search functionality is split into 3 

separate windows: 

 The search window, which provides the input conditions to find coin records. 

It works much the same as a single level Power Search. 

 The results window, which is a simple data grid showing matching records in 

a manner similar to the Coin List Viewer. 

 The replacement window, which allows you to replace existing values with 

new ones. 

Search Window 

 

The search window is displayed when you choose the Search and Replace option 

from the Utility menu. Note: Only inventoried records can be searched upon. 

Search Category Similar to the Power Search, the following categories are 

available: 

 Primary Coin Fields 

 Custom Fields 

 Inventoried Grades 

 Priority Want List 

 Priority Sell List 

 Purchase History 

 Sell History 
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When you choose a category, the Search Field will be 

populated for all valid fields associated with the category. 

Unlike a Power Search, you can’t choose multiple fields to 

search on at one time – only 1 field can be selected for a given 

search. 

Search Field Only replaceable fields will be shown in this drop down list 

based on the search category. Any fields which are read-only 

can’t be part of a search and replace. 

Search Method This method defines how to compare the search values you 

enter to the field contents in the coin record. 

Search From/For If you have entered a search method which requires a 

matching value, this field is displayed and expects you to enter 

something. 

Search To If you have chosen the Between search method, then you must 

provide a start and end value to search against. 

Case-Sensitive For text fields, this option is available to force all text 

comparisons to distinguish between upper and lower case 

letters. 

 

Click on Search to begin. EzCoin will look at every record for a matching condition. 

The total record match count will be shown in the status bar. If at least one match 

is found, you can click on the Show button to display the matching records. 

Results Window 
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This window can be dragged around and resized independently from the main 

EzCoin window. You can continue to work within the main window while the search 

results are displayed. You can close the search results window at any time. 

The records displayed contain only the matching record key and the matching value 

as follows: 

 The first column always contains the search field and the record’s current 

value. 

 Denomination 

 Year 

 Type/Reign 

 Variety 

 Mint Mark 

 If the search category was for secondary coin information (PWL, PSL, 

Purchase or Sell History), the grade value will always be shown as the second 

column. 

For secondary coin information, it’s possible the results window will show several 

rows for the same coin record. Duplicate coin records can also show up in the 

results. 

The toolbar at the bottom of the window contains the options you can apply to the 

search results. 

 

1. Perform a replacement on selected rows only. 

2. Perform a replacement against all rows in the data grid. 

3. Select all rows in the data grid. 

4. Select nothing (deselect all rows in the data grid). 
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Replacement Window 

 

This window provides a replacement method and a replacement value. 

The original search value is displayed in the Search Value field. If the search 

method didn’t require a search value (i.e. a Not Empty search method), then this 

field will be blank. 

The replacement method can be one of the following. Depending on the search 

value and the data type, not all of these options will be available. 

 Replace all occurrences of the search value with the replacement value (text 

fields only, and only if the search method is of type: Contains, Starts With, 

Ends With, or Equals. 

 Insert the replacement value before the current field value (text fields only). 

 Append the replacement value after the current field value (text fields only). 

 Replace the entire field with the replacement value. 

The Do not confirm replacements option, if unchecked, will provide a confirmation 

every time you click the Replace button. It will NOT prompt you for every 

replacement on a per record basis. If you have selected 12 records to replace from 

the results data grid, you will only be asked to confirm one time. 

Once changes are made, the original values in the search list will be updated to 

show new values. Keep in mind that when a value changes, the original value is 

lost, and this means that the replace all occurrences drop down option will no 

longer match on the original value, since it’s been changed. 
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Grade Configuration Editor 

EzCoin associates a standard grade list with any given country. The default master 

grade list used by every country file will contain all of the grades available to use. 

When assigning grades to a country file, the master list will always be the source. 

EzCoin provides the following default grades which can be used for any country. 

They are grouped into sets using a Group ID value. This is a carryover from EzCoin 

version 1. In version 2, you are free to decouple grades from a group and assign 

them to country files on an individual basis. 

Poor 001  SP 004  PROOF 007  MS-60RD 010 

Fair 001  SP-60 004  PF 007  MS-61RD 010 

AG 001  SP-61 004  PF-60 007  MS-62RD 010 

G 001  SP-62 004  PF-61 007  MS-63RD 010 

VG 001  SP-63 004  PF-62 007  MS-64RD 010 

F 001  SP-64 004  PF-63 007  MS-65RD 010 

VF 001  SP-65 004  PF-64 007  MS-66RD 010 

EF 001  SP-66 004  PF-65 007  MS-67RD 010 

P-1 001  SP-67 004  PF-66 007  MS-68RD 010 

AG-3 001  SP-68 004  PF-67 007  MS-69RD 010 

G-4 001  SP-69 004  PF-68 007  MS-70RD 010 

G-6 001  SP-70 004  PF-69 007    

VG-8 001     PF-70 007  GEM 011 

VG-10 001  UNC 005       

F-12 001  UNC-60 005  PL 008  FDC 012 

F-16 001  UNC-61 005  PL-60 008    

VF-20 001  UNC-62 005  PL-61 008  CAM 013 

VF-30 001  UNC-63 005  PL-62 008  CAM-60 013 

EF-40 001  UNC-64 005  PL-63 008  CAM-61 013 

EF-45 001  UNC-65 005  PL-64 008  CAM-62 013 

   UNC-66 005  PL-65 008  CAM-63 013 

AU 002  UNC-67 005  PL-66 008  CAM-64 013 

AU-50 002  UNC-68 005  PL-67 008  CAM-65 013 

AU-55 002  UNC-69 005  PL-68 008  CAM-66 013 

AU-57 002  UNC-70 005  PL-69 008  CAM-67 013 

AU-58 002     PL-70 008  CAM-68 013 

AU-59 002  BU 006     CAM-69 013 

   BU-60 006  MS-60RB 009  CAM-70 013 

MS 003  BU-61 006  MS-61RB 009    

MS-60 003  BU-62 006  MS-62RB 009  BULLION BLN 

MS-61 003  BU-63 006  MS-63RB 009    

MS-62 003  BU-64 006  MS-64RB 009    

MS-63 003  BU-65 006  MS-65RB 009    

MS-64 003  BU-66 006  MS-66RB 009    

MS-65 003  BU-67 006  MS-67RB 009    

MS-66 003  BU-68 006  MS-68RB 009    

MS-67 003  BU-69 006  MS-69RB 009    

MS-68 003  BU-70 006  MS-70RB 009    

MS-69 003          
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MS-70 003          

 

The grades editor can be accessed from the Grades Configuration Editor from 

the Utility menu. 

 

The left side of the window shows the master grade list, from which all grades for a 

country must come from. The right side shows the assigned grades for the current 

open country file. 

Icon Status and Color Coding 

The master field list will contain either an "S" icon for pre-supplied grades, or a "U" 

icon for user/custom grades you create. 

If the background color is shaded green behind the icon, it indicates the grade is 

assigned to the country. 

The list on the right for assigned grades to the current country uses a similar color 

coding. If the S/U icon has dark green background, then the grade is currently in 

use and can't be removed from the country. A grade is considered in use if it's 

associated with any of the following: 

 Inventoried grade 

 Priority Want List 

 Priority Sell List 
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 Purchase History 

 Sell History 

 A market value exists 

 

Toolbar Options 

 

1. Add a new custom grade. 

2. Remove custom grades. You can’t remove a pre-supplied grade, or remove a 

custom grade if the grade is in use. 

3. Save all changes and close the editor. 

4. Cancel all changes and close the editor. 

5. Undo all changes. 

6. Export the assigned grade list to a file. 

7. Import the assigned grade list from a file. 

 

Exporting and Importing Grades 

If you wish to use custom grade configurations in other country files, or maintain a 

backup copy of your configuration, use the export option. This will save the grade 

definitions to a file with a .GRD extension. You can import grade files provided that 

this will not result in removal of custom grades which are already being used by the 

country. 

Assigning and Removing Grades 

Grades can be assigned by group or individually to a country. This is accomplished 

with the 4 buttons between the 2 grade lists. 
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1. These 2 buttons will move grades by group ID as a set. The left arrow button 

removes the group from the country, the right arrow assigns it. 

 

As a shortcut, you can double click on any grade assigned to group in the 

lists. Double click in the master list to assign the group, double click in the 

country list to remove the group. 

2. These 2 buttons move selected grades individually. 

 

As a short cut, you can assign grades by right clicking a selection of grades 

in the master list, or right clicking a selection in the country list to remove. 

 

You will not be able to remove any grade if it's currently in use by the country. 

The buttons to the right of the assigned grade list control the sort/display order of 

the grades as they will appear in the data grids in EzCoin. 

 

1. These 2 buttons will move grades up and down in the assigned list by group 

ID as a set. Hold down the SHIFT key while clicking to move the group to the 
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beginning or end of the list. 

2. These 2 buttons move selected grades individually up and down in the 

assigned list.  

 

Note that once you select a single grade and move it by group, all of the 

grades for the group will be collected into a single ordered group as they 

appear in the master grade list - you will lose any individual grade ordering 

in this case. 

 

Deleting and Renaming Grades and Groups 

Options in the Master menu allow you to rename and delete grades/groups. 

You will not be able to delete any grade if it's currently in use by the country as an 

inventoried grade, part of the purchase/sell history, the priority want/sell lists, or 

has a market value assigned to it. 

You can't rename or delete a grade pre-supplied by SoftPro. 

Note: EzCoin doesn't track grade usage across other country files - it's possible to 

remove a grade from the master list that's unique to a different country file and not 

in use by the current country. If you do delete such a grade, EzCoin will attempt to 

add it back in the master list for you the next time you run the grades editor. 

Custom grades can be renamed, but care must be taken if the grade is in use by 

multiple country files. EzCoin can only rename the grade within the current open 

country file. If the grade is in use in multiple country files, you must rename the 

grade for each country file in turn. A menu option named Fix Custom Country 

Grade can be used. A dialog like the one below will appear. 
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Consider this example. 

 You create a grade named MSX-11 while in currently working in the grades 

editor with the USA country file opened. 

 You inventory some coins with this grade. 

 You now open CANADA and use the grades editor to change this to MSX-12. 

This would only fix coin records assigned to Canada for MSX-11 and update 

their grades to MSX-12. This will not fix USA, which is still on the old MSX-11 

grade. 

 When you open USA again, and run the grades editor, EzCoin will detect that 

the country has a grade being used named MSX-11, even though you 

renamed it to MSX-12 while working within the Canada country file. The 

master list will show both MSX-11 and MSX-12, even though MSX-11 has 

been renamed. The assigned country list will show MSX-11, since USA is still 

using the old grade name. 

 To rename the grade from MSX-11 to MSX-12, you will choose the 2 grades 

from the above dialog as shown above. EzCoin will rename MSX-11 to MSX-

12 for USA. 

Care must be taken that no coins are using grade MSX-12 in USA when trying to fix 

the original MSX-11 grade. If this happens, EzCoin can't fix the problem, as you 

would be attempting to merge coin records with MSX-11 grades with coin records 

containing MSX-12 grades. Grade merging is not possible at this point. 

The bottom line is: Try not to rename custom grades after they are already being 

used by coin records. If you must rename them after this point, take care to fix all 

of your country files which use the old grade and change it to the new grade 

immediately. 
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Group names can be changed for any custom grades as you see fit. As the group 

names are only used to manage grade configurations, and don't have any value in 

reports and inventoried coin records, they can be renamed at any time. However, 

you will not be able to rename pre-supplied group names from SoftPro. 

 

Setting Grade Visibility 

If you find that there are too many pre-supplied grades to work with for a country, 

you can hide some of them using the Show/Hide Grade Visibility options from 

the Grades menu. 

The grades will still be available for the country, and can still contain existing coin 

data - you've simply decided to hide their visibility in EzCoin. For this reason, take 

care to only hide grades which you have no intention to attach to your inventory, 

priority want/sell lists or purchase/sell history. 

 

Restoring Grades from Backup 

There are 2 items under the Options menu. 

Restore Country Grades only applies to country files which have pre-supplied 

grade information from SoftPro. Pre-supplied grade lists are saved in the country 

file as a backup copy. You can choose to restore the pre-supplied list at any time. 

Custom grades you have assigned to the country will be left intact. 

Restore Master Grades will use the EzCoin pre-supplied master grade backup file 

to restore any pre-supplied grade information to the master grade list. Any custom 

grades will be left intact in the master list. 
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Custom Fields Editor 

Custom fields are provided to allow you to extend the basic information provided 

for coin records. By default no custom fields are provided for any pre-supplied 

country. You create custom fields using the Custom Fields Editor under the 

Utility menu, or you can automatically generate them from any import from prior 

versions of EzCoin. The custom fields created from older EzCoin imports will 

automatically generate the same fields and data types from the older version, and 

preserve all your custom data for the coin records you exported. 

 

The custom fields editor works similar to the Report Fields editor, with the same 

toolbar options. A custom field is defined with the following attributes. Many of 

these attributes are common to the report field master list. 

Field Name The field as it will uniquely be identified in EzCoin.  

Data Type The type of data, which can be any of the following: 

 Plain text, in mixed case format 

 Upper case text 

 Whole numbers without fractions (i.e. quantities) 

 Currency 

 Numeric with fractions 

 Date (without the time component) 
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 Yes/No status 

 Image link (file path + file name format) 

 Web URL (or any type of document) 

 Category (allows for multiple categories per coin) 

 

Note: EzCoin version 1 contained a Time data type. If imported 

from the old version, the value is converted to a string format. 

Display 

Name 

The name as it will appear on screen and in reports. 

Short Print 

Name 

The short format of the field as it will appear in header labels on 

printed reports. 

Long Print 

Name 

An alternate long format for the printed name. 

Alignment How the field value is justified on reports: Left, Centered, or Right. 

Print Type Fixed width, truncated, or multi-line using automatic word 

wrapping. Not all print types are available for a given data type. 

Visible If a field is not visible, it won’t appear in reports or in the custom 

fields edit windows. 

Totals The field will show a grand total at the bottom of the report by 

adding all the row values for the field together. Test fields cannot 

be totaled. 

Copy The field will automatically have its inventoried value copied to the 

next non-inventoried pre-supplied record when stepping through a 

country file. 

Searchable The field is available in Power Search and other dialog windows 

where custom fields can be used in country file searches. 

Reportable The field is available to add to a custom report profile. 

Display 

Chars 

For a data type which is not a fixed width print type, you can enter 

the number of characters to define a default display width for the 

column. 

Print Width This is the default print width for multi-line and truncated print 

types, measured in inches. 

Display Mask For a data type which is a fixed width print type, you can enter any 

arbitrary set of characters to create the “default width” for the 

report viewer columns. This value is not used for printed reports. 
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Toolbar Options 

 

1. Add a new custom field. 

2. Remove custom fields. You can’t remove a field if you have any inventoried 

coin records which are using it. 

3. Edit the selected field. 

4. Move the selected fields up or down in the list. 

5. Save all changes and close the editor. 

6. Cancel all changes and close the editor. 

7. Undo all changes. 

8. Export and import custom field files. 

 

Web URL and Image Link Types 

Image links for custom fields can reference any valid image file in any location. As 

such, an image link is stored with a full path name along with the file name. 

Web URL data types are primarily intended to reference a Web site. However, you 

can set a URL data type to point to any type of file as well. 

Adding and Editing Custom Fields 

Click on the + icon to add a new custom field. 
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This window provides all of the attributes to define a custom field. Depending on 

the data type and print method chosen, some of the other options will automatically 

be disabled. 

To edit an existing custom field, select it and click on the edit icon, or double click 

the row in the data grid. The edit window is identical to one use to add new fields. 

Field Ordering 

The order in which the fields are displayed in the editor window is how they will 

appear in EzCoin in any window which displays them (custom fields secondary 

window, dropdown lists, etc.). You can change the field order by selecting rows in 

the editor and moving them using the up/down arrows in the toolbar. Hold down 

the CTRL key while clicking to move the selection to the start or end of the list. 

Exporting Custom Fields 

If you wish to use custom field configurations in other country files, or maintain a 

backup copy of your configuration, use the export option. This will save the fields to 

a file with a .CFF extension. You can NOT import custom fields if you currently have 

an existing custom field configuration with active inventoried data. 

Renaming In-Use Fields 

If a field already has inventoried data associated with it, you can’t rename it using 

the normal edit dialog window. EzCoin stores the field name with each data value in 

the individual coin records. To rename a field which is in use, use the special option 
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named Rename a Field with Data. EzCoin will individually adjust each coin record 

to use the new name. 

Deleting In-Use Fields 

If you want to delete a custom field, EzCoin will not allow you to do so using the 

remove field icon if any inventoried records have data on that field. You can use the 

special option named Delete Fields & Data to remove the custom field, and also 

any data values from all coin records for that field. 
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Custom Country Editor 

EzCoin has an internal country list with more than 500 entries. When you create a 

custom country file, you can select from one of the pre-supplied country names, or 

choose to create a completely new country reference. Any country file name which 

is not recognized by EzCoin as a pre-supplied value will automatically be stored in a 

separate area reserved for Custom Countries.  

An editor is provided under the Utility menu. Use this editor to review or make 

changes to any custom country. 

 

The editor has no provision to add new custom countries, as this is handled 

automatically from the New Country option in EzCoin. What you can do is change 

the settings for an existing country, or delete the country record entirely. EzCoin 

will not allow you to remove a country which is already in use.  

The edit option allows you to change any of the following attributes: 

Data Directory 

Name 

This is the name under which all images are associated, and 

also uniquely identifies the country. You will not be able to use 

any data directory name which is already reserved for pre-

supplied countries. 

Upper Case Name The upper case version of the country name. 

Mixed Case Name The mixed case version of the country name. 
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Flag/Image File This drop down list contains all flag images stored in a special 

folder in EzCoin. 

 

Removing Custom Countries 

When creating a new custom country using the New option from the File menu, 

EzCoin will automatically add the country name to the current Custom Country list, 

which is maintained separately from the pre-supplied list. As long as you have at 

least one country file (.SDF file in the DB folder) active in EzCoin, you can’t remove 

the custom country – it’s in use.  

If you want to remove a custom country from the list, you must use the Remove 

Country option in the Country Data File Utilities submenu and remove every 

SDF file associated with the custom country name. 

Custom Flag Images 

Flag images are created using 2 sizes: 

 Small flags are 80 pixels wide by 50 pixels tall. 

 Large flags are 176 pixels wide by 110 pixels tall. 

The pre-supplied images are in Windows RLE Bitmap (.BMP) format, using 256 

colors. 

Images are stored in the Images folder in the EzCoin application path. A subfolder 

named ~~Flags\Small contains the small image files, and the ~~Flags\Large 

contains the large image files. 

If you want to use a custom flag image for your custom countries, then you will 

need to create 2 image files in the proper sizes, and manually copy them into the 2 

subfolders. Once you do this, they will become available in the drop down list. You 

are not permitted to use the same file names as existing pre-supplied flag images.  

 

User Data Copy Filter 

The copy data filter by default is disabled in EzCoin. When enabled, this option will 

transfer over some basic non-pre-supplied coin information to the next pre-supplied 

record. This feature doesn't have any benefit for custom country files which have no 

pre-supplied coin records from SoftPro. 

To enable the data copy filter, choose the User Data Copy Filter option from the 

Utility menu. 
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There are 5 field filters for inventoried data, plus special copy settings for your 

custom fields. At the bottom of the window is an on/off switch for enabling all of 

these options.  

If you un-check Enable Selected Options, then all user copy functionality is 

disabled, regardless of the other checkbox checked states – the options are all 

grayed out. 

 For Grade options, all inventoried grades and their associated attributes will 

be copied from the previous inventoried coin record to the next available pre-

supplied coin record from SoftPro which is not inventoried. 

 The custom fields copy option can be used as an on/off switch, using the first 

2 radio buttons. The bottom radio button, if chosen, will only copy custom 

field data for fields which are defined to be User Data Copy Enabled. Refer to 

the documentation for the custom fields editor. 
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Image File Copy 

When you install EzCoin, the image files are not copied to your hard disk 

installation path. As such, you will need to keep the EzCoin distribution disc in your 

drive to view the images. 

If you want to copy the image files to your hard disk, you can use the Image File 

Copy option from the Utility menu. 

 

If you have a country file currently open, it will be displayed in the title bar and the 

radio button option Copy the current Country will be enabled and selected by 

default. 

The Source Drive dropdown list will show all available removable media drives on 

your system. Network drives and hard disks will not appear, as they are not valid 

sources for disc media copy. 

Check the all countries option to copy all image files for every country on the disc. 

Use the current country option to only copy file for the open country file.  

Note that distribution images are provided as a single archive file per country with 

an extension of .IMG and the file name equal to the country name. These IMG files 

will always be copied to the Images subfolder where you installed EzCoin to. 
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Note: If you chose the default EzCoin setup options in the EzSetup program, then 

the image files would have already been copied for you. 

 

Custom Image Link Comparison 

This utility will display a list of all custom coin images which you've attached to a 

country file with pre-supplied data from SoftPro. For custom country files without 

pre-supplied data, the utility will not be available. 

The option is available as Custom Image Links from the Utility menu. The intent 

of the utility is to provide a side by side comparison of pre-supplied images with 

custom images you have chosen as a replacement. In addition, coin records which 

have only your custom images will also be displayed. 

 

Note that the list present is unfiltered. That is, any coin record that has a custom 

image association will be part of the list, sorted by denomination and year, without 

any type of search conditions to filter the list down (i.e. a range of years). If you 

need filtered lists of custom coin images, a Power Search would server this purpose 

with a custom report profile to include the coin images. 

Primary and Alternate Images 

The comparison window will display the set of pre-supplied and custom obverse and 

reverse images for either the primary or alternate image sets. If an alternate image 
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set exists for the coin record, then a button will appear in the bottom right of the 

window labeled as either Alternate (to show the alternate image set) or Primary 

(to show the primary image set). The labels below the images will indicate if an 

alternate image set is available as shown in the example screen above. 

Navigation of Coin Records 

Use the next and previous buttons to cycle  through the coin records. Hold down 

the CTRL key while clicking the previous or next buttons to move to the first or last 

records in the list respectively. 

The 5 key coin attributes will be displayed for the current coin record, along with 

the total number of coin records at the current coin position in the list. The pre-

supplied and custom image link file names will be displayed below the images. 

Navigation List Assignment 

The comparison utility will not allow editing of image links. If you wish to review or 

edit the image links for the purpose of changing the image file references, you can 

assign the coin list to the active EzCoin navigation list in the main window, and use 

the violet navigation arrow buttons in the main window toolbar along with the 

image link editor. Click on the Nav List button to assign the list and close the 

dialog window. 

Resizable Image Preview 

If you wish to view any of the images in a larger size, double click inside any of the 

4 image panes to show a resizable image preview pane. 

Main Window View 

To select the current coin displayed from the list in the main EzCoin window, double 

click anywhere within the 5-key field label area and the dialog will close, with the 

coin record displayed in the main EzCoin window. 

Clearing Links 

There are 2 buttons on the right side of the window to clear the custom obverse or 

reverse image links. Once you clear a link, the file name link area will change to the 

text <* REMOVED *>. This will tag the coin record for link removal, but the 

change won't be saved at this time. All linked marked for removal will not be 

committed to the country file until you click on the Save button. 

Note that clicking the clear button a second time will undo the change and restore 

the original link back. 

Exporting Links 

Once you choose to clear links and commit the changes via the Save button, the 

option to restore the original links is lost, unless you've made a country file backup. 

You can choose to export all of your custom image links to a tab-delimited text file 
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by clicking on the Export button. The 5 key fields along with the 4 custom image 

links (for primary and alternate images) will be saved to a UTF-8 tab-delimited text 

file. There is no import facility to restore the links back. You will need to manually 

enter links or restore from a backup file. 

Saving Changes 

Use the Save button to commit all cleared image links to the country file. Clearing 

an image link does not remove the image file itself - it will remain where it is 

located on your system. 

 

Coin Location Copy Utility 

This option is available from the Utility menu. It provides the facility to transfer the 

coin record's main location value to the individual grades. This feature is more of a 

support tool for users bringing in location data from version 1 of EzCoin. 

 

The first checkbox option will move the primary coin location to the grade level and 

remove it once completed. If not checked, the main location value will remain as is 

and each inventoried grade will have a copy. 

The second checkbox option is based on existing locations at the grade level. If a 

coin record has at least one grade with a location value, and this option is NOT 

checked, then the coin record is skipped over. For example: 

 MS-65 has a location value 

 VG-8 does NOT have a location. 
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If unchecked, the coin record is skipped. If the second option is checked, the main 

coin record location is copied to the VG-8 grade. 

Any grades will an existing location value will never be overwritten. 

 

Recalculating Country Totals 

Under normal operating conditions, EzCoin will maintain totals (record counts, 

quantities and currency values) automatically for you. However, in case you notice 

that totals seem to be “off” in a report, you can easily rebuild the country totals 

information quickly using this option from the Utility menu. Unless an unexpected 

error occurred in a country file, the totals should not need to be recalculated. 

Recalculating Grand Totals 

Each country maintains totals information. EzCoin will also maintain a grand totals 

list for every country file you have opened and inventoried at least one record on. 

Normally, grand totals are built and maintained automatically. However, if you add 

or remove country files outside of EzCoin’s provided mechanisms to support this 

(i.e. copy a country .SDF file manually from Windows Explorer is not one of these 

mechanisms), you are bypassing the grand totals tracking capabilities in EzCoin. 

The grand totals recalculation involves opening all country files you have installed, 

and extracting the country file’s individual totals information. As with country totals 

recalculations, you should never have to use this option unless you notice the grand 

totals are not matching the country totals when running a Grand Totals report. 

Recalculating Everything 

This option basically performs a country totals recalculation for your entire set of 

installed country files, including a grand totals recalculation on each one. Only use 

this option if you notice report discrepancies on more than one country file for 

calculated values. 

  



EzCoin Reference – Version 2.0 

Page | 328 
 

Snapshot Viewer 
The report viewer in EzCoin provides an option to save all or part of the report 

records to a Snapshot file. These files have an extension of .SNP and by default are 

saved to the Snapshots folder within the EzCoin installation path. 

The snapshot view is available from the Extras menu, and also as freely 

distributable standalone application which can be downloaded from the EzCoin web 

site. An example of the viewer window is shown below. 

 

The viewer provides a read-only copy of the report from which you saved to the 

snapshot file. The data grid and its contents are an exact copy of what you saw in 

the report viewer at the time of the save – there is no reference to a country file, as 

all of the information is contained in the snapshot file itself. 

The bottom of the window contains some basic information (the standalone version 

contains an Open file button not shown in the integrated version), including the 

description of the snapshot file, country of origin (by name and description), and 

some basic country settings: 

 Currency format (number of decimal places) and conversion rate (1.0 = 

USD) 

 Version of the country file which contained the data 
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 Effective date of the last pricing and supplied data applied 

 Number of records in the report 

 When the snapshot file was created 
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EzCoin General Preferences 
EzCoin stores most of the customizable options into a single preferences file, named 

EzUser.cdt, located in the installation path Config subfolder. For first time 

installations, this file will not be present, at which point EzCoin will assign a default 

configuration for the application. If you want to customize specific features in 

EzCoin, you can access the preferences configuration from the Options menu. 

 

The preferences window is organized into tabs. Refer to the help topic for each tab 

for a summary of the configuration options on that tab. 

Right Click/Ctrl Click Quick Help 

You can right click any preference option to see popup help. Buttons within the 

dialog window also have popup help windows, but you must hold down the CTRL 

key while clicking a button for help. 

Resetting Preferences 

Click on the Reset button to initialize all preference options to default values which 

reflect a fresh installation of EzCoin. Your current settings are always saved to a file 

named EzCoin.cdt, located in the installation path. If you delete the CDT file from 

outside EzCoin and then run the application, the preferences will automatically be 

recreated using these default values. 
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Exporting Settings 

Click on the Export button to save the current preference setting to a file of your 

choice. The file extension will be set as .CDT. You can restore the settings at any 

time using the Import button. 

General Settings 

Automatically back up country files before opening 

Check this option to create a backup of the country (.SDF) file prior to opening it. You can 

use the Restore from Backup Files (Auto backup) utility to restore the previous backup. 

Only one level of restore is available and each time a country is opened, the previous auto 

backup is replaced. 

Automatically open the last country file when starting EzCoin 

Check this option to automatically open the most recently accessed country file when you 

start EzCoin. 

Keep a backup of the country when supplied updates are applied 

Check this option to retain a copy of the country file before applying pre-supplied pricing 

and data updates. Only one copy of the country file is retained, and will be replaced upon 

the next supplied update you apply. 

Automatically add selected grades when saving to inventory 

When inventorying a coin record, this option allows you to auto-commit selected grades 

at the same time, avoiding the need to click on the Add Selected Grades button first. 

Autosave the coin record from grade/custom field editors 

When using the quick edit (spreadsheet) or single grade edit options from the main 

EzCoin window, changes are not updated to the country file when you apply them within 

the editor dialog windows by default. 

Check this option to force an auto-save of the coin record when applying the edits from 

within these 3 edit dialogs. If the coin was not inventoried at the time of the auto-save, it 

will become part of your collection. 

Step to previous supplied on inventory deletions 

Check this option to automatically recall the previous supplied coin record (by Scott #) 

when removing the current coin from inventory. 

Include duplicates when using navigation stepping methods 

If this option is checked, then duplicate coin records will count when stepping forwards 

and backwards using the navigation arrow buttons (green, blue and violet) in the main 

EzCoin screen. 

 

With this option disabled, you will need to use the smaller arrow buttons in the bottom 

status bar to step between duplicate coins. 

Include duplicate coins in the key field search results window 
When searching for coin records from the main EzCoin window based on the 5 key fields 

(Denomination, Year, Type/Reign, Variety, Mint Mark), with less than all 5 fields filled in, 

and start a search with multiple matching coin records, a report view will be presented 

with all matches. Use this option to control if duplicate coin records will be displayed or 

suppressed. 

The Clear Fields button behavior will mimic EzCoin version 1 
The clear fields button in the main EzCoin screen functions different from version 1 of the 



EzCoin Reference – Version 2.0 

Page | 332 
 

application, in that you must hold Ctrl down to clear all fields on the main screen. If you 

wish to use the version 1 behavior, then enable this checkbox. Holding down Ctrl in this 

mode will clear user fields, without Ctrl the entire screen. 

Use faster in-memory method to sort reports 

By default, EzCoin will sort reports using a file-based method, which is slower, but 

consumes less memory. If you check this option, all reports will be sorted using your PC’s 

memory instead, which is significantly faster. If you are using an older PC with limited 

memory capacity, it’s recommended to leave this option unchecked. 

Slide show interval (sec.) 

When presenting a slide show of coin records using the Navigation List feature of EzCoin, 

this value controls the delay between showing each coin record. The value is in seconds. 

Smart mouse cursor movement for dialog windows 

Check this option to enable smart mouse cursor movement when navigating between the 

various windows in EzCoin. The choice of the default "hot spot" for the cursor movement 

in each window is pre-determined and can't be changed. 

 

This option will not work on windows which are outside the EzCoin application, such as a 

file open dialog. 

Use quick entry for Priority Want and Sell Lists 

Check this option to use quick entry for Adding and Removing grades to and from the 

Priority Want/Sell Lists. With this option disabled, you will always be presented with a 

dialog window to allow for specific grade, quantity and type options. 

Disable changed coin warning messages 

There are many operations within EzCoin which could result in temporary changes (on the 

main EzCoin window) being lost if you didn’t save them to your inventory beforehand. 

This option controls the display of the warning dialog which allows you to back out before 

performing such an operation. If you check this option, no change warning dialogs will 

appear. 

Exclude image link file names in generic text Power Searches 

Power Searches have the ability to match your text-based search values against every 

text field associated with a coin record, including the image link file names. This may 

cause unwanted matches when searching for basic text information such as PCGS # or 

Denomination. To avoid hitting an image link on a Power Search, check this option. 

Compact Country File Reminder Notice 
Over a period of time, additions, deletions, changes and pre-supplied data updates to 

your country files can cause them to grow in size due to data fragmentation, much like 

the hard disk on your PC. EzCoin has a built in monitor on each country file to detect 

when a certain amount of time has elapsed before reminding you to compact your country 

file to reclaim space and make the file as small as possible. 

 

You can change the interval on the reminder period or disable it altogether. If disabled, 

you can choose to compact the country files at any time using the Compact Country 

utility. 

Grid view height adjust 
There are many windows in EzCoin which make use of data grids (aka spread sheet 

views) to display information in rows and columns format. This setting can be used to 

increase or decrease the height of the data rows based on a percentage adjustment of the 
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default row height. 

Date Input and Output Formats 
EzCoin displays dates using a pre-defined pattern for the day, month, and year values. It 

also uses a second pre-defined pattern for any input field where a date is expected. You 

select the patterns to use from the available values in the drop down lists.  

Note that the Date Output value can be used as a valid format for entering dates, as can 

any date which is currently in the format defined by the Date/Time settings for your PC. 

Coin Lookup Profile 
When searching for coins in the main EzCoin window a report view will be displayed when 

multiple records are detected for the given input (i.e. you press ENTER in the 

Denomination field which has 1 Cent display and the other 4 key fields are all empty). 

 

This drop down list allows you to assign a custom profile for the report view. Note that 

you MUST make a copy of the profile named Coin Lookup List and customize the a copy 

to have it appear in the drop down list. 

 

Display Options 

Show different colors for supplied and inventoried coin fields 
Check this option to show a different background and text color for fields on the main 

EzCoin window where pre-supplied values are different from the inventoried values. 

 

To set the colors, change the Difference Color values under the Colors tab in the 

Preferences window. 

Use country file-specific labels for Cat IDs, Serial # and Location 
Check this option to use country-specific labels for the Serial #, Location, and alternate 

catalog ID field names. This setting affects the main window labels, the Report Viewer and 

printed reports. 

EzCoin main tabs and quick editors will use the same sort order 
Check this option to ensure that the quick editors for grade, purchase/sell history and 

priority/want sell/list data retain the same order in the editor grid as in the main EzCoin 

window’s tabbed grid views. 

Show PWL in main tab list 
Check this option to add a grid to the tab list of the main EzCoin window for the Priority 

Want list. 

Show PSL in main tab list 
Check this option to add a grid to the tab list of the main EzCoin window for the Priority 

Sell list. 

Show custom fields in main tab list 
Check this option to add a grid to the tab list of the main EzCoin window for the Custom 

fields for the current country. 

Disable automatic tooltip text for Report, Coin List and Snap views 
Check this option to disable the automatic tooltip text which shows when you hover the 

mouse over cells in the following data grids: Report Viewer, Snapshot Viewer, and Coin 

List Viewer. You will need to restart the application for this change to take effect. 

Display the notes and comments in the left details panel 
EzCoin by default will place the pre-supplied Notes and User-supplied comments data 

below the coin images in the main window. This makes optimal use of the available space 

when used on monitors with less than high-res (under 1920 x 1080 pixels) capabilities.  
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For higher resolutions with a larger EzCoin main window size, you can place the notes and 

comments under the designer field in the left information panel, allowing the coin image 

area to increase considerably. Note that resetting the EzCoin main window size will turn 

off this option by default. 

Drop down lists for Locations and other items always sort alphabetically 
Check this option to automatically sort lists alphabetically in drop down list controls in 

EzCoin. If unchecked, the list sort order must be maintained manually as new items are 

added with new coin updates, using the Lists Editor utility (the latter mode reflects the 

standard behavior in EzCoin version 1). This option applies to lists for Locations, Graders, 

Purchased From, Sold To, and Priority Want/Sell List Types. 

Show high currency values in a different color on report views 
Check this option to show a different background and text color in the Report Viewer 

window whenever a currency value exceeds the minimum amount shown in the Minimum 

High Currency field. 

To set the colors, change the High Value Color values under the Colors tab in the 

Preferences window. 

Text Box, Drop Down List, and Data Grid Fonts 

You can define any font in an 8 or 9 point size to use for the text box fields, drop down 

lists or data grid views appearing in any EzCoin window. This will affect only EzCoin dialog 

windows – it will not be applied to any other application, as these are not Windows 

settings. 

 

Colors 

Grid Odd Rows 
For on-screen grids and the report viewer, these are the text and background colors for 

rows 1, 3, 5, etc. 

Grid Even Rows 
For on-screen grids and the report viewer, these are the text and background colors for 

rows 2, 4, 6, etc. 

Grid Header 
For on-screen grids and the report viewer, these are the text and background colors for 

the header caption labels for each column of the spread sheet. 

Grid Highlight 
For on-screen grids and the report viewer, these are the text and background colors for 

date rows which are currently selected. 

Grid Cursor 
For on-screen grids and the report viewer, these are the text and background colors for 

selected cells. This color combination only appears for grids which allow individual cells to 

be selected. 

Grid Non-Editable 
For on-screen grids used by various edit windows, these are the text and background 

colors for cells which can’t be edited (aka read only). 

Grid Marked 
For the grades quick editor and the report viewer, these are the text and background 

colors for data rows which are marked for changes or bookmarked in the viewer. 

Help Hint Windows 
For the Quick Help message windows, you can set custom text and background colors. 
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You can’t change the font type or font size for help hints. 

Difference Color 
You can indicate changes between pre-supplied data values and your inventoried values 

of the same fields using special text/background colors, which are applied to the main 

EzCoin window and the report viewer. 

 

You will also need to enable the appropriate preference/report option to display these 

colors. 

High Value Color 
You can enable high currency value color coding in the report viewer by enabling the 

preference option and setting a minimum currency value for which these colors will be 

displayed. 

Inventoried Record 
These colors are used to mark inventoried records in the report viewer. The color coding 

is applied to the record number column (left most) in the report view grid. 

Grid Lines 
This color is applied to all grid lines used for on-screen spread sheet views. 

Main Image Background: 
This color is used as the background color for the main EzCoin image area. 

Viewer Image Background: 
This color is used as the background color for the report and coin list viewer image areas. 

 

Image Options 

Clipboard Save Format 
EzCoin allows you to use the image links editor to paste in a coin image from the Windows 

clipboard. This option determines what format will be used to save the clipboard image as 

a file. 

Image Quality 
For displayed images, this option controls the image rendering quality. If you are running 

EzCoin on an slow PC, you may want to use a lower quality setting. 

 

Note that printed reports use an independent image quality setting defined in each 

report’s profile. 

Allow images to expand beyond 100% actual size 
This option controls if images displayed on screen will be expanded to larger than 100% 

size to fit the available image window area. 

Do not search the EzCoin distribution disc drive for image files 
Check this option to disable checking the CD/DVD/BD drive from which EzCoin was 

installed from for image files, if they can’t be located in other locations (i.e. the hard disk 

image copy path) first. 

Alternate Images Location 
EzCoin allows you to specify an alternate image path which can be used separately from 

the hard drive image copy path. Use this option if you wish to keep your image repository 

separate from the EzCoin installation location. 

By default, EzCoin will reference your images from within the Images subfolder of the 

EzCoin application installation path. 

EzCoin CD/DVD/BD Drive 
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When EzCoin is installed, the CD/DVD/BD drive which was used has the path name 

automatically saved. The path setting is based on the user who installed EzCoin. If you 

have multiple users logging into your PC, or you wish to reference images from a drive 

other than the one which was used to install EzCoin, you must manually change the drive 

location here. Use the ellipsis button to browse to a new location. 

Alternate Image Location Preference 
When this option is checked, EzCoin will search your preferred alternate image folder first 

for coin image files. When this option is not checked, EzCoin will search under the 

application installation path first. 

Do not show primary images when the alternate obverse/reverse image isn't 

available 
By default when showing alternate images in EzCoin, if the obverse or reverse image isn't 

available, the primary version of that image will be shown instead. Use this option to 

disable this behavior. If an alternate image isn't available, the primary image will not be 

displayed. 

 

 

 

Selection Rectangle Transparency: 
When selecting coin images in the thumbnail viewer, a rectangle will outline the selected 

coin. This option allows you to set the transparency level. A higher value will allow more 

of the image underneath the selection rectangle to appear. 

Viewer Background Color 
This color is used as the backdrop for all coin images in the thumbnail viewer. 

Grid Line Color 
This color is used to draw the gridlines between the coin rows and columns in the 

thumbnail viewer. 

Selection Rectangle Color 
This color is used to draw the rectangle around the current coin selected in the thumbnail 

viewer. 

Label Color (Supplied) 
Pre-supplied coins which are not part of your inventory will show the Denomination & Year 

with this background color. 

Label Color (Inventoried) 
Coins which you have inventoried based on pre-supplied data will show the Denomination 

& Year with this background color. 

Label Color (Custom) 
Coins which you have inventoried which have no pre-supplied data will show the 

Denomination & Year with this background color. 

Number of Rows 
This value determines how many rows of images will be displayed in the thumbnail 

viewer. Note that you can drag the viewer to be larger or smaller, but the number of rows 

will not change. 

Number of Columns 
This value determines how many columns of images will be displayed in the thumbnail 

viewer. Note that you can drag the viewer to be larger or smaller, but the number of 



EzCoin Reference – Version 2.0 

Page | 337 
 

columns will not change. 

Label Text Color 
This color is used for the Denomination & Year text below each coin image in the viewer. 

Image Quality 
Thumbnail image quality can be defined using this drop down list. If you are running 

EzCoin on an old PC with limited performance, use a lower quality setting, or reduce the 

number of rows and columns to display. 

Label Font 
You can change the font to be used for the Denomination & Year displayed below each 

image. Left click the font name to change the current setting. 

Image to Show 
The thumbnail viewer can only show primary or alternate images at one time. This drop 

down prioritizes which set of images are displayed. If the coin record doesn’t have an 

available image based on your choice, the primary image will be substituted 

automatically. 

Allow images to expand beyond 100% actual size 
Check this option to allow images to exceed 100% of their actual size. In this case the 

image will grow to fit within the boundaries of each image cell in the viewer. 

Show grid lines between image rows and columns 
You can hide grid lines between coin images in the viewer by un-checking this option. 

 

Report Viewer Options 

Image Quality 
The report viewer image quality can be defined using this drop down list. If you are 

running EzCoin on a slow PC, use a lower quality setting. 

Image Background 
When displaying in image column in the report viewer, this option is used to define the 

background color. 

Image Size 
When displaying an image column in the report viewer, this option is used to define how 

large the image cell will be. The columns of text data will be adjusted to match this 

height. 

Suppress Zero Override 
This option controls how the report viewer will display zero quantity and zero currency 

values. The default is to let the report profile (which has its own suppression setting) 

handle this. You can globally override the report profile at any time by using this option to 

always suppress or always show zero values. 

Display the alternate Catalog ID column on reports 
Check this option to globally enable the current alternate catalog ID value (as shown in 

the main EzCoin window) on all reports. Note that if you have added alternate catalog ID 

values explicitly into the field profile for a report, this option will have no effect on that 

particular report. 

Display the duplicate sequence # column on reports 
Check this option to show the duplication number on all reports. For example, a coin 

which has been duplicated 2 times can show as 3 rows on the report viewer. This column 

allows you to see the duplication number on the report. If a report profile has been 

defined with the duplication field already, this option will have no effect. 
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Pressing ENTER in the report view selects the coin and exits 

Check this option to enable an EzCoin Version 1 feature. When enabled, selecting a coin 

record in any report view, then pressing the ENTER key, while navigating the data grid 

cells with the cursors keys, will result in the selected coin record being displayed in the 

main EzCoin window, and the report dialog window closing. 

Enable search match columns on reports 
Enable this option to show all matching columns from a Power Search. For example, if you 

matched on Denomination and it wasn’t in the field profile for a report, it will 

automatically be added to the right side of the column set. 

Image Caching 
The report viewer can speed up the display of reports which contain image columns by 

caching the images as smaller thumbnails on your hard disk.  

Use the Clear Cache button to flush out the file list from your PC. If you want to have the 

cache auto-cleared when exiting EzCoin, enable the Clear Cache on Exit option. 

Note that if you change the size of the image cells, you will need to clear the cache or the 

previous sized images will be used. 

Use short column names on report views 
The report viewer can use either the Long or Short display names for column header 

captions. The short format will reduced the amount of horizontal scrolling needed to view 

the report data. 

Group Header Colors 
If you include field data groups (Purchase/Sell History, Grades, Priority Want/Sell List) in 

a report profile, the header labels can be shown with different background colors, to 

better distinguish normal primary coin information from the secondary data group 

columns.  

 

Printer Settings 

Printer Selection 
Each report profile can have a specific printer assigned to it. The general preference 

option allows you to have a master default printer assigned for every report, regardless of 

each report’s individual settings. 

 

Note: if you add or remove printers after EzCoin has been installed, you may need to 

refresh the printer list. For performance reasons related to some network-based printer 

configurations, EzCoin only builds a list of printers on demand. Use the Refresh Printers 

button to update the list. 

 

If you don’t select a printer, EzCoin will use the default printer assigned on your PC. 

Paper Size 
You can set a global paper size to be applied to all reports. If you don’t set a global paper 

size, the report will use the default paper size for the selected printer. 

Orientation 
The Default option will use the current paper orientation of the current printer. Use the 

other two options to enforce a specific page orientation for all reports. 

Apply this orientation, margins, paper and printer to all reports 
Check this option to enable global Printer, Paper Size, Orientation and Margin settings, 

which are basically the values you choose in the preferences window. If the option is not 
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checked, the report profile’s internal printer settings will be used instead.  

 

The global setting is recommended if you intend to output the report using the same 

printer and paper size consistently regardless of the report type. 

Margins 
Global margins can be assigned for reports using these values. The header and footer are 

based on the top and margins, and occupy space which is deducted from those margins. 

 

Margins must be entered in units of inches. 

Autosize all column widths for Multi Page Reports 
For a report type defined as multiple pages, this option will automatically adjust the 

widths for any columns which aren’t defined as multi-line format. A multi-line format 

column will still be restricted to the width defined in Master Report Fields list. 

Adjust Fit to 1 Page Reports to fill the page width 
For any report which only occupies a single physical page width, this option is used to 

proportionally enlarge each column’s width so that the grid size fully occupies the page 

between the left and right margins. 

Refreshing Printers 
EzCoin only creates a printer list when you install the application. If you add or remove 

printers after this time, you will need to refresh the available list of printers. This button 

performs this task and is identical to the Refresh Printers option in the main EzCoin menu. 

 

Customizations 
EzCoin provides several options to customize your copy of EzCoin. All of these 

customizations are located under the Options menu. 

Precious Metal Prices 

Coins valuations are normally based on the market value and grade. However, 

coins can contain precious metal content, and EzCoin will always maintain a bullion 

value for the coin, regardless of the grade. The coin's net bullion value is the grade 

quantity multiplied by the calculated bullion value. 

The calculated bullion value requires more than 0 percent content for any of the 

following metal types: Gold, Silver, Platinum or Palladium. Unlike EzCoin version 1, 

the precious metal content percentages are maintained in separate fields.  

When importing data from version 1, the composition field is scanned for precious 

metal percentages, based on the same process used to assess bullion value coins in 

version 1. 

A coin must have a valid weight assigned to it as well, which can be in any of the 

pre-defined units of weight. 



EzCoin Reference – Version 2.0 

Page | 340 
 

A bullion value is the weight of the coin, multiplied by its current precious metal 

price and it's percentage of metal content, for each of the 4 metal types. 

As bullion valued coins are part of the net value for the coin collection in each 

country, the current precious metal values are saved within each country's data file. 

EzCoin will also maintain a global metal price. This pricing update window is 

accessed from the Precious Metal Prices item in the Options menu. 

 

There are 2 sets of prices saved with EzCoin. The left side prices you are free to 

maintain on your own independent of any data updates from SoftPro. 

The right side prices come from Free Updates from SoftPro. If you want to get the 

latest prices from an online Web site, you can Visit the Web Links shown. SoftPro 

provides 3 current links for pricing, and you can add 3 of your own, using the Your 

Links radio button. 

The price values are always expressed in U.S. Dollars (USD) currency. When 

working with country files using a different currency rate, EzCoin will automatically 

calculate the bullion values based on the currency rate for the country. 

As you change prices the As Of date will update accordingly. Free updates from 

SoftPro may also update the As Of dates in the right side prices. 

Use the Update Links Only button to apply any changes you make to any of the 3 

custom Web Link URL values. Otherwise, click Apply to save Web Link changes AND 

price changes. 
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When you update the global pricing, EzCoin will check the country pricing when you 

next open the country file. If the precious metal pricing has changed, you will be 

given a confirmation window to apply the new pricing values. 

 

Click Update to apply the prices changes to the country file. If you click Cancel, you 

will be prompted again the next time you open the country file. Note that if you 

currently have a country file open when you change a precious metal price, the 

information will automatically be updated to the country file. 
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Keyboard Shortcuts 

EzCoin defines a handful of default shortcut keys for the main EzCoin menu. You 

are free to redefine the keyboard shortcut mappings for EzCoin using the 

Keyboard Shortcut Configuration option under the Options menu. 

 

The shortcut list contains all of the items in the main EzCoin menu, grouped by the 

primary name in the menu bar. If a shortcut is assigned, the item will be 

highlighted in a different color to indicate this. Shortcuts can consist of a 

combination of the key on the keyboard and qualifiers, which are the CTRL, SHIFT, 

and ALT keys. Not every keyboard combination is valid for a shortcut. For example 

unqualified letters and digits are not allowed, as are keys reserved by Windows. 
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Toolbar Options 

 

1. Removes a shortcut from the selected item. You can also Right click the item 

to remove shortcuts. 

2. Assign or change a shortcut key. This option will bring up a small dialog 

window, prompting you to enter a valid shortcut. If the shortcut is already in 

use, a warning will be given – duplicate shortcut keys are not allowed. To 

cancel, you must click the small X in the caption bar of the window. 

 

Note: You can double click any shortcut item in the list to assign a shortcut 

key. 

3. Undo all changes you have made. 

4. Erase all keyboard shortcuts. 

5. Save keyboard changes. 

6. Cancel all changes and close the editor. 

7. Click the export button to save the keyboard shortcuts to a file. Keyboard 

shortcut files are saved with an extension of .EKM. Use the import button to 

recall saved shortcuts from a file. 

 

Reverting to Pre-supplied Shortcuts 

Use the Revert option in the File menu to change the shortcut mappings to the 

default pre-supplied settings. 
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Menu Shortcut Buttons 

EzCoin’s main toolbar provides a basic set of buttons for the more frequently used 

options. If you find using shortcut keys or menu navigation cumbersome and prefer 

to have icons to click on to perform the equivalent menu actions, you can attach 

most menu items to shortcut buttons which will appear as a secondary window you 

can position alongside the main EzCoin window. 

The editor is accessible from the Shortcut Buttons Configuration item under the 

Options menu. The shortcut button window is displayed or hidden using the 

Command Shortcuts option under the View menu. 

 

The edit window shows available menu commands in the left side list and assigned 

commands on the right side list. Up to 5 sets of shortcut buttons can be configured. 

The current set of buttons is shown in the title bar (Set 1 to 5). The bottom area of 

the edit window shows the selected item’s description, location in the EzCoin menu, 

and any shortcut key attached to it. 
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Toolbar Options 

 

1. Removes the selected assigned items from the right side list. You can also 

Right click the selection on the right side list to remove them. 

2. Assign selected items from the available list in the left side list to the assigned 

items in the right side list. You can also right click the selection in the left side 

list to assign them. 

3. Undo all changes you have made. 

4. Erase all button assignments in the right side list for the current set. 

5. Move the selected items in the right side list up or down. Topmost items will 

be the first ones visible in the shortcut window. Hold down CTRL while clicking 

to move the selection to the top or bottom of the assigned list. 

6. Save shortcut changes for all 5 sets. 

7. Cancel all changes and close the editor. 

8. Click the export button to save the button shortcuts to a file. Button shortcut 

files are saved with an extension of .ECF.  

 

Use the import button to recall saved shortcuts from file. Note: The import 

and export options work with the current set (1-5). If you export while 

working within set #2, then only set #2’s shortcuts are exported. 

9. These buttons change the current command set. The assigned and available 

lists will automatically be adjusted when you click on one of these buttons. 
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Resetting EzCoin Application Windows 

This option is available as Reset Application Windows under the Options menu. 

 

As indicated in the dialog notes above, nearly every window in EzCoin has some 

type of configuration element, such as a checkbox state, text field value, or the size 

and position of the window on your screen. This information is stored in special 

window configuration files in the CFG folder of the EzCoin installation path.  

The reset dialog provides only 3 checkbox options. This is based on the 3 main 

window types in EzCoin: 

 The primary window for EzCoin. 

 Supporting windows which can be positioned alongside the primary window, 

such as the Thumbnail Viewer or the Coin List. These windows are displayed 

or hidden using items under the View menu. 

 Secondary windows, which is basically every other window in EzCoin. 

Resetting a window removes all customizations and settings on the windows, 

including their current size and position (if applicable). The window states will 

return to what they were when EzCoin was first installed. 
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Application Shortcut Links 

The Create Shortcuts item under the Options menu will allow you to create or 

update the shortcuts to the EzCoin application on the desktop and program start 

menu. The shortcuts will also include updates to the help files and the EzUpdate 

application. 

 

In order to avoid any issues with UAC (User Access Control) under Windows 

Vista/Windows 7/Windows 8, EzCoin will not try and access any restricted areas of 

your Windows installation which would otherwise require Administrator rights or 

UAC permissions. Shortcuts to the desktop and program start menu are created by 

the EzSetup application with ownership set to the user who runs EzSetup. 

If you run Windows under a different user, the shortcut links will need to be 

updated for the new user. This dialog will perform that task. 

In addition, if you elect to copy EzCoin from one location to another, you can easily 

re-point the shortcut links to the new location. 

The checkbox option is for updating the Desktop shortcuts. If you don’t check this 

option, then shortcuts are only updated to the program start menu. 
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Setting the Grade Data Display Order 

The Grade Display Order submenu under the Options menu allows you to control 

how grades are sorted in the Grades tab of the main EzCoin window. 

 

 There are 4 options in this submenu. 

Inventoried Grades This sort order (the default one) will always prioritize the 

inventoried grades to come first. 

Priority Want List Priority Want List grades will be sorted first. 

Priority Sell List Priority Sell List grades will be sorted first. 

Default Grade Order The grades will always retain the default order as defined 

in the Grades Configuration editor. 

 

In addition to these 4 sort orders, you can click any column in the grades data grid 

to sort the data in ascending or descending order. 

  



EzCoin Reference – Version 2.0 

Page | 349 
 

Setting the Fields to Display in the Tabbed Grid Area 

For the 5 data grids in the main EzCoin window, you can choose which fields you 

want to display, and in custom left to right ordering, using the Field Settings for 

Data Grids submenu under Options. 

 

NOTE: This dialog window is also used to set the fields to display for report profile 

which contain data groups for these 5 types of coin information. 
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The left side list is the available fields to show in the data grid. The right side list is 

the assigned fields. The top to bottom ordering in this list corresponds to the left to 

right ordering of these fields in the main EzCoin window data grids. 

Toolbar Options 

 

1. Removes the selected fields from the right side list. You can also Right click 

the selection on the right side list to remove them. 

2. Assign selected items from the available list in the left side list to the right 

side list. You can also right click the selection in the left side list to assign 

them. 

3. Undo all changes you have made. 

4. Erase all field assignments in the right side list. You can’t save an empty list, 

so at least one field must be assigned. Use the Reset menu option to restore 

the assignment list back to the default fields. 

5. Move the selected items in the right side list up or down. Hold down CTRL 

while clicking to move the selection to the top or bottom of the assigned list. 

6. Save the filtered field list. The main EzCoin data grid will update accordingly. 

7. Cancel all changes and close the editor. 

 

Custom Grid Field Display Files 

A Save Custom File option is provided for the Grades data grid only, to save the 

current assigned fields to a customization file in the User folder of the application. 

The customization files represent temporary field settings for the main window data 

grid. When you close down EzCoin and restart the application, your default field 

settings will be applied. Custom field files are a quick way to change the fields in 

the EzCoin grades grid without having to generate a new default field list each time 

you want to hide or show fields in the grid. 

This option is available from the File menu. When you select it, you will be 

prompted for a description, which will also be used for the name of the file. The 

extension of .fgrd is applied to the file for you automatically. 
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Choosing a Customized Field Display File 

Switching to a new set of fields to display in the main EzCoin grades grid is simple: 

right click anywhere in the data grid area, and choose the Select Custom Field 

List option from the pop-up menu. This will present a simple dialog window with a 

list of custom field files which were saved. 

 

You can select any field settings file in the list then click Select to use that file. You 

can also Double-click the item in the list to select the file and close the dialog 

window at the same time. 

To delete a settings file, select it then click on the Delete button. 

To rename a settings file to a different name, click on the Rename button. 

To undo any custom field display setting in the EzCoin main window and restore the 

fields to the default set, click on the Undo button. Keep in mind that custom field 

settings are not retained once you close the EzCoin application. 
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Setting the Fields to Display in the Tabbed Grid Area 

For Grades, Priority Want/Sell List, and Purchase/Sell History, you can choose which 

fields you want to display in the tabbed data grid area of the main EzCoin window. 

These options are available in the Field Settings for Data Grids submenu under 

the Options menu. 

 

Choosing any of the 5 menu options will present a window like the one shown below 

for inventoried grades. 

 

 



EzCoin Reference – Version 2.0 

Page | 353 
 

The left side list is the available fields to show in the data grid. The right side list is 

the assigned fields. The top to bottom ordering in this list corresponds to the left to 

right ordering of these fields in the main EzCoin window data grids. 

Toolbar Options 

 

1. Removes the selected fields from the right side list. You can also Right click 

the selection on the right side list to remove them. 

2. Assign selected items from the available list in the left side list to the right 

side list. You can also right click the selection in the left side list to assign 

them. 

3. Undo all changes you have made. 

4. Erase all field assignments in the right side list. You can’t save an empty list, 

so at least one field must be assigned. Use the Reset menu option to restore 

the assignment list back to the default fields. 

5. Move the selected items in the right side list up or down. Hold down CTRL 

while clicking to move the selection to the top or bottom of the assigned list. 

6. Save the filtered field list. The main EzCoin data grid will update accordingly. 

7. Cancel all changes and close the editor. 
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Installed Printers Configuration 

EzCoin keeps a configuration file (EzUser.pcf under the Config subfolder) for all 

installed printers on your system. This file is automatically generated when it isn’t 

found (which is the case when you first install the application). The purpose of the 

configuration is to build a list of the printer capabilities (paper type and other 

printing attributes) ahead of time, which aids in making printer and paper selection 

fast, especially when you may have network printers connected which may be 

offline or unavailable. 

Some versions of Windows and certain types of printer installations (especially 

those across a network) can take several seconds to obtain the printer attributes. 

This would in turn make EzCoin quite slow in responding to paper and printer 

selections. 

Given this situation, you will want to refresh the printer configuration file after 

installing a new printer. There are refresh options under the Options menu, and 

also within the Report Profile editor and EzCoin general preference windows. 
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Setting the Label Text for Country Fields 

Most of the labels associated with coin fields are shared across all country files (i.e. 

Mint Location, Denomination, Composition, etc.). However, 6 fields have labels 

which can be unique per each country: 

 Alternate Catalog ID fields (4 in total). 

 Location 

 Serial Number 

The item Change Country Field Labels under the Option menu allows you to 

rename these labels. You can also click on the labels in the main EzCoin window 

and choose Rename from the popup menu. 

 

Select one of the 6 label fields using the radio buttons. For each selection, the 4 

label names will be changed accordingly. There are 2 display formats for the label 

and 2 print formats. 

Click the Copy Display to All button to transfer the long format display name to 

the other 3 fields. Click on Reset to restore the labels to current global values 

stored in the report field configuration.  
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Additional EzCoin Features 

Context-Sensitive and Quick Help Hints 

The main EzCoin window provides context-sensitive hint messages in the status bar 

at the bottom of the window when you move the mouse cursor over buttons and 

menu items. 

Hover over the blue checkbox: 

 

To see the hint message: 

 

In addition, you can get a more detailed popup quick help message displayed when 

right clicking on any button or label. 

Right click on the label for Weight to see the popup help message: 
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Tips of the Day 

The default status of the tips of the day is to show it when EzCoin is first started. 

You can use the similar named item under the Help menu to show the tips screen 

at any time. The tips dialog provides a checkbox option to turn it off, and also to 

step through all the tip messages. 

 

About EzCoin and Sending Email 

The about dialog window is displayed when choosing the About EzCoin item from 

the Help menu. This window will show the current EzCoin build version in the title 

bar, along with some basic information about your installation of Windows. 

The Web site and Email links are clickable. The former item takes you to the EzCoin 

web site. The latter can be clicked to compose an email to SoftPro. The Send Email 

button works the same as clicking on the email address link. It will launch a simple 

email composition window: 
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Enter your message text into the input box below the To and Subject lines, then 

click on Send. This will bring up your default mail client at which point you can 

send the message. 

Your contact information is automatically added to the end of the message, along 

with some basic information about your version of EzCoin and your Windows 

installation. SoftPro uses this information to help identify what version of EzCoin 

you are using and what your operating system is. It’s recommended that you don’t 

remove this information. 

If you need to change your contact information, click the Change Contact Info 

button before sending the email. 

Checking for Free Updates 

SoftPro will provide free updates for EzCoin to address bug fixes and minor 

software enhancements. These updates basically cover most things in EzCoin 

except for supplied data, pricing updates and new images. 

Choose the Check for Free Updates option from the Help menu. EzCoin will 

check online for any pending updates. EzCoin updates are bundled in one or more 

archive files, each one containing a special date coin which determines if your copy 

of the application is up to date. Only required archive files are downloaded, saving 

time and space. 

If EzCoin determines that your files are up-to-date, you will be notified with the 

message: Your installation of EzCoin requires no new application updates at this 

time. 
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If any updates were downloaded, EzCoin will close down, and the EzUpdate 

application will be launched. Refer to the EzUpdate help topic for more information. 

Forcing a Full Update 

Note: Unless you are experiencing any strange behavior with either EzCoin or the 

Free Update process, do NOT perform the following action. 

EzCoin uses a special update history file named EzCoin.upd located in the EzCoin 

installation path. This file contains the up-to-date download activity on your PC for 

EzCoin updates. If you delete this file and run the free update option, EzCoin will 

perform a full download of every archive file, and EzUpdate will replace/update 

from each of these files. 

 

Checking for Updated CD/DVD Releases 

Choose the option Check availability of Updated CDs/DVDs from the Help 

menu to launch your default Internet browser and navigate to the SoftPro EzCoin 

updates web page. 
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Dealers, Suppliers and Auctioneers 

 

Simply choose a dealer/supplier from the drop down list and the associated 

information such as phone/fax numbers and contact details will be displayed for 

you. It can save you hours of hunting through ads for a dealer near you. 

Please note that SoftPro is not affiliated with any particular dealers. 

This list of dealers, supplies & auctioneers will be updated periodically 
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EzUpdate – Applying Free and Supplied Data Updates 
As part of the EzCoin installation, a support application named EzUpdate is 

provided. This application is automatically launched whenever free updates are 

downloaded. You can manually run the application by choosing it from Windows 

Start Menu: 

 

EzUpdate has only one of two windows to display, the choice of which is based on 

the type of update. 

Free Updates 

For free updates, the EzUpdate window will appear as below: 

 

The window contains some basic information about the update: 

 A brief description of the update package. 

 The effective date of the update archive files. 
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 The cumulative size of all files that were downloaded. 

The View Notes button can be used to see special information and release notes. 

The button is only enabled when notes are available. 

Click on the Install Updates button to install any changes from the downloaded 

archive files. Each file in EzCoin has effective date signatures contained inside of 

them. EzUpdate will ensure that only files which are newer or different from what is 

installed with your version of EzCoin is updated. Custom data files, exported 

information and custom images are never replaced, modified or deleted by 

EzUpdate. Only pre-supplied data is updated. 

Pressing F1 will provide a simple reference to this help topic. 

Note that you can’t cancel an update once started. However, if it didn’t complete, 

you can run EzUpdate again and continue from where you left off. You should 

NEVER run EzCoin until EzUpdate has completely applied the update, or you may 

experience unpredictable behavior. 

Supplied Data and Pricing Updates 

The EzUpdate window is slightly different for this type of update: 
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You must use the Browse button to locate the update archive file (which will be a 

specially formatted .ZIP file). The archive files can be from online downloads, or 

distributed on CD/DVD/BD disc media. 

Once you select a file, it will be validated for authenticity and integrity. The 

description, date and size fields will be updated if the file passes validation. Any 

release notes for the update can be viewed by clicking the View Notes button. 

Click the Install Updates button to start the update process. As with free updates, 

you can’t cancel the update, but can resume an update if it didn’t finish on a prior 

attempt. 

EzUpdate and Master/Country Data File Updates 

EzUpdate doesn’t contain any special functionality to apply updates to your country 

files or the EzCoin master configuration file (EzCoin.sdf). These updates are 

handled by EzCoin the next time you start it. Pending country file and master data 

updates are handled using special files stored in the Setup subfolder of the EzCoin 

installation path. EzUpdate will extract these files from the update archive and let 

EzCoin apply the updates from those files. For every country in the archive file, 

there will be one pending setup file for EzCoin to apply to the associated country 

SDF file. 
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  PLEASE READ CAREFULLY        

SOFTPRO 2001 LICENSE AGREEMENT 

The use of this package indicates your understanding and acceptance of the 

following terms and conditions. This license shall supersede any verbal or prior 

verbal or written statement or agreement to the contrary. If you do not understand 

or accept these terms you must remove this software from any computer system 

that it has been installed on and discontinue its use. 

COPYRIGHT:  This product is Copyright (c) SoftPro 2001, All rights reserved. This 

product is protected by Canadian and United States copyright laws, international 

treaties and all other applicable national or international laws. This software 

application and any accompanying documentation, images or any other component 

may not be copied, translated, or reduced, in whole or part, to any electronic 

medium or machine or human readable form, without prior consent in writing, from 

SoftPro 2001. SoftPro 2001 does not transfer title to the software package to you. 

You have the non-exclusive, non-commercial use of the software package. SoftPro 

2001 retains the full and complete title to the software package, and all intellectual 

property rights therein. 

 

Coin Images © 2019 Royal Canadian Mint. All Rights Reserved  

Images des pièces © 2019 Monnaie Royale Canadienne. Touts Droits Réservés 

PROPRIETARY RIGHTS AND RESTRICTIONS: Subject to this Agreement, 

SoftPro 2001 retains all copyrights, trade secret rights, patents, trademarks, and 

any other proprietary rights covering or relating to this software package. You 

acknowledge that the software package includes or incorporates proprietary and 

confidential information belonging to SoftPro 2001. All rights not expressly granted 

by SoftPro 2001. in this Agreement are reserved. All images supplied with the 

software are copyright protected and may not be used for any commercial use. 

EzCoin and all supplied images are strictly for PERSONAL use. You may not modify 

or alter the application executable code or any associated files. You may not 

attempt to unlock or bypass any copy protection or registration authentication 

algorithm incorporated in the program executable. You may not remove or modify 

any copyright notice, nor any dialog screens containing such copyright notices. 

LIABILITY DISCLAIMER: This software package and/or license is provided 'AS 

IS', without any representation or warranty of any kind, either express or implied, 

including without limitation any representations or endorsements regarding the use 

of, the results of, or performance of the product, its appropriateness, accuracy, 

reliability, or correctness. In no event shall SoftPro 2001 be liable for any losses, 
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direct, indirect, consequential, or incidental damages arising out of use, the results 

of use, or inability to use this product. SoftPro 2001 does not warrant that the 

operation of the software package will be uninterrupted or error free. The entire 

risk as to the results & performance of this program is assumed by you. 

LIMITED WARRANTY:  SoftPro 2001warrants that the physical contents 

(CD/DVD/BD) to be free from defects for a period of thirty (30) days from the date 

of purchase.  In the event of notification within the warranty period of covered 

defects in material or workmanship, the defective components will be replaced so 

long as you mail, freight prepaid, the defective material to SoftPro 2001. This shall 

be the sole remedy for breach of this warranty & shall be limited to the replacement 

of the defective CD/DVD/BD.  

OPERATING LICENSE: One registered copy of EzCoin may be used by a single 

person who uses the software personally on one or more computer systems or by 

multiple persons on a single workstation non-simultaneously. 

Use of EzCoin over a LAN (Local Area Network), or a WAN (wide area network) is 

strictly prohibited under any circumstances. 

BACKUP AND TRANSFER OF LICENSE RIGHTS: You may make one copy of the 

program solely for back-up purposes as prescribed by Canadian, United States, and 

international copyright laws. You may not transfer the software package to any 

other person or third party. This license is effective until it is terminated. You may 

terminate the license by destroying the software package in its entirety, including 

any back-up copy you may have made. This license also terminates if you fail to 

comply with any terms or conditions of the license agreement. You agree upon such 

termination to destroy all copies of the software package and any associated 

documentation, or to return them to SoftPro 2001.  

You may not redistribute, sell, decompile, reverse-engineer, disassemble, or 

otherwise reduce the Software to a human-perceivable form. All other rights and 

restrictions not specifically granted in this license are reserved by SoftPro 2001. 

©2019 SoftPro 2001. ALL RIGHTS RESERVED. 


